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Notice 

While reasonable efforts have been made to ensure that the information 
in this document is complete and accurate at the time of printing, Avaya 
assumes no liability for any errors. Avaya reserves the right to make 
changes and corrections to the information in this document without the 
obligation to notify any person or organization of such changes. 

Documentation disclaimer 

“Documentation” means information published in varying mediums 
which may include product information, operating instructions and 
performance specifications that are generally made available to users of 
products. Documentation does not include marketing materials. Avaya 
shall not be responsible for any modifications, additions, or deletions to 
the original published version of Documentation unless such 
modifications, additions, or deletions were performed by or on the 
express behalf of Avaya.  End User agrees to indemnify and hold 
harmless Avaya, Avaya's agents, servants and employees against all 
claims, lawsuits, demands and judgments arising out of, or in 
connection with, subsequent modifications, additions or deletions to 
this documentation, to the extent made by End User. 

Link disclaimer 

Avaya is not responsible for the contents or reliability of any linked 
websites referenced within this site or Documentation provided by 
Avaya. Avaya is not responsible for the accuracy of any information, 
statement or content provided on these sites and does not necessarily 
endorse the products, services, or information described or offered 
within them. Avaya does not guarantee that these links will work all the 
time and has no control over the availability of the linked pages. 

 

Warranty 

Avaya provides a limited warranty on Avaya hardware and software. 
Refer to your sales agreement to establish the terms of the limited 
warranty. In addition, Avaya’s standard warranty language, as well as 
information regarding support for this product while under warranty is 
available to Avaya customers and other parties through the Avaya 
Support website: 
http://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091
120112456651010 under the link “Warranty & Product Lifecycle” or such 
successor site as designated by Avaya.  Please note that if You acquired 
the product(s) from an authorized Avaya Channel Partner outside of the 
United States and Canada, the warranty is provided to You by said 
Avaya Channel Partner and not by Avaya.  

“Hosted Service” means an Avaya hosted service subscription that You 
acquire from either Avaya or an authorized Avaya Channel Partner (as 

applicable) and which is described further in Hosted SAS or other 
service description documentation regarding the applicable hosted 
service.  If You purchase a Hosted Service subscription, the foregoing 
limited warranty may not apply but You may be entitled to support 
services in connection with the Hosted Service as described further in 
your service description documents for the applicable Hosted Service.  
Contact Avaya or Avaya Channel Partner (as applicable) for more 
information.   

Hosted Service  

THE FOLLOWING APPLIES ONLY IF YOU PURCHASE AN Avaya 
HOSTED SERVICE SUBSCRIPTION FROM AVAYA OR AN AVAYA 
CHANNEL PARTNER (AS APPLICABLE), THE TERMS OF USE FOR 
HOSTED SERVICES ARE AVAILABLE ON THE AVAYA WEBSITE, 
http://support.avaya.com/LicenseInfo under the link “Avaya Terms of 
Use for Hosted Services” or such successor site as designated by 
Avaya, AND ARE APPLICABLE TO ANYONE WHO ACCESSES OR USES 
THE HOSTED SERVICE. BY ACCESSING OR USING THE HOSTED 
SERVICE, OR AUTHORIZING OTHERS TO DO SO, YOU, ON BEHALF OF 
YOURSELF AND THE ENTITY FOR WHOM YOU ARE DOING SO 
(HEREINAFTER REFERRED TO INTERCHANGEABLY AS “YOU” AND 
“END USER”), AGREE TO THE TERMS OF USE.  IF YOU ARE 
ACCEPTING THE TERMS OF USE ON BEHALF A COMPANY OR OTHER 
LEGAL ENTITY, YOU REPRESENT THAT YOU HAVE THE AUTHORITY 
TO BIND SUCH ENTITY TO THESE TERMS OF USE.  IF YOU DO NOT 
HAVE SUCH AUTHORITY, OR IF YOU DO NOT WISH TO ACCEPT THESE 
TERMS OF USE, YOU MUST NOT ACCESS OR USE THE HOSTED 
SERVICE OR AUTHORIZE ANYONE TO ACCESS OR USE THE HOSTED 
SERVICE.   

Licenses THE SOFTWARE LICENSE TERMS AVAILABLE ON THE 
AVAYA WEBSITE, HTTP://SUPPORT.AVAYA.COM/LICENSEINFO, 
UNDER THE LINK “AVAYA SOFTWARE LICENSE TERMS (Avaya 
Products)” or such successor site as designated by Avaya, ARE 
APPLICABLE TO ANYONE WHO DOWNLOADS, USES AND/OR 
INSTALLS AVAYA SOFTWARE, PURCHASED FROM AVAYA INC., ANY 
AVAYA AFFILIATE, OR AN  AVAYA CHANNEL PARTNER (AS 
APPLICABLE) UNDER A COMMERCIAL AGREEMENT WITH AVAYA OR 
AN  AVAYA CHANNEL PARTNER. UNLESS OTHERWISE AGREED TO BY 
AVAYA IN WRITING, AVAYA DOES NOT EXTEND THIS LICENSE IF THE 
SOFTWARE WAS OBTAINED FROM ANYONE OTHER THAN AVAYA, AN 
AVAYA AFFILIATE OR AN AVAYA CHANNEL PARTNER; AVAYA 

RESERVES THE RIGHT TO TAKE LEGAL ACTION AGAINST YOU AND 
ANYONE ELSE USING OR SELLING THE SOFTWARE WITHOUT A 
LICENSE. BY INSTALLING, DOWNLOADING OR USING THE SOFTWARE, 
OR AUTHORIZING OTHERS TO DO SO, YOU, ON BEHALF OF YOURSELF 
AND THE ENTITY FOR WHOM YOU ARE INSTALLING, DOWNLOADING OR 
USING THE SOFTWARE (HEREINAFTER REFERRED TO 
INTERCHANGEABLY AS “YOU” AND “END USER”), AGREE TO THESE 

TERMS AND CONDITIONS AND CREATE A BINDING CONTRACT 
BETWEEN YOU AND AVAYA INC. OR THE APPLICABLE AVAYA 
AFFILIATE (“AVAYA”). 

Avaya grants You a license within the scope of the license types 
described below, with the exception of Heritage Nortel Software, for which 
the scope of the license is detailed below. Where the order documentation 
does not expressly identify a license type, the applicable license will be a 
Designated System License as set forth below in Section M(i)1 or 2 as 
applicable. The applicable number of licenses and units of capacity for 
which the license is granted will be one (1), unless a different number of 
licenses or units of capacity is specified in the documentation or other 
materials available to You.  “Software” means computer programs in 
object code, provided by Avaya or an Avaya Channel Partner, whether as 
stand-alone products, pre-installed on hardware products, and any 
upgrades, updates, patches, bug fixes, or modified versions thereto.  
“Designated Processor” means a single stand-alone computing device. 
“Server” means a set of Designated Processors that hosts (physically or 
virtually) a software application to be accessed by multiple users. 
“Instance” means a single copy of the Software executing at a particular 
time: (i) on one physical machine; or (ii) on one deployed software virtual 
machine (“VM”) or similar deployment.   

License types 

Designated System(s) License (DS). End User may install and use each 
copy or an Instance of the Software only: 1) on a number of Designated 
Processors up to the number indicated in the order; or 2) up to the number 
of Instances of the Software as indicated in the order, Documentation, or 
as authorized by Avaya in writing. Avaya may require the Designated 
Processor(s) to be identified in the order by type, serial number, feature 
key, Instance, location or other specific designation, or to be provided by 
End User to Avaya through electronic means established by Avaya 
specifically for this purpose. 

Concurrent User License (CU). End User may install and use the Software 
on multiple Designated Processors or one or more Servers, so long as 
only the licensed number of Units are accessing and using the Software at 
any given time as indicated in the order, Documentation, or as authorized 
by Avaya in writing. A "Unit" means the unit on which Avaya, at its sole 
discretion, bases the pricing of its licenses and can be, without limitation, 
an agent, port or user, an e-mail or voice mail account in the name of a 
person or corporate function (e.g., webmaster or helpdesk), or a directory 
entry in the administrative database utilized by the Software that permits 
one user to interface with the Software. Units may be linked to a specific, 
identified Server or an Instance of the Software. 

 

Heritage Nortel Software 

“Heritage Nortel Software” means the software that was acquired by 
Avaya as part of its purchase of the Nortel Enterprise Solutions Business 
in December 2009.  The Heritage Nortel Software  is the software 
contained within the list of Heritage Nortel Products located at 
http://support.avaya.com/LicenseInfo/ under the link “Heritage Nortel 
Products,” or such successor site as designated by Avaya. For Heritage 
Nortel Software, Avaya grants Customer a license to use Heritage Nortel 
Software provided hereunder solely to the extent of the authorized 
activation or authorized usage level, solely for the purpose specified in the 
Documentation, and solely as embedded in, for execution on, or  for 
communication with Avaya equipment. Charges for Heritage Nortel 
Software may be based on extent of activation or use authorized as 
specified in an order or invoice. 

 

Copyright 

Except where expressly stated otherwise, no use should be made of 
materials on this site, the Documentation, Software, Hosted Service, or 
hardware provided by Avaya. All content on this site, the documentation, 
Hosted Service, and the product provided by Avaya including the 
selection, arrangement and design of the content is owned either by 
Avaya or its licensors and is protected by copyright and other intellectual 
property laws including the sui generis rights relating to the protection of 
databases. You may not modify, copy, reproduce, republish, upload, post, 
transmit or distribute in any way any content, in whole or in part, including 
any code and software unless expressly authorized by Avaya. 
Unauthorized reproduction, transmission, dissemination, storage, and or 
use without the express written consent of Avaya can be a criminal, as 
well as a civil offense under the applicable law. 

Virtualization  

The following applies if the product is deployed on a virtual machine.  
Each product has its own ordering code and license types.  Unless 
otherwise stated, each Instance of a product must be separately licensed 
and ordered. For example, if the end user customer or Avaya Channel 
Partner would like to install two Instances of the same type of products, 
then two products of that type must be ordered.  

http://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
http://support.avaya.com/helpcenter/getGenericDetails?detailId=C20091120112456651010
http://support.avaya.com/LicenseInfo
http://support.avaya.com/LICENSEINFO


Third Party Components  

“Third Party Components” mean certain software programs or portions 
thereof included in the Software   or Hosted Service may contain 
software (including open source software) distributed under third party 
agreements (“Third Party Components”), which contain terms regarding 
the rights to use certain portions of the Software (“Third Party Terms”). 
As required, information regarding distributed Linux OS source code 
(for those products that have distributed Linux OS source code) and 
identifying the copyright holders of the Third Party Components and the 
Third Party Terms that apply is available in the products, Documentation 
or on Avaya’s website at: http://support.avaya.com/Copyright or such 
successor site as designated by Avaya.   The open source software 
license terms provided as Third Party Terms are consistent with the 
license rights granted in these Software License Terms, and may 
contain additional rights benefiting You, such as modification and 
distribution of the open source software.  The Third Party Terms shall 
take precedence over these Software License Terms, solely with respect 
to the applicable Third Party Components, to the extent that these 
Software License Terms impose greater restrictions on You than the 
applicable Third Party Terms. 

The following applies only if the H.264 (AVC) codec is distributed with 
the product.   THIS PRODUCT IS LICENSED UNDER THE AVC PATENT 
PORTFOLIO LICENSE FOR THE PERSONAL USE OF A CONSUMER OR 
OTHER USES IN WHICH IT DOES NOT RECEIVE REMUNERATION TO (i) 
ENCODE VIDEO IN COMPLIANCE WITH THE AVC STANDARD ("AVC 
VIDEO") AND/OR (ii) DECODE AVC VIDEO THAT WAS ENCODED BY A 
CONSUMER ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS 
OBTAINED FROM A VIDEO PROVIDER LICENSED TO PROVIDE AVC 

VIDEO. NO LICENSE IS GRANTED OR SHALL BE IMPLIED FOR ANY 
OTHER USE. ADDITIONAL INFORMATION MAY BE OBTAINED FROM 
MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM 

Service Provider   

THE FOLLOWING APPLIES TO AVAYA CHANNEL PARTNER’S HOSTING 
OF AVAYA PRODUCTS OR SERVICES.  THE PRODUCT OR HOSTED 
SERVICE MAY USE THIRD PARTY COMPONENTS SUBJECT TO THIRD 
PARTY TERMS AND REQUIRE A SERVICE PROVIDER TO BE 
INDEPENDENTLY LICENSED DIRECTLY FROM THE THIRD PARTY 
SUPPLIER.  AN AVAYA CHANNEL PARTNER’S HOSTING OF AVAYA 
PRODUCTS MUST BE AUTHORIZED IN WRITING BY AVAYA AND IF 
THOSE HOSTED PRODUCTS USE OR EMBED CERTAIN THIRD PARTY 
SOFTWARE, INCLUDING BUT NOT LIMITED TO MICROSOFT 
SOFTWARE OR CODECS, THE AVAYA CHANNEL PARTNER IS 
REQUIRED TO INDEPENDENTLY OBTAIN ANY APPLICABLE LICENSE 
AGREEMENTS, AT THE AVAYA CHANNEL PARTNER’S EXPENSE, 
DIRECTLY FROM THE APPLICABLE THIRD PARTY SUPPLIER.  

WITH RESPECT TO CODECS, IF THE AVAYA CHANNEL PARTNER IS 
HOSTING ANY PRODUCTS THAT USE OR EMBED THE  H.264 CODEC 
OR H.265 CODEC, THE AVAYA CHANNEL PARTNER ACKNOWLEDGES 

AND AGREES THE AVAYA CHANNEL PARTNER IS RESPONSIBLE FOR 
ANY AND ALL RELATED FEES AND/OR ROYALTIES.    THE H.264 (AVC) 
CODEC IS LICENSED UNDER THE AVC PATENT PORTFOLIO LICENSE 
FOR THE PERSONAL USE OF A CONSUMER OR OTHER USES IN 
WHICH IT DOES NOT RECEIVE REMUNERATION TO: (I) ENCODE VIDEO 
IN COMPLIANCE WITH THE AVC STANDARD ("AVC VIDEO") AND/OR (II) 
DECODE AVC VIDEO THAT WAS ENCODED BY A CONSUMER 
ENGAGED IN A PERSONAL ACTIVITY AND/OR WAS OBTAINED FROM A 
VIDEO PROVIDER LICENSED TO PROVIDE AVC VIDEO.  NO LICENSE IS 
GRANTED OR SHALL BE IMPLIED FOR ANY OTHER USE.   ADDITIONAL 
INFORMATION FOR H.264 (AVC) AND H.265 (HEVC) CODECS MAY BE 
OBTAINED FROM MPEG LA, L.L.C. SEE HTTP://WWW.MPEGLA.COM.    

Compliance with Laws 

You acknowledge and agree that it is Your responsibility for complying 
with any applicable laws and regulations, including, but not limited to 
laws and regulations related to call recording, data privacy, intellectual 
property, trade secret, fraud, and music performance rights, in the 
country or territory where the Avaya product is used. 

Preventing Toll Fraud 

“Toll Fraud” is the unauthorized use of your telecommunications 
system by an unauthorized party (for example, a person who is not a 
corporate employee, agent, subcontractor, or is not working on your 
company's behalf). Be aware that there can be a risk of Toll Fraud 
associated with your system and that, if Toll Fraud occurs, it can result 
in substantial additional charges for your telecommunications services. 

Avaya Toll Fraud intervention 

If You suspect that You are being victimized by Toll Fraud and You need 
technical assistance or support, call Technical Service Center Toll Fraud 
Intervention Hotline at +1-800-643-2353 for the United States and 
Canada. For additional support telephone numbers, see the Avaya 
Support website: http://support.avaya.com, or such successor site as 
designated by Avaya.  

Security Vulnerabilities 

Information about Avaya’s security support policies can be found in the 
Security Policies and Support section of  
https://support.avaya.com/security 

Suspected Avaya product security vulnerabilities are handled per the 

Avaya Product Security Support Flow 
(https://support.avaya.com/css/P8/documents/100161515). 

Downloading Documentation 

For the most current versions of Documentation, see the Avaya Support 
website: http://support.avaya.com, or such successor site as designated 
by Avaya. 

Contact Avaya Support 

See the Avaya Support website: http://support.avaya.com for product or 
Hosted Service notices and articles, or to report a problem with your 
Avaya product or Hosted Service. For a list of support telephone numbers 
and contact addresses, go to the Avaya Support website: 
http://support.avaya.com (or such successor site as designated by Avaya), 
scroll to the bottom of the page, and select Contact Avaya Support. 
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Trademarks 

The trademarks, logos and service marks (“Marks”) displayed in this 
site, the Documentation, Hosted Service(s), and product(s) provided by 
Avaya are the registered or unregistered Marks of Avaya, its affiliates, 
its licensors, its suppliers, or other third parties. Users are not permitted 
to use such Marks without prior written consent from Avaya or such 
third party which may own the Mark. Nothing contained in this site, the 
Documentation, Hosted Service(s) and product(s) should be construed 
as granting, by implication, estoppel, or otherwise, any license or right 
in and to the Marks without the express written permission of Avaya or 
the applicable third party. 

Avaya is a registered trademark of Avaya Inc. 

All non-Avaya trademarks are the property of their respective owners. 

Linux® is the registered trademark of Linus Torvalds in the U.S. and 
other countries.  
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Chapter 1: Introduction 
 
 
 
 

 

Purpose 

The purpose of this guide is to provide agent-related information about Avaya Interaction Center 
Agent. 

 
 
 
 

Intended audience 

This guide is for the customers and agents using Interaction Center. 
 
 
 
 

Document changes since last issue 

The following sections have been modified in this document since the last issue: 

● Managing email contacts 

● Using resources in an email 

● Understanding notifications 

● Understanding the tabbed pane 

● Popping out your chat task to a separate window 

● Performing a Blind Chat transfer 

● Transferring a Chat Contact to Another Agent 

● Involving other agents in a chat contact 

mailto:infodev@avaya.com
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Related resources 
 
 
 

Documentation 

See the following related documents at http://support.avaya.com. 

 

 
Finding documents on the Avaya Support website 

Use this procedure to find product documentation on the Avaya Support website. 

1. Use a browser to navigate to the Avaya Support website at http://support.avaya.com. 

2. At the top of the screen, enter your username and password and click Login. 

3. Click Documents. 

4. In the Enter your Product Here search box, type the product name and then select the 
product from the drop-down list. 

5. If there is more than one release, select the appropriate release number from the Choose 

Release drop-down list. 

6. Use the Content Type filter on the left to select the type of document you are looking for, 

or click Select All to see a list of all available documents. 

For example, if you are looking for user guides, select User Guides in the Content Type 

filter. Only documents in the selected category will appear in the list of documents. 

7. Click Enter. 
 

 

Training 

The following courses are available on the Avaya Learning website at www.avaya-learning.com. 

In the Search field, enter the course code, and click Go to search for the course. 

 

Course Code Course Title 

ATC01175WEN IC and OA Overview 

ATC01176IEN Interaction Center Administration and Configuration 

AUCC100010695 IC-Siebel Integration 

ATC100011017 IC-Siebel Integration, Installation and Troubleshooting 

mailto:infodev@avaya.com
http://support.avaya.com/
http://support.avaya.com/
http://www.avaya-learning.com/
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Support 
 
 
 

Viewing Avaya Mentor videos 

Avaya Mentor videos provide technical content on how to install, configure, and troubleshoot 
Avaya products. 

Videos are available on the Avaya Support website, listed under the video document type, and 

on the Avaya-run channel on YouTube. 

● To find videos on the Avaya Support website, go to http://support.avaya.com and perform 

one of the following actions: 

- In Search, type Avaya Mentor Videos to see a list of the available videos. 

- In Search, type the product name. On the Search Results page, select Video in the 
Content Type column on the left. 

● To find the Avaya Mentor videos on YouTube, go to www.youtube.com/AvayaMentor and 

perform one of the following actions: 

- Enter a key word or key words in the Search Channel to search for a specific product 

or topic. 

- Scroll down Playlists, and click the name of a topic to see the available list of videos 
posted on the website. 

Note: 
Videos are not available for all products. 

 
 
 
 

Support 

Go to the Avaya Support website at http://support.avaya.com for the most up-to-date 

documentation, product notices, and knowledge articles. You can also search for release notes, 

downloads, and resolutions to issues. Use the online service request system to create a service 

request. Chat with live agents to get answers to questions, or request an agent to connect you 

to a support team if an issue requires additional expertise. 

mailto:infodev@avaya.com
http://support.avaya.com/
http://www.youtube.com/AvayaMentor
http://support.avaya.com/
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Chapter 2: Overview 

 

Avaya Agent and Web Agent, integrated components of Avaya Agent, are installed on a 

computer as part of the Avaya Interaction Center (Avaya IC) software suite. 

Depending on the features available in your contact center, you can use Avaya Agent and Web 
Agent to interact with customers in the following ways: 

● Use Telephony to speak with customers who call your company. 

● Use Email Management to read and reply to emails from the customer. 

● Use Web Management to chat with customers over the Internet by exchanging text 

messages and webpages. You can also speak to customers on the telephone while in a 

chat session with the customers, or share Internet browsers with the customers. 

Note: 
In this user guide, the illustrations show the Avaya Agent interface on the right 

side and across the bottom of the desktop. The Avaya Agent interface on your 

computer might differ from the interface shown in the illustrations in this user 

guide. Contact your system administrator if you need help in understanding the 

setup of Avaya Agent that you see on your computer. 

This chapter describes the interface of the Avaya Agent and the Web Agent. 
 
 
 
 

Avaya Agent 

Using the Avaya Agent application, you can handle incoming and outgoing contacts with 
customers. The interface of Avaya Agent application surrounds the desktop on the computer. 

You can see the following components on the Avaya Agent interface: 

● Media tab. This tab contains: 

- Task lists where you receive telephone calls, emails, and chat requests assigned to 
you. 

- Softphone for speaking with customers who call. 

● Contact History Browser tab: This tab is located on the Contact History Browser, for 

information about previous contacts your customers have had with your company. 

● Prompter tab: This tab is located on the Contact History Browser, for scripts directing you 
what to say to customers. 

● EDU Viewer (Electronic Data Unit Viewer) for information about your current contacts. 

mailto:infodev@avaya.com
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You can set other applications that you work with, such as Microsoft Word, to open within the 

Avaya Agent framework. 

  Tip: 

Press Alt+Tab to continue through the open applications while looking at the 

contact information displayed in the Avaya Agent. To move Avaya Agent behind 

the other applications, clear the Always on Top check box in the Avaya Agent 

menu. For information on this option, see Avaya Agent menu on page 16. 
 

 

Using Avaya Agent with multiple languages 

In the Avaya Agent interface, you can communicate with customers in multiple languages other 
than the English language. Following are the features of Avaya Agent and Web Agent, where 

you can use multiple languages: 

● Unified Agent Directory 

● Email 

● Chat 

● Spell checking of email and chat contents 

● Auto-Sync and Push URL 

● Global Resources and Agent Resources 

● Email Templates 

● Suggested Responses 

● Web Self-Service database 

● DataWake 

mailto:infodev@avaya.com
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Avaya Agent menu 

You can gain access to the Avaya Agent menu by clicking the Avaya Agent button at the top of 
the right pane. The Avaya Agent menu consists of the following menu items: 

 

Menu Item Action 

Always on top Use this option to keep the Avaya Agent window always visible on the 
desktop of your computer. 

If you select the Always on top menu item, the system resizes all open 
applications so that the Avaya Agent interface remains visible. 

Click the Always on top menu item and clear the check box if you do 
not need the Avaya Agent interface on top on the desktop of your 
computer. 

Change Password Use this menu item to change your Avaya Agent password. 

If this menu item is unavailable, the system prompts you to change 
your Avaya Agent password when the current password expires. 

Help Use this option to display the Avaya Agent online help. 

About Avaya Agent Use this option to display information about the Avaya Agent 
application release. 

Minimize Use this option to minimize the Avaya Agent application. 

To restore the Avaya Agent, click the Avaya Agent icon on the 
Windows task bar. 

Exit Use this option to close Avaya Agent, the Web Agent, and all open 
windows related to Avaya Agent and Web Agent. 

 

 

Avaya Agent panes 

On the Avaya Agent interface, you can see different panes consisting of various options to 
handle incoming and outgoing customer contacts. 

This section provides information about the following panes and the options available on these 
panes: 

● Media tab on page 17 

● Task lists on page 17 

● Softphone on page 17 

● Contact History browser and EDU viewer on page 18 

● Prompter scripts on page 18 
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Media tab 

On the Media tab, you can view the options for handling your incoming voice, email, and chat 
contacts. 

The Status Control bar displays an Agent button and a button or an icon for each inbound 

media channel such as, Voice, Email, and Web Chat that is activated for you. 

  Tip: 

The buttons are only available if you are working in manual mode. For more 

information, see Setting Manual mode on page 45. 

The text under the Status Control bar displays the following information: 

● Login ID. 

● Channel load in the media channels, that is, the maximum number of customer contacts of 
each media channel that you can handle at a time. 

 
Task lists 

Depending on your responsibilities, you can see any or all of the following tasks listed on the 

Media tab of your Avaya Agent interface: 

● Phone task list, described in Using the phone task list and softphone on page 64 

● Email task list, described in Using the email task list on page 78 

● Chat task list, described in Using the Chat task list on page 119 

When an incoming contact is assigned to you, the system displays that incoming contact in an 

appropriate task list. The task list also displays the information, such as the time when the 

contact is assigned to you and the state of the contact. 

  Tip: 

You can view the contact information by selecting a contact and holding a mouse 

pointer on that contact. The system displays a tooltip with information about the 
selected contact. 

In the task list, double-click the contact to start interaction with the contact. 

 
Softphone 

Using Softphone, you can perform standard telephone operations on your computer instead of 

a physical telephone. 

The Softphone interface is on the Media tab of the Avaya Agent interface. The Softphone 

interface contains the Phone task list and the telephony buttons that you can use to manage 

your incoming and outgoing voice contacts. 

For information on the Softphone, see Using the phone task list and softphone on page 64. 
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Contact History browser and EDU viewer 

You can use the Contact History browser and the Electronic Data Unit (EDU) viewer to locate 
information about the contacts in your task lists. 

Each tab in the Contact History browser contains the history of a contact in your task lists. Each 

tab in the EDU viewer contains current information about a contact in your task lists. 

An EDU is a set of information about an active contact, such as, voice, email, or chat. The EDU 

viewer displays an EDU for each contact that you are currently handling. 

The bottom pane of the Avaya Agent interface contains buttons, which you can use to gain 
access to the following: 

 

Icon Button Caption Description 

 

 

Contact History Filter Filters the records in the Contact History browser to gain 
access to only the historical information that you need for 
the current customer contact. 

 

 

Active Contact Viewer Displays information about any other active contacts from 
the same customer. 

Usually, the contacts are the email contacts assigned to 
other agents. 

 

Prompter scripts 

The system administrator develops Prompter scripts to assist you while you handle contacts. 

Each script provides a consistent method for agents to communicate with customers. On the 

Avaya Agent interface, you can view the Prompter scripts on the Prompter tab, which is 

present at the bottom side of the desktop. The script provides information from a customer and 

gives the required the information to the customer. 

The Prompter scripts can contain statements that you say to customers. The script can also 

contain option buttons and text fields that you can use to indicate the answers from customers, 

and a selection of reasons that explains the questions from customers and how you handled the 

contact. 

You can use Prompter scripts to perform the following: 

● Collect information about customers. 

● Provide answers and information to customers. 

● Enter wrap-up information about a contact with a customer. 

● Contact a customer for a marketing or sales campaign. 

Each answer that a customer gives is the next step in a Prompter script. For example, if a 

customer reports a problem about a product the customer purchased from a company, the script 

is different for a customer who has a valid product warranty than for a customer who does not. 
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Sometimes, the system displays a Prompter script automatically, for example, when you answer 

a customer contact. 
 
 
 
 

Web Agent 

Using the Email Management or Web Management features of the Web Agent component, you 

can interact with customers. 

The Web Agent opens within the Avaya Agent interface when you handle emails and chat 

contacts. 

With Web Management, you can conduct a chat session with customers. While in a chat 

session, you can use the following features: 

● Text Chat: exchanging text messages with your customer in real-time. 

● Voice Chat: talking to your customer using either Chat and Phone or Chat and Voice over 

Internet Protocol (VoIP). 

● Shared Browsing: viewing the same webpages with your customer, using the Auto Sync, 

Push URL, and Collaborative Form Filling features. 

Customers can send an email or initiate a chat session by clicking an appropriate button on the 

website of your company. According to your availability for email or chat, some of these emails 

and chat requests are assigned to you as email contacts or chat contacts. When you 

double-click a contact in your email task list or your chat task list, the Web Agent is displayed. 

The Web Agent is the component where you compose your email responses and conduct your 

chat sessions. 

When you log in to Avaya Agent, you log in to the Web Agent automatically. 

The appearance of the Web Agent changes, according to what you are doing. This section 

explains the features of the Web Agent window while you are handling email or chat contacts, 

under the following topics: 

● The Web Agent while handling an email 

● The Web Agent while handling chat 

● The Web Agent in Supervisor mode 

● The Web Agent status bar 

● The Web Agent information bar 

● Web Agent menus 

● The Web Agent toolbars 

mailto:infodev@avaya.com


Web Agent 

 20 July 2021  Agent User Guide 

Comments on this document? infodev@avaya.com 

 

 

 
 
 

 

The Web Agent while handling an email 

If you receive emails, you can use the Web Agent together with the Avaya Agent to handle 
email contacts from customers. You can use two email modes in the Web Agent: 

● Email Preview: This mode is a read-only view for the mails from customer. If you click the 

Reply, Reply to All, or Forward button on the email toolbar, the view changes to 

Compose mode. 

● Compose: This is where you create a new email or write a reply to an email. 

You can change between the two modes by clicking the Preview tab or the Compose tab. If 

you are handling multiple emails simultaneously, each email has its own Compose tab for your 

reply. 

The following sections describe the features of the Web Agent window while handling email 

● Common features in Email Preview and Compose modes 

● Features of the Email Preview mode 

● Features of the Compose mode 
 

Common features in Email Preview and Compose modes 

The features of the Web Agent window that are common to the Preview and Compose mode 

are as follows: 

● Menu Bar: Names of the menus containing commands: Contact, Resources, and Tools. 
Click the name of a menu to open it and display the commands. 

● Main Toolbar: Buttons below the menu bar for gaining quick access to frequently used 

commands. The toolbar remains the same, whether you are in email mode or chat mode. 

See The Main toolbar on page 27. 

● Resource Toolbar and Filters: Buttons for resource-related commands and a Filter menu 
for displaying only the type of resources you want to see. See Resource toolbar on 
page 34. 

● Resource Area: Pane of window that contains resources, previously prepared text 

responses, emails, and Internet addresses that you can send to customers. Resource 

Area might contain folders for each of the following: Agent Resources, Global Resources, 

Email Templates, and Suggested Responses. 

● Resource Preview Scroll Box: When you select a resource from a folder and then select 
the Preview content check box, a scroll box displays the contents of the resource. 

● Information Bar: Displays important information about the current email. If you switch to a 
chat contact, it displays information about your active chat. See The Web Agent 

information bar on page 25. 
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● Status Bar: Icons that indicate certain aspects of your current Web Agent status. See The 

Web Agent status bar on page 23. 

Note: 
If the Webagent sets the "Read emails in HTML" preference as true, then some of 

the non-English characters of the email might be rendered as junk characters, for 

example, as boxes. This happens if the character encoding used to send the 

email to IC does not contain these characters in its character set table. The email 

client might give a warning to change the encoding to UTF-8. If the email client 

does not give a warning, you must set it explicitly. If the Webagent sets the "Read 

emails in HTML" preference as false, then some of the non-English characters of 

the email might be rendered as junk characters even if the character encoding is 

set to UTF-8. 

 

Features of the Email Preview mode 

The following areas are displayed only in the Email Preview mode: 

● Company Logo: Area that displays a logo that represents a company. If your contact 

center supports different companies or tenants, the logo might change according to the 

website from which the customer sent the active email. 

● Email Preview Toolbar: Toolbar with buttons that help you perform various actions for the 

email, such as reply to, forward, defer, resolve, transfer the email, open attachments to the 

email, or view previous emails the customer sent to the contact center. See Email toolbar 

in the Email Preview mode on page 27. 

● Customer Email Header Area: Information about the email of the customer, consisting of 

the email address of the customer, any other addresses to which the email was sent, the 

date and time the email was sent, and the subject that the customer entered for the email. 

If you click the UAD button, you can find and add addresses of people in your company. 

For detailed technical information about the active email, click the Header check box. 

● Customer Message Area: Box where you can read emails received from customer. You 

cannot edit the text in the message in Email Preview mode. 

 
Features of the Compose mode 

The following features are available only in the Compose mode: 

● Compose Toolbar: The Compose Toolbar contains buttons that help you perform various 

actions to your email reply, such as print, save a draft, cancel, add attachments, spell 

check, and see email history. See Email toolbar in the Email Preview mode on page 27. 

● Drop-down Menu and Send Button: This menu helps you select whether the reply is a 
normal reply, a message to an external agent, or a request to the customer for additional 

information. An external agent is a person outside the company who has been designated 

as a subject matter expert who can help customers when agents request assistance. The 

Send button sends the email that is currently in the Message Composition area to the 

addresses in the header fields. 
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● Outbound Email Header Area: This tab displays information about the email you are 

composing, with the addresses to which the email will be sent and the subject of the 

message. 

● Attachments Area: This tab helps you attach files to the email and displays information 

about any files you have attached. 

● Message Composition Area: The area where you compose an email. It might contain the 

message that you are replying to in addition to the message that you compose. 
 

 

The Web Agent while handling chat 

The features of the Web Agent window in Chat mode are as follows: 

● Menus – Names of menus that contain commands. Click the name of a menu to open the 
menu and display the commands. 

● Main Toolbar – Buttons below the menu bar for gaining a quick access to frequently used 

commands for email or chat. See The Main toolbar on page 27. 

● Resource Toolbar and Filters – Buttons for resource-related commands and a Filter menu 

for displaying only the type of resources you require to see. See Resource toolbar on 

page 34. 

● Resource Area – Pane that contains resources, which are previously prepared text 

responses, emails, and Internet addresses that you can send to customers. The resource 

area might contain folders for Agent Resources, Global Resources, and Email Templates. 

● Resource Preview Scroll Box (not shown) – When you select a resource from a folder and 

then select the Preview content check box, a scroll box displays the contents of the 

resource. 

● Company Logo – Area that displays a logo that represents a company. If your contact 
center supports different companies or tenants, the logo may change according to the 

website from which the customer requested the current chat session. 

● Chat Toolbars – Main chat toolbar that contains buttons for controlling the current chat 

session. Additional toolbars are added when you conduct a chat and phone or a chat and 

VoIP session. See Chat toolbars on page 32. 

● Send Bar – Buttons for sending a URL that opens in the browser of your customer and for 
sending the text you enter in the Text Entry area to your customer. 

● Information Bar – Area that displays important information about your active chat session. 

If you switch to an email contact, it displays information about your active email. See The 

Web Agent information bar on page 25. 

● Customer’s Question – Area that displays the original question typed by the customer on 

the website. This area also displays other information about the customer and the site from 

which the customer requested the chat. This information can also help you identify guest 

users for example, people who log on to the company website without a user account. 
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● Transcript Area: Area that displays the chat conversation that has occurred so far between 

you and the customer. 

● Text Entry: Area where you enter text or Uniform Resource Locators (URLs) to send to the 

customer. 

● Status Bar: Icons that indicate certain aspects of your current Web Agent status. 
 

 

The Web Agent in Supervisor mode 

If you are a supervisor, you can click the Switch to Supervisor Mode button whenever you 
want to monitor a chat session. 

When you select the session you want to monitor, the Transcript and Text Entry areas display 

the chat session. For more information, see Monitoring a Chat Session (Supervisors Only) on 

page 150. 
 

 

The Web Agent status bar 

The following table describes the icons on the Web Agent Status Bar, from left to right: 

 

Icon Description 

WebACD 
Connection Status 

Shows the status of your connection to the Web Automatic Call 
Distribution Server (WebACD Server) with the following colors: 

● Red: Your Web Agent is not connected to the WebACD server. 

● Orange: Your Web Agent is in the process of connecting to the 
WebACD server. 

● Green: Your Web Agent is connected to the WebACD server. 

Note: 
For the WACD server that you restarted or that becomes 

nonfunctional, the status is indicated in Orange color. 

Email Server 
Connection Status 

Shows the status of your connection to the email server, which handles 
your email contacts. 

● Red: Your Web Agent is not connected to the Email server. 

● Orange: Your Web Agent is in the process of connecting to the Email 
server. 

● Green: Your Web Agent is connected to the Email server. 

Note: 
For the Email server that you restarted or that becomes 

nonfunctional, the status is indicated in Orange color. 
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Icon Description 

Chat Server 
Connection Status 

Is only present as an icon when you are handling one or more chat 
contacts. It shows the status of your connection to the Chat Server. 

● Red: Your Web Agent is not connected to the Chat server. 

● Orange: Your Web Agent is in the process of connecting to the Chat 
server. 

● Green: Your Web Agent is connected to the Chat server. 

Note: 
For the Chat server that you restarted or that becomes 

nonfunctional, the status is indicated in Orange color. 

Supervisor Status 
and 
Login ID 

If you are an agent, shows your supervisor’s login ID and indicates 
whether the supervisor is currently logged in. 

The supervisor icon has a stripe on the shirt so you can distinguish it from 
your own icon. The shirt color indicates your supervisor’s login status, as 
follows: 

● Grey: Your supervisor is not online. 

● Red with yellow stripe: Your supervisor is logged in. 

If you are a supervisor, the status bar does not have the Supervisor icon. 

From IC Release 7.3.5, vaya Agent Rich Client (AARC) uses supervisors 
from the assigned supervisors list to monitor an agent logged in to Avaya 
(AARC). 

Avaya Agent Web Client (AAWC) and SDK client use the default 
supervisor selected from the assigned supervisors list for agent 
monitoring purposes. 

Workgroup The name of the workgroup to which you belong. The icon does not 
change color. 

Agent Status and 
Login ID 

Shows your login ID and your agent status with the following shirt colors: 

● Grey: You are not logged in to the Web Agent. 

● Red/Yellow: You are logged in. 

Chat channel load Shows your availability for chat and, if you are available, your chat 
channel load that is, the maximum number of chat customers you can 
currently handle at the same time. Zero means that you are currently 
unavailable to help chat customers. The icon does not change color. 

Email channel 
load 

Shows your availability for email and, if you are available, your email 
channel load (the maximum number of email customers you can currently 
handle at the same time). Zero means that you are currently unavailable 
to receive email contacts. The icon does not change color. 
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The Web Agent information bar 

The Web Agent has an Information Bar for you to attend to important information, whether you 
are in an email contact or a chat contact. The Information Bar displays messages such as: 

● New inbound email from a customer. 

● New chat request from a customer. 

● This email will be sent to a customer. 

● Response rejected during quality assurance. 

● Transfer request successful. 
 

 

Web Agent menus 

The Web Agent has the following menus on the menu bar: 

● Contact: This menu displays commands related to chat and email contacts. The Print 

command prints whatever is displayed in the current window to the default printer. When 

you have an active chat contact, you can use the Auto Sync and JoinUs options. See 

Managing chat contacts on page 118 for information on these features. You can use the 

Spell Check option at any time to check an email or a chat. You can use options to 

transfer and wrap up a contact. 

When you have an active chat contact, you can also use the Blind Transfer and Pop In/ 

Pop Out the Chat options. For more information on these features, see Performing a 

Blind Chat transfer on page 143 and Popping out your chat task to a separate window on 

page 121. 

● Resources: This menu has a set of commands related to resources such as pre-written 
text, URLs, and emails that you can send to customers. With one set of options, you can 

create, delete, save, and view your own Agent resources. With the Expand all folders 

and Collapse all folders options, you can determine whether to view all resource folders 

or only the main folder or folders. You can also use the Filter by drop-down list to limit the 

display to the types of resources you want to see. 

  Tip: 

The Resources toolbar above the Resource area has some additional commands 

related to resources. 

● Tools: This menu contains a set of commands that link to webpages for agents and 

customers, a set of two commands that relate to email, and the Preferences command 

that helps you customize the look of the Web Agent and set various options related to chat 

and email. 
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● Help: This menu contains an About option that displays the information about Avaya Web 

Agent. The information on the About Avaya Web Agent dialog box contains the version 

number and the build number of the Web Agent.. 
 

 

The Web Agent toolbars 

The Web Agent has several toolbars containing buttons that you can click to perform a 

particular operation. The main toolbar is always present near the top of the Web Agent 

component. The other toolbars depend on your current customer interaction. 

The toolbars are as follows: 

● The Main toolbar 

● Email toolbar in the Email Preview mode 

● Email toolbar in the Compose mode 

● HTML Formatting toolbar 

● Chat toolbars 

● Voice Chat toolbars 

● Resource toolbar 
 

  Tip: 

At any time if you do not remember what a button does, hold your cursor over the 

button for a moment. The Web Agent displays either the name or a description of 

the button. It also shows the keyboard shortcut that you can use to perform that 

command, such as Control+Alt+c to switch to Chat management. 
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The Main toolbar 

You can use the main toolbar in the Web Agent for both Email Management and Web 

Management. Using the buttons on the main toolbar, you can quickly access frequently used 

commands that are also available in the menus. The buttons on the main toolbar, from left to 

right, are as follows: 

 

Button Action 

 

 

Switch to Chat mode 

Switches the Web Agent to the Chat mode. If you select a chat 
contact in the Chat task list, the system displays a current chat 
session. If you are currently handling more than one chat session, 
you can switch from one session to another by changing the chat 
contact that is selected in the Chat task list. 

 

 

Switch to Chat & Phone 
mode 

Switches the Web Agent to the Chat & Phone mode. This switching 
makes it possible for you to speak with a customer over the 
telephone while the customer remains in the chat session with you. 

 

 

Chat & VoIP 

Switches the Web Agent to the Chat & VoIP Mode. This switching 
makes it possible for you to speak with your customer through a 
connection between your telephone and the Internet connection of 
the customer. While you speak with each other, you and the 
customer remain in the chat session together. 

 

 

Switch to Email mode 

Switches the Web Agent to the Email mode. If you select an email 
contact in the Email task list, the current email is displayed. The 
email might be displayed in Email Preview mode or Compose 
mode, depending on your latest view of this email. If you are 
currently handling more than one email, you can switch from one 
email to another by changing the email contact that you select in 
the Email task list. 

 

 

Switch to Supervisor 
mode 

This button is for the Supervisors only. If you are not a supervisor, 
the button is deactivated. In this mode, a panel displays icons for 
the chat sessions that agents in your workgroup are currently 
conducting. 

 

 

Launch Agent Home 
page 

Opens your Internet browser and displays a page where you can 
search for documents to the frequently asked questions (FAQs) on 
the Web Self-Service pages or submit your own documents to 
these pages. Submitted documents are reviewed by an 
administrator and may be accepted or rejected. 

 
Email toolbar in the Email Preview mode 

The email toolbar has a different set of buttons, depending on whether you are looking at the 
customer email in email Preview mode or composing an email reply in Compose mode. 
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When you click an email contact in your Email task list, the Web Agent displays the email of the 

customer in Email Preview mode, as indicated by the tab above the email. This is a read-only 

view of the email. The buttons in the Email toolbar, from left to right, are as follows: 

 

Button Action 

 

 

Print 

Prints the currently displayed email to the default printer. 

 

 

Reply to 
customer 

Displays the Compose mode of the Web Agent window. The default 
window in Compose mode is a Normal Reply, which addresses your reply 
to the sender of the email, and no one else. You can change this to Send 
to External Agent or Request Additional Info to compose those special 
types of email. 

 

 

Reply to All 

Displays the Compose mode of the Web Agent window and addresses 
your reply to the sender of the email and to all the people listed in the Cc 
(Copy) field of the message you are replying to. 

 

 

Forward a copy 

Forwards a copy of this email to the people whose addresses you enter in 
the To, Cc, and Bcc fields. For more information, see Forwarding an 
email on page 101. 

 

 

Resolve with a 
specified status 

Helps you apply a status to the email. For example, you may use a status 
of Dismiss if a customer sends you a thank you and all the questions of 
the customer have been answered. For more information, see Resolving 
an email on page 109. 

 

 

View email 
history 

Displays a dialog box with information about the current email and any 
previous emails sent from the email address of the current customer. You 
can also see copies of the emails. For more information, see Viewing 
email history on page 80. 

 

 

Forward original 
email 

Forwards the original email to the specified email address. You cannot 
modify the contents while forwarding an email using this option. 
Interaction Center does not track the email forwarded using this option. 

For more information, see Forwarding an original email on page 103. 

 

 

Transfer current 
contact 

Displays the Unified Agent Directory (UAD) so you can transfer this email 
contact. You can transfer it to a queue and let Avaya IC route the email to 
the first available agent in that queue. You may also be able to transfer it 
to a particular agent, supervisor, or an external agent. 

For information, see Transferring an email contact on page 98. 
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Button Action 

 

 

Defer current 
contact 

Puts the current email message on hold, giving you a chance to research 
the customer’s question or problem. Any reply that you have composed is 
saved automatically as a draft. You can receive another email contact to 
replace a deferred email. 

For more information, see Deferring an email on page 99. 

 

 

Wrap 

Puts you in WrapUp state. While in WrapUp state, you cannot receive 
another email contact to replace this contact. You might need to fill the 
information about this email contact while you are in WrapUp state. For 
more information, see Wrapping up an email contact on page 116. 

 

 

Complete current 
contact 

Completes the wrapped contacts and removes them from the Email task 
list. 

 

Email toolbar in the Compose mode 

When you are viewing an incoming email in the Email Preview mode and you click Reply or 

Reply to All, the Web Agent displays the email in Compose mode, as indicated by the tab 

above the email. This is where you compose your reply to the customer. 

Above the tab is the Compose toolbar. The buttons in this toolbar, from left to right, are as 

follows: 

 

Button Action 

 

 

Print 

Prints the currently displayed email to the default printer. 

 

 

Cancel email 
composition 

Displays a dialog box that asks if you want to save a draft of the reply you 
are composing. If you click No, your reply is deleted, and you must 
compose a new reply for this email contact. 

 

 

Add Attachments 

Displays a dialog box where you can locate a file and attach it to the 
current email reply. 

 

 

Perform a 
spellcheck 

Displays a dialog box that helps you check the spelling of the current 
email reply, interactively. 

Note: You can set a preference to have this spelling dialog box appear 
automatically after you click Send. See Setting Preferences on page 163. 
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Button Action 

 

 

Email History 

Displays a dialog box with information about the current email and any 
previous emails sent from the current email address of the customer. You 
can also see copies of the emails. See Viewing email history on page 80 
for more information. 

 

 

Save Draft 

Saves a draft of the current email reply that you are composing. You can 
return to the email by clicking its Compose tab. The email contact 
remains in your email task list. 

This icon is displayed only when you are forwarding an email or replying 
to an email. 

 

HTML Formatting toolbar 

If you select the HTML type when you compose a new email, you can view the following buttons 
on the HTML Formatting toolbar. For more information about formatting an email, see 

Formatting HTML text on page 86. 

 

Button Action 

 

 

Font 

Lists the fonts installed on the system. 

 

 

Font Size 

Lists the fonts size. 

 

 

Bold 

Applies the bold format to the selected text in an 
email. 

 

 
 

Italics 

Applies the italics format to the selected text in an 
email. 

 

 
 

Underline 

Applies the underline to the selected text in an 
email. 

 

 

Align Left 

Aligns a paragraph to the left side of the page. 
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Button 
Action 

 

 
 
Center 

Aligns a paragraph to the center of the page. 

 

 
Align Right 

Aligns a paragraph to the right side of the page. 

 

 
 
Bullets 

Applies a character bullet to a paragraph. 

 

 
Numbering 

Applies a numbering bullet to a paragraph. 

 

 
Text Highlighting 

Highlights the text with the selected color. 

 

 
 
Font Color 

Applies a color to the selected text in an email. 

 

 
Insert Image 

Inserts an image in an email. 

 

 
 
Insert Hyperlink 

Inserts a hyperlink in an email. 

 
 Remove hyperlink 

 Removes hyperlink from an email. 
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Button Action 

 

 
 

Center 

Aligns a paragraph to the center of the page. 

 

 

Align Right 

Aligns a paragraph to the right side of the page. 

 

 
 

Bullets 

Applies a character bullet to a paragraph. 

 

 

Numbering 

Applies a numbering bullet to a paragraph. 

 

 

Text Highlighting 

Highlights the text with the selected color. 

 

 
 

Font Color 

Applies a color to the selected text in an email. 

 

 

Insert Image 

Inserts an image in an email. 

 

 
 

Insert Hyperlink 

Inserts a hyperlink in an email. 
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Chat toolbars 

When you are in a chat session, the main chat toolbar is located on the right side of the Web 

Agent above the chat transcript area. This toolbar contains buttons you use to control the chat 

session. The buttons in the toolbar, from left to right, are as follows: 

 

Button Action 

 

 

Print 

Prints the currently displayed chat messages to the default printer. 

 

 

Start an Auto 
Sync Session 

You see this button when Auto Sync is off. Starts an Auto Sync session so 
that the browser of the customer displays the same webpages as your 
browser as you navigate through the webpages. See Using Auto Sync on 
page 127 for more information. 

 

 

You see this button when Auto Sync is on. Stops an Auto Sync session. 

Stop an Auto 
Sync Session 

 

 

 

JoinUs 

Starts a JoinUs session in which friends of your customer can join the chat 
session. See Handling a JoinUs Conference on page 147 for more 
information. 

 

 

Spell Check 

Displays a dialog box that helps you check the spelling of text that you have 
typed in the Text Entry area before you send it. 

Note: You can set a preference to have this spelling dialog box appear 
automatically after you click Say. 

 

 

Blind Transfer 

Transfers a chat to the queue. When you click this button, you are 
automatically dropped from the chat conference room without waiting for the 
other agent to receive the chat contact from the queue. For more information, 
see Performing a Blind Chat transfer on page 143 

 

 

Transfer 

Displays the Unified Agent Directory (UAD) so you can transfer this chat to 
another agent or to a queue. For information, see Involving other agents in a 
chat contact on page 139. 

 

 

Conference 
current 
contact 

Displays the Unified Agent Directory (UAD) so you can invite one or more 
agents to join this chat. For information, see Involving other agents in a chat 
contact on page 139. 
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Button Action 

 

 

Cancel 
Transfer/ 
Conference 

This button is only active after you initiate a transfer or a conference of a chat 
contact and before the second agent accepts the chat contact. Cancels the 
transfer or conference of a chat and returns it to your desktop. For 
information, see Cancelling the Transfer or Conference of a Chat Contact on 
page 144. 

 

 

Wrap 

Puts you in WrapUp state. While in WrapUp state, you cannot receive another 
chat contact to replace this contact. You may be asked to fill out information 
about this chat contact while you are in WrapUp state. For more information, 
see Wrapping Up a Chat Contact on page 155. 

 

 

Complete 
Current 
Contact 

Completes the wrapped contacts and remove them from the chat task list. 

 

 

Pop out 

pops out the chat task to another window. You can customize the size or 
minimize and maximize the popped out window. For more information, see 
 Popping out your chat task to a separate window on page 121. 

 

 

Pop In 

Pops the chat task back in to the tabbed pane. For more information, see 
 Popping out your chat task to a separate window on page 121. 

 

Voice Chat toolbars 

When you are in a chat session, you can handle two types of Voice Chat: 

● Chat & Phone – You and your customer speak to each other over the telephone. 

● Chat & VoIP – You speak to your customer over your telephone while your customer 
speaks to you over the Internet. 

Customers can request a Chat & Phone (Chat and Callback) session or a Chat & VoIP session 

on the company website. In such a case, the Web Agent will display the Chat & Phone toolbar 

or the Chat & VoIP toolbar, according to the request of your customer. 

If the customer does not request one of these two Voice Chat options on the website, but it will 

be helpful, you can initiate a Chat & Phone session by clicking the Chat and Callback button. 

Only the customer can initiate a Chat & VoIP session. 
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Resource toolbar 

Resources in the Web Agent are previously prepared text, emails, and URLs that you can send 

to customers when customers require information. This saves you the time that it would take to 

type the same information repeatedly. The Resources toolbar is above the Resource area on 

the left side of the Web Agent. The buttons in this toolbar, from left to right, are as follows: 

 

Button Action 

 

 

Save 

Saves the resources that you have created or modified. 

 

 

Collapse All 

Hides all resource folders under the single folder that contains them. 

 

 

Expand All 

Shows all resource folders and all their contents subfolders and the resources 
themselves. 

 

 

View 

When you select a resource and then click this button, the View Resource 
dialog box opens to display the contents of the resource. You cannot modify the 
resource. 

 

 

Edit 

When you select a resource and then click this button, the Edit Resource 
dialog box opens and lets you modify the contents of the resource if you want. 

 

 

Delete 

When you select a resource and then click this button, the resource is deleted. 
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Chapter 3: Managing Avaya Agent 

 

This chapter provides instructions for tasks that you perform in Avaya Agent. These tasks apply 

to the Voice, Email, and Chat media channels. 

This section includes the following topics: 

● Logging in and logging out on page 36 

● Accessing Avaya Agent on Citrix on page 40 

● Setting Your Availability on page 43 

● Viewing customer and contact information on page 48 

● Reloading layouts in the EDU viewer on page 52 

● Using the Unified Agent directory on page 53 

● Using Screen pops on page 60 

● Wrapping up contacts on page 61 

Note: 
Depending on your configurations, some of the Avaya Agent components 

discussed in this chapter might not be available to you. 
 
 
 
 

Logging in and logging out 

You must log in to Avaya Agent for every work session and log out to end the session. Use the 

password provided by your supervisor to log in to Avaya Agent for the first time. You might need 

to reset the password to a new password within a certain time interval, such as every 30 days. 

 
Important: 

If you do not log out at the end of a work session, problems might occur. For 
example, you may not be able to defer email contacts. 

 
SECURITY ALERT: 

Read the section System Security on page 38 for rules about creating and using 

passwords. 

Your Avaya Agent may use free seating. With free seating, your personal settings and 

preferences are attached to your login ID and password. Therefore, you can log in to different 

workstations at your contact center, and Avaya Agent will open with your personal settings and 

preferences. 

! 
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CAUTION: 

With free seating, you should only log in to one workstation at a time. If you want 

to change from one workstation to another, ensure to log out from the first 

workstation before you log in to the second one. 

When you log in to Avaya Agent, you automatically log in to Web Agent, and to the media 

channels such as Voice, Email, and Web Chat. 
 

 

Logging in to Avaya Agent 

If your contact center hosts Avaya Agent on Citrix, instead of your workstation, you must access 

Avaya Agent on Citrix before you can log in. For more information, see Accessing Avaya Agent 

on Citrix on page 40. 

To log in to Avaya Agent: 

1. Double-click the Avaya Agent icon on your desktop. 

If your desktop does not have an Avaya Agent icon, select the Avaya Agent shortcut from 

the Windows Start menu. For example, select Start > Programs > Avaya Interaction 

Center 7.3.x > Interaction Center. 

2. In the Avaya Agent Login tab, enter your login ID and password in the appropriate text 

box. 

Note: 
Type your password carefully. If you enter the incorrect password for multiple 

times, the system might be locked. The administrator configures the number of 

attempts allowed to an agent for entering an incorrect password. To unlock the 

system, contact the system administrator. 

 
SECURITY ALERT: 

For understanding the rules about creating and using passwords, see System 

Security on page 38. 

  Tip: 

The IC Data Source field has been set for you. Ignore this field unless system 

administrators indicate that you should change it. 

You might need to change your password. 

Avaya Agent automatically adds your login ID and password to the appropriate text boxes 

in the other tabs to log you in to the other channels. 
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3. If your system includes Softphone, enter the information for the fields available on the 

Softphone tab. These fields include the following: 

 

Field Name Field Description 

Agent ID Logs you on to the telephone switch and makes sure that all voice 
contacts assigned to your Agent ID are sent to your telephone. 

Agent Password Confirms your identity to the Automatic Call Distributor (ACD) telephone 
system. 

Station ID Identifies the station or equipment number of your telephone. 

4. Click OK. 

The status messages display the progress of your login. If your login ID and password are 
valid, Avaya Agent is displayed on your desktop. 

5. Check your Avaya Agent Status Control Bar, located at the top right of your screen, to 

confirm that you do not have all zeros for your channel loads. Your channel loads are the 

number of contacts in a media channel (Voice, Email, or Chat) that you can handle at a 

time. 

Note: 
If your channel loads across all available channels are set to zero, contact your 

system administrator to make sure that the servers are running. If the servers are 

running, reset your channel loads (see Setting your channel loads on page 46). 
 

 

System Security 

You have an important responsibility to keep your system secure. Observe the following rules to 

ensure the security of the system: 

● When you are required to change your password, choose one that is easy for you to 

remember but would be impossible for anyone to guess. 

● You may need to follow certain rules about the length of the password and the number and 

type of characters it contains. 

● Ask your administrator if you need help for creating your password. 

● Never write down your password. 

● Never share your password with anyone. 

● Contact your administrator immediately if you suspect any security problems, such as a 

computer virus, unusually slow response times, or other abnormal behavior of the system. 
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Logging in and out of media channels 

When you log in to Avaya Agent, you log in to all the media channels (Voice, email, or Chat) for 

which you are enabled. However, you can also log in and out of individual media channels if you 

want to limit your contacts to one or two channels at a particular time. For example, you may 

want to log in to the voice channel and log out of email and chat channels. Then you will receive 

new voice contacts only. 

To log in or out of a media channel: 

1. Right-click in the blank area of Avaya Agent to display the pop-up menu. 

Note: 
If you are logged in to a channel, the menu option for that channel displays 

Logout. If you are logged out of the channel, the menu option displays Login. 

2. From the pop-up menu, click one of the following: 

● Web Agent - Login (or Logout) – Lets you log in to (or log out of) the Web Agent so 

that you can respond to chat and email contacts. 

● Softphone - Login (or Logout) – Lets you log in to (or log out of) the voice (telephony) 
channel so that you can respond to voice contacts. 

Note: 
Only log out of a media channel, if instructed to do so by your administrator. 

3. In the Avaya Agent Login dialog box, enter your login ID, password, and any other 

information required for the media channel. 

4. Click OK. 
 

 

Logging out of Avaya Agent 

When you log out of Avaya Agent, you automatically log out of all your Avaya applications also. 
You may need to enter the reason that you are logging out of Avaya Agent. 

If your contact center hosts Avaya Agent on Citrix, instead of your workstation, you must log out 

through the Avaya IC tools for Citrix. For more information, see Accessing Avaya Agent on 

Citrix on page 40. 

To log out of Avaya Agent 

1. Change your agent state to AuxWork. 

If you log out in an Available state, Avaya Agent may automatically place you in an 

Available state and deliver contacts to you when you log back in. For information on how to 

change your agent state, see Changing your agent state on page 43. 

2. Click the Avaya Agent button at the top of the Avaya Agent. 
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3. Select Exit from the Avaya Agent menu. 

If you did not change your state to AuxWork, Avaya Agent displays a message advising 
you to change your agent state. 

4. If the Logout dialog box appears, select a reason and click OK. 
 
 
 
 

Accessing Avaya Agent on Citrix 

If your contact center uses Citrix, Avaya Agent is on a Citrix server not on your workstation. You 

use an Avaya IC tool to access Avaya Agent on the Citrix server. After you access the server, 

you can work with Avaya Agent normally. 

Avaya provides two tools that you can use to access Avaya Agent on the Citrix server. The Web 

browser tool opens in Internet Explorer. The Executable tool opens as a dialog box. 

The Avaya IC tools for Citrix: 

● Connect you to Avaya Agent and the other agent applications that you need on the correct 

Citrix server. 

● Ensure that Avaya Agent sizes properly in the Citrix client interface. 

● Ensure that you can properly exit from the Citrix server and the Citrix interface. 

● You re-connect to the Citrix server if you encounter a problem. 

This section includes the following topics: 

● Using the Web browser tool on page 41 

● Using the Executable tool on page 42 

 
Important: 

The Avaya IC tools for Citrix that you see on your desktop may look different from 

the illustrations. The text for the links on the Web browser tool and the text on the 

buttons in the Executable tool may have been customized for your contact center. 

Contact your supervisor or system administrator if you need understanding the 

tools that you see on your desktop. 

! 
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Using the Web browser tool 

The Web browser tool displays as a webpage in Internet Explorer that you use to access Avaya 

Agent on Citrix. After you use the Web browser tool, Internet Explorer displays Avaya Agent and 

other agent desktop applications published on the Citrix server. 

This section includes the following topics: 

● About the Web browser tool on page 41. 

● Accessing Avaya Agent with the Web browser tool on page 41. 

 
About the Web browser tool 

The following table describes the function of each link in the Web browser tool. 

 

Item Default link text Description 

1 Start IC Agent in CITRIX Application mode Click this link to access Avaya Agent or 
another Avaya IC agent desktop 
application on Citrix server. 

2 EXIT Click this link to exit from the Web 
browser tool and the Citrix interface. 

3 Force Reset Click this link to force a reset of 
application after failure. 

 

Accessing Avaya Agent with the Web browser tool 
 

Important: 

You must use the following steps in the correct sequence when you use the Web 
browser tool to access Avaya Agent and other agent desktop applications in the 

Citrix interface. If you do not follow this sequence, you may have problems with 

the Citrix interface. 

For information about how to log in and log out of Avaya Agent, see Logging in and logging 

out on page 36. 

To access Avaya Agent with the Web browser tool: 

1. In Internet Explorer, open the Web browser access page for the agent desktop 

applications. 

The link for the access page should be in your Favorites folder. If you cannot locate the 

link, contact your Supervisor. 

! 
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2. Click the Start link. 

Avaya Agent on the Citrix server starts. 

3. Log in to the agent desktop application through Citrix. 

4. Handle contacts with customers and perform required tasks in Avaya Agent. 

5. Log out from Avaya Agent in Citrix. 

6. Click the Exit link to exit the Web browser tool. 
 

 

Using the Executable tool 

The Executable tool opens as a dialog box on your workstation. After you use the Executable 
tool, the Citrix client interface opens a window that displays Avaya Agent and other Avaya IC 

agent desktop applications published on the Citrix server. 

This section includes the following topics: 

● About the Executable tool on page 42. 

● Accessing Avaya Agent with the Executable tool on page 42. 

 
About the Executable tool 

The following table describes the function of each button in the dialog box. 

 

Item Default link text Description 

1 Set Desktop For IC Agent Select this button to access Avaya Agent or 
another Avaya IC agent desktop application on 
Citrix server. 

2 Reset Desktop to Original Size Select this button to exit from the Executable tool 
and the Citrix interface. 

3 Force Reset Select this button to force a reset of application 
after failure. 

 

Accessing Avaya Agent with the Executable tool 
 

Important: 

You must use the following steps in the correct sequence when you use the 

executable tool to access Avaya Agent and other agent desktop applications in 

the Citrix interface. If you do not follow this sequence, you may have problems 

with the Citrix interface. 

! 
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For information about how to log in and log out of Avaya Agent, see Logging in and logging 

out on page 36. 

To access Avaya Agent with the Executable tool: 

1. On your desktop, double-click the shortcut icon for access to the Executable tool and 

Avaya Agent. 

If you do not have a shortcut on your desktop, contact your Supervisor. 

2. Select the Set Desktop For IC Agent button. 

Avaya Agent on the Citrix server starts. 

3. Log in to the agent desktop application through Citrix. 

4. Handle contacts with customers and perform required tasks in Avaya Agent. 

5. Log out from Avaya Agent in Citrix. 

6. Select the Reset Desktop to Original Size button to exit the Executable tool. 
 
 
 
 

Setting Your Availability 

At any point in time, you are either available or unavailable to handle contacts in the media 

channels. If you are available, contacts are assigned to you by the system. 

You can set two basic types of availability: 

● Your channel loads: The maximum number of contacts you can handle in a media channel 

at any one time. For example, if you have a channel load of 3 emails, you could have a 

maximum of three emails assigned to you at one time. 

● Your agent state: Whether you are available at a particular moment to handle contacts. 

Agent states are Available, Aux-work (Busy), and Init. Aux-work (Transition between 

Available and Aux-work). Your agent state may apply to all media channels or to a single 

media channel. 

You can view or control your channel loads and your agent state through the Avaya Agent 

Media pane. 
 

 

Changing your agent state 

You can make yourself available or unavailable to receive voice, email, or chat contacts or to 

make outbound calls. Your current state of availability to handle contacts is called your agent 

state. 
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The Agent button in the Status Control bar indicates your current agent state. If you are in 

automatic mode, when you click the Agent button, you set your agent state for all channels 

simultaneously. See Changing state across all media channels on page 45 for more 

information. 

 
Important: 

When using a physical phone set in conjunction with Softphone, you should avoid 
changing states using the physical phone set. For example, if Softphone is preset 

to enter the Ready state after a call ends, and you set your physical phone set to 

enter the WrapUp state after a call ends, Softphone and your physical phone set 

may be out of sync when you end a call. To prevent this condition, try to use 

Softphone to change states. 

If your administrator has given you permission to enter manual mode, you can also change your 

agent state for single channels individually. This would allow you to click media channel buttons 

to make yourself Available for one channel (Voice, for example), while you are in Aux-work 

(Busy) for other channels (email and Web Chat, for example). See Changing state in a single 

media channel on page 45 for more information. 

The three agent states are shown in the following table: 

 

Agent State Agent Button Description 

Available 
 

 

You are available to accept new contacts. In manual 
mode, some media channels may be unavailable, as 
shown by an X on the buttons. 

Aux-work (Busy) 
 

 

You are busy and are unavailable to accept contacts. In 
automatic mode, you are unavailable in all media 
channels so the Agent button and all media channels 
have an X. In manual mode, the Agent button and any 
unavailable media channels have an X. 

Click to enter Aux-work when you go to lunch, research a 
customer’s problem, or do any activity where you cannot 
handle a contact. Wrapping up a contact is not 
considered Aux-work. 

Init. aux-work 
(Transition) 

 

 

You are in a transition state between Available and 
Aux-work. For example, you have attempted to log out 
with one or more contacts that need to be wrapped up. In 
both automatic and manual modes, the Agent button 
has a grey X when you are in this state. 

At your contact center, you may need to enter the reason 
for entering Aux-work and wrap up all active contacts on 
your desktop. 

If you are using a Communication Manager (CM) telephone switch and the Auto-In or Manual-In 

work modes, you can also change your agent state by pressing buttons on your physical 

telephone. For information, see Using Softphone with Communication Manager (CM) 

switches on page 66. 

! 
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For information about entering or changing the reason you are in Aux-work state, see Entering 

reason for your unavailability on page 47. 

 
Changing state across all media channels 

Your mode of operation determines how much control you have over your agent state. 

Depending on how Avaya Agent is configured, you may work in either of the following modes of 

operation: 

● Manual mode 

● Automatic mode 

In automatic mode, the Agent button is the only one you can click. Click the Agent button until 
it changes to the desired agent state. The other media channels change to the same state. 

 
Changing state in a single media channel 

If you are in manual mode, you can change your agent state for a single media channel. For 

example, you can make yourself available for voice while you are unavailable (in Aux-work) for 

chat. 

 

To change your agent state for one media channel (manual mode only): 

● Click the media channel button on the Status Control bar until the button changes to the 

desired agent state: 

- Available – The button does not have a yellow X. 

- Aux-work (Busy) – The button has a yellow X. 

- Init. aux-work (Transition) – The button has a grey X as your state changes between 

Available and Aux-work. 

OR 

● Right-click the media channel button in the Status Control bar. Then click the pop-up menu 

option to change your agent state for that media channel. 

The pop-up menu options change according to your agent state for each media channel. 
 

 

Setting Manual mode 

If your administrator has given you permission to use manual mode, you can set your agent 

state and channel loads manually. This means that you can reduce your channel loads if you 

want. In manual mode, you can also change each of the Voice, email, and Web Chat channels 

individually from Available to Busy, and from Busy to Available. In other words, you can be Busy 

in one channel while Available in other channels. 
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When you are in manual mode, the Status Control bar contains channel buttons that you can 

click. 

In the Manual mode, you can do the following things: 

● Set your agent state across all media channels 

● Set your agent state for only one media channel 

● Set your channel load 

To enter the Manual mode: 

1. Right-click in the Avaya Agent Status Control bar. 

2. Click Options in the menu to open the Channel load dialog box. 

3. In the Channel load dialog box, select the Manual Mode check box. 

4. Click Apply. 

Note: 
If you cannot access the Manual Mode check box, your administrator has set 

your channel loads. Contact your administrator for further assistance. 
 

 

Automatic mode 

In automatic mode, when you click the Agent button, you can only change your agent state 

across all media channels at the same time. You cannot change your agent state for a single 

channel. Therefore, you are always in the same agent state in all media channels. 

When you are in automatic mode, the Status Control bar on the Media tab has only button—the 

Agent button. You cannot select the Voice, email, and Web channels icons. 
 

 

Setting your channel loads 

For each type of contact that you handle, you have a channel load, which is the number of 

contacts in that media channel that you are enabled to handle at one time. You may be able to 

adjust your channel loads, but they can never be higher than channel ceilings that your 

administrator set for you. (The channel ceiling is the absolute maximum number that you can 

ever handle at one time.) 

For example, if your administrator has set up your account so that the channel ceiling for chat 
contacts is three, you can set your chat channel load to three, two, one, or even zero. But with a 

ceiling of three, you can never change your channel load to four chat contacts. 

To be able to adjust your channel loads, your user account must be set up for permission to 

work in manual mode. If you can select the Manual Mode check box in the Channel load 

dialog box, that means that you have permission to adjust your channel load. 

mailto:infodev@avaya.com


Chapter 3: Managing Avaya Agent 

47 Agent User Guide July 2021 

Comments on this document? infodev@avaya.com 

 

 

 

 
To set your channel loads: 

1. Right-click a media channel button in the Avaya Agent Status Control bar. 

2. Click Options from the pop-up menu. 

The Channel load dialog box is displayed. 

3. Select the Manual Mode check box if it is not already selected. 

Note: 
If you cannot select the Manual Mode check box, you cannot adjust your channel 

load. Contact your administrator for further assistance. 

4. Enter the maximum number of contacts you want to be able to handle in the text box next 

to the appropriate channels. Click the up arrow to increase the number or the down arrow 

to decrease the number. 

If the number stops changing when you click the arrow, you have reached the ceiling that 

your administrator set for you. For example, you may not be able to set more than 1 or 2 

chats. 

If any field is disabled, you are not set up to handle sessions in that channel. 

5. Click Apply. 

The Avaya Agent Status Control bar shows the channel loads that you entered, which is 

the maximum number of contacts that you can handle for each channel. 

Note: 
The Web Agent Status Control bar shows your current loads for chat and email, 

as set by the program rules. These are called contact loads. The routing servers 

can reduce this number at any time according to program rules that consider the 

number and type of contacts you are handling, the number of contacts currently in 

the system, and so on. Therefore, the numbers can change while you are in your 

current login session. Your current contact loads as shown in the Web Agent may 

be less than the channel loads shown in the Avaya Agent. 
 

 

Entering reason for your unavailability 

Your contact center may use a feature that lets you enter a reason that you are unavailable (in 

Aux-work). If your contact center uses this feature, you can enter a reason or change the 

reason that you are unavailable. You will remain in Aux-work state even if you change the 

reason. 

For example, you may be unavailable because you are in a training session. You select 

InTraining as the reason, which indicates that you are unavailable. When you return from your 

training session, you may go on your break. You change the reason that you are unavailable to 

OnBreak. 
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To enter or change the reason you are unavailable: 

1. While you are in Aux-work, right-click in the Status Control bar. 

2. Select Change Aux Reason from the pop-up menu. 

3. In the Select reason code dialog box, select the reason that you are not available. 

4. Click OK. 
 
 
 
 

Viewing customer and contact information 

When a contact arrives in the Avaya Interaction Center (Avaya IC) contact center, an electronic 
data unit (EDU) is created for that contact. The application then forwards the contact to an 

available agent, using the rules that have been set up by your system administrator. 

The Avaya Agent on your desktop displays information about the currently active contacts that 

have been assigned to you. The task lists in the Media pane display the basic information about 

each contact. The Contact pane that is displayed near the bottom of the Avaya Agent contains 

two areas where you can immediately access more detailed information about a contact: 

● The EDU Viewer displays detailed information about any active contacts, including the 

creation date and time. 

● The Contact History Browser provides information about previous contacts with the same 

customer. 

The Contact pane also contains two buttons: 

● The Contact History Filter button 

● The Active Contact Viewer button becomes available only when another agent is 

currently handling an email contact with the same customer. The Active History Browser 

provides information about the other active email contact or contacts. 

To view the information in the Contact pane, click a contact in the task list to bring it into focus. 

Note: 
If the subject of the email contains characters such as },{ , “},{“ , "} }}, the EDU 

viewer will not display the subject of the email. The EDU viewer will display 

subject as unknown. 

For information about the Contact History Filter, see Filtering Contact History information on 

page 51. For information about the Active Contact Viewer, see Using the Active Contact 

Viewer on page 49. 
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Viewing active contact information 

You can use the EDU Viewer for most information about your active contacts. You may need to 
check the Active email Viewer to see all active email contacts. 

 
Using the EDU Viewer information 

When you select a contact in a task list, the EDU Viewer brings the tab containing information 

about the active contact to the front. 

 
Using the Active Contact Viewer 

Another agent may have deferred an email contact from a customer that you are handling by 

voice, email, or chat. The agent who has deferred the email plans to reply to the customer at a 

later time. The deferred email remains in the other agent’s email task list. Deferred emails are 

not displayed in the Contact History Browser because they have not been completed. 

You can see information about the deferred email contacts in the Active Contact Viewer. For 

each active email contact from that customer in another agent’s email task list, the Active 

Contact Viewer displays: 

● The date and time when the email contact was created 

● Whether there are any attachments 

● The contents of the To field 

● How many times the email contact has been forwarded 

● The sender’s email address 

● The subject line 

If the customer has several active email contacts in the system, information about each contact 

is displayed in a separate tab. 

To view information about a deferred email contact: 

1. Double-click the new email contact to open it in your desktop and view information about 

that contact in the EDU Viewer. 

2. Click the Active Contact Viewer button, which is located between the two boxes in the 

Contact pane. 

Note: 
If the button is disabled, there is no other active email contact from the customer 

in the contact center. 

If any deferred email contacts from this customer exist, the Active Contact Viewer dialog 

box opens and displays information about them. 
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Viewing Contact History information 

The Contact History browser contains information about completed contacts that your current 

customer has had with the contact center. Contacts that have not yet been wrapped up are not 

listed. 

The Contact History Browser contains a tab for each of your current contacts. Each tab contains 

the history of that contact, that is, the previous contacts the customer has had with the contact 

center. Avaya Agent automatically brings the tab for the active contact to the front of the Contact 

History Browser. To view information about another contact, click the appropriate tab. 

Note: 
Current information about an active customer contact does not appear in the 

Contact History Browser until you have wrapped up that contact. 

In addition to the information that is visible in the Contact History Browser, you can double- click 

to see more details about previous email and chat contacts. The additional information available 

in the Contact History Browser is as follows: 

● Voice contact: No additional information. 

● Email contact: When you double-click, displays the Email History dialog box, which 
contains two tabs: 

- Tracking History tab, which provides a more detailed description of each contact 

- Customer History tab, which provides a detailed customer history and copies of 
emails this customer sent to the company in the recent past 

● Chat contact – When you double-click, displays your Internet browser and displays a 

transcript of the previous chat session. 
 

 

Clearing current contacts 

You can clear the Contact History Browser of all the information that is currently displayed. 

To clear contacts from the Contact History Browser 

1. Right-click in an empty part of the Avaya Agent. 

2. Click Contact History Browser - Reset from the pop-up menu. 

3. Click OK. 
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Filtering Contact History information 

If the current customer has a large number of contacts in the Contact History Browser, you can 

use the Contact History Filter to filter records before they are displayed. For example, if you 

click Email in the Media Type filter and enter May 1, 2003 and May 31, 2003 in the Time filter, 

the Contact History Browser displays only email contacts received from a customer in the month 

of May. 

You can filter and display records by: 

● Media type 

● Date and time the contacts were received 

● Last x contacts made by a customer (for example, the last five contacts). 

To filter contacts in the Contact History browser: 

1. Click the Contact History Filter button. This is the top button between the two boxes of 

the Contact pane. 

The Contact History Filter dialog box is displayed. 

2. Select the Enable Filter check box for the desired filter or filters. 

3. Complete the required fields for the selected filter or filters, as follows: 

● Media Type Filter – Select email, chat, or voice from the Media Name list. 

If you want to view contacts of all media types, do not click this filter. 

● Time Filter – Click a start date and an end date. 

● Last N Contacts Filter – Enter a numerical value for the last number of contacts you 

want to view (for example, enter 10 to view the customer’s last ten contacts). 

4. Click Set. 

 
Clearing Contact History filters 

To clear all contact history filters 

1. Click the Contact History Filter button. 

2. In the Contact History Filter dialog box, click Reset. 
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Reloading layouts in the EDU viewer 

The EDU viewer displays details of the current contacts in your task lists. 

If your administrator instructs you to clear all current contacts from the EDU Viewer or to reload 

updated layouts, you use options in a pop-up menu to do these tasks, as described in the 

following subsections 

● Clearing current contacts in the EDU viewer 

● Reloading EDU viewer layouts 
 

 

Clearing current contacts in the EDU viewer 

You use the EDUViewer - Reset command to clear all tabs of the EDU Viewer. 

Note: 
Only use the EDUViewer - Reset command if your administrator instructs you to 

do so. 

To clear your current contacts 

1. Right-click in an empty part of the Avaya Agent. 

2. Click EDUViewer - Reset from the menu. 

3. Click OK. 
 

 

Reloading EDU viewer layouts 

You use the EDUViewer - Reload Layouts command to reload the EDU Viewer formats onto 
your desktop after your administrator has changed them. 

Note: 
Only use this command if your administrator instructs you to do so. 

To reload the EDU viewer formats: 

1. Right-click an empty part of the Avaya Agent. 

2. Click EDU Viewer - Reload Layouts from the menu. 

The revised templates are loaded onto your system. 

3. Click OK. 
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Using the Unified Agent directory 

The Unified Agent Directory (UAD) is a directory full of information about resources in your 

contact center. Depending on the set-up at your company, the UAD may have the following 

tabs: 

● Queues tab: The UAD always has a Queues tab. When this tab is selected, the UAD 

displays queues that contains contacts waiting to be assigned to agents. The queues are 

used to route contacts to agents. For example, there may be email queues for Hardware 

Sales, Software Sales, Hardware Support, and Software Support, each containing agents 

who handle emails about a particular type of customer. Similarly, there may be voice 

queues or chat queues who handle particular types of customer. 

● Agents tab: The UAD on your desktop may or may not have an Agents tab. If the tab is 

present, it contains lists with many items of information about the Avaya IC users in your 

contact center. This may include information about the following types of agents: 

- Administrators 

- Supervisors 

- External agents, who are people, usually outside of your company, who possess 

special knowledge or skills 

- Agents with particular skills, such as speaking other languages or knowing a particular 
operating system 

Note: 
The Agents tab is the default tab that opens if available. 

● Tabs for individual workgroups: Your contact center may have set up workgroup tabs in the 
UAD. Each workgroup tab contains information only about agents in that workgroup. For 

each agent listed in the workgroup tab, only the agent’s login name, display name, and 

primary email address are displayed. 

You can use the UAD for the following purposes: 

● Looking for the queue and agent information on page 54 

● Involving other agents in a voice contact on page 70 

● Initiating a voice contact on page 72 

● Sending an email to an external agent on page 96 

● Transferring an email contact on page 98 

● Originating an outbound email on page 111 

● Involving other agents in a chat contact on page 139 
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Looking for the queue and agent information 

Whether or not you are currently handling contacts, you can use the UAD to look up information 

about resources at your company. You may be able to find contact information, such as email 

addresses and phone numbers, of other agents, supervisors, external agents, or agents with 

particular skills. 

This section explains how to look up information in the UAD, under the following topics: 

● Looking for the queues on the Queues tab on page 54 

● Looking for the agents on the Agents tab on page 54 

● Looking for the agents with the Find option on page 57 

● Filtering the data displayed in UAD on page 55 

● Updating UAD information on page 59 

 
Looking for the queues on the Queues tab 

The Avaya IC software routes incoming customer contacts to various queues. A queue contains 

contacts waiting to be assigned to agents. 

The Queues tab of the UAD lists the queues that administrators at your contact center have set 

up in the database and marked for inclusion in the UAD (marked as "addressable"). Queues 

include agents enabled to handle a single media type (Voice, email, or Chat) or the combination 

of Voice and Chat. 

You use the Queues tab when you want to transfer a voice contact or email contact to a queue. 

The transfer will be assigned to the first available agent in that queue. (Chat is the exception. 

You cannot transfer a chat contact to a queue.) For information, see Involving other agents in a 

voice contact on page 70 or Transferring an email contact on page 98. By default, the Queues 

tab displays only the queues that handle the same media channels that you are currently 

handling. 

To be sure that you have the latest information on queues, you should refresh the UAD before 

using the Queues tab. See Refreshing the entire UAD on page 60. 

 
Looking for the agents on the Agents tab 

If your UAD has an Agents tab, you can use it to look up information about people who work for 

the contact center. You may find the following types of information about each person who is 

listed in the Agents tab: 

● General agent information, such as last name, first name, login ID 

● Telephone numbers, such as primary, secondary, mobile, pager, and fax 

● Email addresses, such as internal and personal 
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If your UAD does not have an Agents tab or if you are looking for agents with particular skills, 

use the instructions in Looking for the agents with the Find option on page 57. 

To look the agent information: 

1. Right-click anywhere in the Avaya Agent Media pane. 

2. Select Show Directory from the pop-up menu. 

The Directory dialog box (the UAD) is displayed. 

3. Click the Agents tab (or any workgroup tab that you have containing agent information). 

The tenant and workgroups that you belong to, and the agents within these groups, are 
displayed in a tree structure. A house icon represents tenants and a folder icon represents 

a workgroup. 

Note: 
A tenant may be a company, such as XYZ Corp; a location, such as New York or 

Boston; or a workgroup, such as Sales or Support. 

A red icon of a person’s head represents an agent. The appearance of the icon indicates 

information about an agent: 

4. If the person you are looking for does not belong to this tenant or these workgroups, make 

an appropriate selection from the Site drop-down menu. If you are not certain which of 

these tenants and workgroups the person belongs to, select All Sites. 

5. Navigate through the tree structure. Click the plus button (+) beside any tenant or 

workgroup to display its contents. Use the scroll bars as necessary to see more 

information. 

6. When you find the name of a person you want information about, right-click the name and 

click Properties. 

The Properties dialog box is displayed for this person. 

7. Click the appropriate tab in the Properties dialog box to find the desired information about 

this person. 

  Tip: 

If you leave the UAD open for a while, the information may not be current. You 

can right-click a workgroup and select Update State to update the information in 

that workgroup. For more information, see Updating UAD information on page 59. 

 
Filtering the data displayed in UAD 

You can use the Filter dialog box to limit the information you see in the UAD. You can filter 

agents by the type of media agents handle, their agent type, and their current agent state. 

To filter the queue or agent information: 

1. Right-click anywhere in the Avaya Agent Media pane. 
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2. Select Show Directory from the pop-up menu. 

The Directory dialog box (the UAD) is displayed. 

3. Select View > Filter. 

The Filter dialog box is displayed. 

Note: 
If you do not see a Filter option in the UAD’s View menu, or if the Filter option is 

disabled, your contact center does not use this feature. 

4. In the Media Type section of the Filter dialog box, select or de-select the types of media 
handled by agents that you will search for. You can select one, two, or all three types. 

Following are results based on the filter criteria that you select: 

● If you select a single media channel, all the agents handling that selected media 

channel are listed. 

● If you select two media channels, all the agents handling both the selected media 
channels are listed. For example, if you select the Voice and Email options in the filter, 

the agents handling both voice and email media channels are listed. Agents handling 

only voice or only email channels are not listed. 

● If you do not select any media channels, all agents handling at least one media 
channel are listed. 

Note: 
If you select one or more media, then the filter/search results will show only those 

agents who are handling all these media types. 

5. In the Agent Type section, select one or two of the following: 

a. Software if you want to search only for non-human resources like IVR queues. 

b. External if you want to search only for people who have been designated as external 

agents. 

c. Supervisor if you want to search only for supervisors. 

Note: 
External agents are people, usually outside of your company, who have been 

designated as external agents because of special knowledge or skills they 

possess. 

6. In the Agent States section, select only one of the following agent states: 

a. Available includes only agents who are currently logged-in and available. 

b. Logged-In includes only agents who are logged-in (whether they are available or in 

Aux-work). 

c. Any includes all agents regardless of agent state (whether they are logged in and 

available, logged in and in Aux-work, or not logged in). 
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7. Click Apply. 

The tab is updated to display only the information you included in your selections. 

 
Looking for the agents with the Find option 

The Find option offers another method of looking up information about agents at your contact 

center. With this dialog box, you can search for agents in the following ways: 

● Media type (Voice, email, or Chat) 

● Agent type (External, Supervisor, or Software) 

● Current agent state (Available, Logged-In, or Any) 

● Skills (such as knowledge of a language or an operating system, and skills) 

● Personal information (First Name, Last Name, and so on) 

The Find option returns three pieces of information about each agent: login ID, display name, 

and media types that are enabled for the agent. 

You can save the results of each search as a tab to be added to the UAD. The tab displays the 

results list of the Find dialog box, including agents’ media types, login ID, display name, and 

email address. This can help you find an agent with a specific skill when you need one, such as 

an agent who is proficient in a specific language. For example, if you occasionally receive voice 

contacts from people who speak German, you could search for agents who speak German 

proficiently and who handle Voice. You would then save the results of your search as a tab 

which you can name "German." 

Note that you can search for agents by agent state, but agent state changes regularly. If you 

want to be sure agent state is accurate, you may want to perform a new search. 

To look the agent information with the Find option: 

1. Right-click anywhere in the Avaya Agent Media pane. 

2. Select Show Directory from the pop-up menu. 

The Directory dialog box (the UAD) is displayed. 

3. Select View > Find. 

The Specify Search Criteria dialog box is displayed. 

Note: 
If the Find option is disabled, your contact center does not use this feature. 

4. From the Site drop-down menu, select the location that you want to include in the search. 

5. Go to the appropriate step below for each tab you want to use for the search. Skip the 

steps about tabs you do not want to use. 
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  Tip: 

You can use any of the three tabs (Agents, Skills, or By Name) in the dialog box 

to select the criteria that will be used for the search. The tabs are cumulative. This 

means that when you click the Find Now button, the search will find only the 

agents that meet all the criteria you select in all the tabs. 

6. Agents tab: Select all the criteria that you want to include in the search, as follows: 

a. In the Media Type section, if you want to look for agents who are enabled to handle a 

single media channel, select that media type. You can select one, two, or all three 

types. If you do not select any media type, the search will include all media channels. 

b. In the Agent Type section, select one or two of the following: 

1. Software if you want to search only for non-human resources like IVR queues. 

2. External if you want to search only for people who have been designated as 

external agents. 

3. Supervisor if you want to search only for supervisors. 

c. In the Agent States section, select only one of the following: 

1. Available if you want to search only for agents who are currently available. 

2. Logged-In if you want to search only for agents who are currently logged in 

(including those who are Available and those in Aux-work). 

3. Any if you want to include all agents. 

7. Skills tab: If you want to search for agents with certain skills, such as agents who speak 

certain languages or agents who support a certain operating system, click the Skills tab 

and do the following: 

a. If necessary, navigate through the folders. 

b. When you find the skill you want, double-click to select it. 

The selected skill moves to the bottom of the dialog box. 

c. You can select a range (> for greater than; = for equal to, or < for less than) and a 

Proficiency rating (Expert, High, Low, or Medium) to indicate the level of proficiency 

by clicking in the appropriate columns. 

For example, if you wanted to find an agent who speaks French well (greater than a 
Medium level of proficiency), you might select a Range of > and a Proficiency of Medium. 

After selecting the range, you would click the Proficiency column and select the range. 

8. By name tab: If you want to find a specific person, click the By name tab and enter any 

information that you know about the person in the appropriate text box. 

Note: 
The information is case-sensitive. If a person’s name is Bob, your search will not 

find him if you type bob instead of Bob. 
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9. Click Find Now whenever you have entered all the desired search criteria. 

When the search is complete, the dialog box expands to display your search results. 

10. Look at the results of the search at the bottom of the dialog box. If you think that the results 

will be useful another time, create a tab with this data, as follows: 

a. In the text box at the right side of the dialog box, where Search #X is displayed, select 
the text and type over it to create a name for the new tab. 

b. Click Save Results. 

A tab is added to the main screen of the UAD displaying the information found in the 
previous search. 

11. If you did not get exactly the results you wanted, change any of your selections in the 

Specify Search Criteria dialog box as desired. Then click the Find Now button again. 

 
CAUTION: 

Use the New Search button only if you want to clear the previous search criteria 

and begin again. 

12. If you want to save the results in a tab added to the main UAD dialog box, you should first 

rename the results in the Search Results text box so you will know what is displayed in 

the tab. Then click the Save Results button. 

 
Deleting the Search Results tabs 

If you saved information you found in the Find option, new tabs were created in the UAD with 

the results. You can delete any tabs that were created this way. 

To remove Search Results tabs from the UAD: 

1. Click the tab that you want to delete. 

2. Select View > Delete Search Results. 

The system deletes the Search Results tab. 
 

 

Updating UAD information 

Information about queues and agents changes over time. For example, new queues or agents 

may be added or existing ones may be removed. 

To be sure that the information you see in the UAD is current, you can refresh the UAD before 

using it. 

You can either refresh the entire UAD or you can update agent states only. To be sure you get 
the latest information about queues, you must refresh the entire UAD. 

 

mailto:infodev@avaya.com


Using Screen pops 

July 2021 60 Agent User Guide 

Comments on this document? infodev@avaya.com 

 

 

 

 
If you want to be certain that the agent state information is current and your contact center does 

not update this information automatically, or if your UAD has been open for a while, you can 

update agent states only. If your contact center is large, it is faster to update agent states than to 

update the entire UAD. 

 

Refreshing the entire UAD 

The information about queues and agents may have changed since you logged in. To be sure 

that you have the latest information on both queues and agents, you can update all UAD data. It 

may take a while to refresh the entire UAD. 

To update all data displayed in the UAD 

● Select View > Refresh. 

The UAD brings in all the latest information. 

 
Updating Agent State only 

The information in the UAD about agents may not be current if your UAD has been open for a 

while or if your administrators have turned off automatic updates of agent state data. 

You can update the agent state of agents in a single workgroup. It is faster to update the agent 

state in one workgroup than to update the entire UAD. 

To update agent state data in members of a group: 

1. Right-click the name of a workgroup. 

2. Select Update State from the pop-up menu. 

The latest agent state information for members of this workgroup is displayed. 

3. Repeat with other workgroups, as desired. 
 
 
 
 

Using Screen pops 

If your contact center has set them up, you may see screen pops when new incoming contacts 

arrive in your task lists. If you click Yes in a screen pop, the new contact becomes active. If your 

contact center includes an agent desktop application that is integrated with Avaya Agent, 

information about that contact is automatically imported into that application. 

If you are already responding to a contact when the new contact arrives, and you click No in the 

screen pop, Avaya Agent does not display a second screen pop because the new screen pop 

may interrupt your current contact. You can manually display a screen pop for the second 

contact through the pop-up menu in the Avaya Agent Media pane. 
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Note: 
Depending on how your administrator configured your system, you may not see 

screen pops. 

To perform a manual screen pop for an incoming contact: 

1. Click the new contact to make it active. 

2. Right-click in any open area of the Avaya Agent. 

3. Click Screen Pop in the pop-up menu. 

Avaya Agent opens the integrated agent desktop application with customer information 

about the incoming contact. 
 
 
 
 

Wrapping up contacts 

After you complete an incoming voice, email, or chat contact call, your contact center may 

require you to wrap up the contact or call by entering information in a Wrap-up dialog box or a 

Prompter script. The information you enter is added to the contact information in the database 

to assist the next agent who handles a contact from that customer. Because each contact 

center handles wrap-up information differently, your system administrator determines the 

following: 

● Whether you are automatically placed in the WrapUp state after completing a contact 

● Whether you enter information in a dialog box or click buttons in a script to enter customer 

and contact information 

● Whether you must record wrap-up information for every contact 

Note: 
 
 

 

Using the Wrap-up dialog box 

Most contact centers document the reason and outcome of customer contacts through the 

Wrap-up dialog box. 

When you wrap up a voice, email, or chat contact, you may need to select information from one 

or more of the following areas of the Wrap-up dialog box: 

● Categories – You may see a category for each of the media channels in this drop-down 

menu. Of you may see another type of grouping of a set of reasons for the contact (for 

example, Balance Inquiry or Cancellation Request). 

● Reasons – Items that specify the purpose of a customer’s contact or the intent of the work 

you performed. 
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● Outcomes – This information specifies the action you took or the result of your activity. 

The Wrap-up Selection(s) area is for the items that you select from the Reasons and 
Outcomes areas, or whatever areas you have in your Wrap-up dialog box. 

The Wrap-up dialog box may also have a History button that displays the following information 

about previous contacts with this customer: 

● The login ID of the agent who entered the wrap-up information 

● The name of the agent who entered the wrap-up information 

● A description of the category, reason, or outcome selected by the agent who wrapped 
up the contact 

To wrap up a contact using the Wrap-up dialog box: 

1. Complete your voice conversation, chat session, or email with the customer, using the 

Hangup button for a voice contact, or the Wrap button for an email or a chat session. With 

an email, you may not need to use the Wrap button. 

The Wrap-up dialog box opens automatically. 

2. Select the appropriate item from the Categories drop-down list. 

3. Select the appropriate items in the Reasons list and the Outcomes list, or whatever lists 

you see. 

Note: 
If your Avaya Agent contains two or more lists, you may need to choose from all 

available lists before you can add the entries to the Wrap-up Selection(s) list. 

4. Click the down arrow button to add the items you selected to the Wrap-up Selection(s) 

list. 

Note: 
If you need to de-select an item that you added to the Wrap-up Selection(s) list, 

select the item, click the up arrow button, and click OK. 

5. Click OK. 

6. If a dialog box asks you to confirm that you want to wrap the contact, click Yes. 
 

 

Using a WrapUp Prompter script 

If your system is configured for a WrapUp Prompter script, the script is displayed in the 
Prompter pane when you wrap up a contact. 
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The WrapUp Prompter script contains a series of questions about contacts specifically designed 

by your company. You proceed through the script by clicking radio buttons, selecting check 

boxes, or typing text in fields to provide information about the contact. Generally, the answers to 

the script questions require you to select reason, category, and outcome information, similar to 

the information fields in the Wrap-up dialog box (see Using the Wrap-up dialog box on 
page 61). 

To wrap up a contact using the WrapUp Prompter script: 

1. Click the Hangup button to complete the voice contact. 

You automatically enter the WrapUp state, and the WrapUp Prompter script opens in the 

Prompter tab of the Contact pane. 

2. If necessary, click the Prompter tab to bring it to the foreground of the Contact pane. 

Follow the script, selecting or entering the appropriate information. 
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Chapter 4: Managing inbound voice 

contacts 

 

This chapter provides step-by-step instructions on using Avaya Computer Telephony for IC to 
manage inbound voice contacts. 

When a customer calls customer care, the call comes to the contact center from where it is 

routed through Avaya Interaction Center (Avaya IC) to an agent who is available to handle voice 

contacts. Voice contacts that are routed to you are displayed in your Phone task list. 

This chapter includes the following topics: 

● Using the phone task list and softphone on page 64 

● Handling a basic voice contact on page 68 

● Involving other agents in a voice contact on page 70 

● Initiating a voice contact on page 72 

● Example: Handling two voice contacts on page 74 
 
 
 
 

Using the phone task list and softphone 

When your contact center application forwards a voice contact to you, the contact is displayed 

in the Phone task list, which is located in the Softphone interface. 

The Phone task list displays information about all voice contacts you are currently handling. 

Each entry in your Phone task list corresponds to a different voice contact. 

The information about each contact that is displayed in your Phone task list depends on the 

telephone switch used by your contact center. The Phone task list can display the following 

information about each contact: 

● Customer Number: The number displayed depends on the inbound call and what 
information exists in the call record. If the call is: 

- inbound, the primary ANI (Automatic Number Identification) associated with the call is 

displayed. If primary ANI is not available, the ANI associated with the call is displayed. 

● Call ID: Number that identifies the contact to the software. 

● Call State: State of the contact (such as Ringing, Ready, Busy, OnHold, InCall, WrapUp) 
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Note: 
Your contact center may use different terms to describe call states. For example, 

Ready may be known as Available. Busy may be known as Auxiliary Work or Idle. 
The WrapUp state may be known as After Call Work. 

● Time-in-call: The period of time that you have been on the call with the customer in 
minutes and seconds. 

  Tip: 

If you hold a mouse pointer over a selected contact, you can see a tooltip with the 

information about the selected contact. 

The status of a new contact in the task list before you answer the call is Ringing. You 

double-click the contact to answer the call (unless you are using Auto Answer, which answers 

the call for you). 

An open angle bracket (>) indicates the active voice contact. This is the contact you are 

currently handling. All buttons that you click applies to the active contact. 

Blue highlighting indicates the selected contact. The selected contact may or may not be the 
active contact. 

 

 

Using the Softphone buttons 

You use the Softphone buttons to control the active voice contact. All Softphone buttons affect 

the active contact. For example, if you click the Hangup button, the system hangs up the active 

voice contact, but any other contacts in your Phone task list remain. 

If you receive a second voice contact while you are still handling your first voice contact, you 

can select the second voice contact by clicking it one time. This selects the contact without 

answering the telephone call. It allows you to see information about the second contact in the 

EDU Viewer or Contact History Browser while you are still engaged with your first contact. A 

selected contact is highlighted in blue in the task list. 

If you double-click the second voice contact, it becomes the active contact, while the first 

contact is put on hold. Before you double-click a second voice contact, you should tell your first 

customer that you are putting them on hold. 

If you have any problems with your Phone task list or with Softphone, see Inbound Voice 

Problems on page 181. 

With the telephony buttons, you can perform various Softphone functions. These buttons can 

include: 

● Answer or Hangup 

● Hold or Reconnect 

● Initiate 

● Transfer 
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● Consult 

● Conference 

Telephony buttons are either available or unavailable to you, depending on the current state of 

the active voice contact and on your agent state. For example, the Hold and Hangup buttons 

are available only if the active voice contact is in an InCall state. If it is not in an InCall state, the 

Hangup button is disabled (greyed out), and the Hold button is either disabled or replaced by 

the Reconnect button. 
 

 

Using the Softphone menu 

With the Softphone you can perform standard telephone functions without a physical telephone. 

The Softphone menu is part of the Avaya Agent pop-up menu. You see this menu if you 

right-click (use the right mouse button to click) any blank section of Avaya Agent. The pop-up 

menu contains the following menu options: 

● Softphone - Login/Logout 

● Softphone - Reset 

For information on logging in and out of Softphone, see Logging in and out of media 

channels on page 39. 
 

 

Using Softphone with Communication Manager (CM) switches 

If your Softphone system uses a CM telephone switch, you may need to do the following tasks: 

● Sending numerical information with DTMF 

● Using the Auto-In Work mode 
 

Sending numerical information with DTMF 

If your Softphone uses a CM telephone switch, your administrator may have implemented 

DTMF. You use DTMF to enter numerical information, such as a customer’s account or 

identification number, on the numeric keypad of the Dial Pad dialog box. DTMF sends this 

numerical information to a selected device, such as an Interactive Voice Response (IVR) unit, 

as if you had dialed the tones on your telephone. 

To send numerical information with DTMF: 

1. In Avaya Agent, click DTMF. 

2. In the Dial Pad dialog box, enter the numbers in either of the following ways: 

mailto:infodev@avaya.com


Chapter 4: Managing inbound voice contacts 

67 Agent User Guide July 2021 

Comments on this document? infodev@avaya.com 

 

 

 

 
● Click in the entry field. Then type the digits on your keyboard. 

OR 

● Click the numeric buttons in the keypad window. 

If you type an incorrect number, click the CE (Clear Entry) button to clear one number at a 

time or click the Clear button to completely clear everything that is displayed. 

3. Click Send to transmit the number across the telephone line. 

 
Using the Auto-In Work mode 

This section applies to you only if you are using a CM telephone switch and you can set the 

Auto-In and Manual-In work modes. You can set these work modes by pressing buttons on your 

telephone, by entering codes on your telephone, or by using Softphone. The work modes have 

been set up at your contact center to correspond to agent states in specified ways. 

The Auto-In work mode automatically assigns you to specific Automatic Call Distributor (ACD) 

queues. It makes you available immediately after the end of a call. Therefore, with Auto-In, you 

may get another call as soon as you hang up. 

If you plan to take a break after your current call while in Auto-In mode, you can change your 

work mode or agent state while on the call. The operation does not take effect, however, until 

you complete the call. For example, while on a call, you can click the Agent button in the Avaya 

Agent to change your agent state to Aux-work. The button will turn grey and remain grey as long 

as you remain in the call. As soon as you complete the call, your state will change to Aux-work 

and the Agent button will turn red. 

In Auto-In mode, you cannot preset the Softphone while in a call to change from a Busy 

telephone state to an Available telephone state. You must reset the Softphone to change to and 

from the Aux-work state. See Softphone Stops Responding on page 184. 

Be aware of the following issues when using Auto-In mode: 

● You should not use this mode when you are handling outbound calls. 

● If you are logged in to email or chat, you should log out of those media before using 

Auto-In. 

● Other buttons you push on your physical telephone while wrapping up in automatic mode 
may not work. 

● If your system uses the Wrap-up dialog box and you press the AutoIn and ManualIn 

buttons, a voice contact may be assigned to you while you are handling another call. You 

will see a Wrap-up dialog box for the first call after it ends, but a second call may arrive 

before wrap-up is complete. This will not happen on subsequent calls. 
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The following table shows how your agent state changes when you press a telephone button in 

either manual or automatic mode. 

 

Initial Agent State Phone Button Pushed Changed Agent State 

Available AutoIn 

ManualIn 

AuxWork 

No change 

No change 

Voice channel changes to 
busy 

Aux-work 

Aux-work AutoIn 

ManualIn 

AfterCall 

AuxWork 

Available 

Available 

No change 

No change 

Init aux-work AutoIn 

ManualIn 

AfterCall 

AuxWork 

For all buttons: 

No Change / Aux-work at the 
end of the call 

In the earlier release of IC, Agent used to go in available state when the agent used to press the 
ACW button while in the call on either the hardphone or the softphone. In IC 7.3.3, if AutoIn is 

disabled, then the voice channel remains in the AfterCallWork state if the agent presses the 

ACW button on the hardphone or the softphone. If the agent is in manual blending mode, the 

agent can go available by clicking on the Voice channel option on the softphone. If the agent is 

in Automatic blending mode, the agent can go available using the hardphone. 
 
 
 
 

Handling a basic voice contact 

This section explains how to handle a basic incoming voice contact, under the following topics: 

● Handling contacts with Auto Answer 

● Handling contacts without Auto Answer 

● Placing a voice contact on hold 

● Involving other agents in a voice contact 
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Handling contacts with Auto Answer 

If you have Auto Answer turned on, Softphone automatically answers an incoming voice contact 
and makes that your active contact. Softphone does the following: 

● Answers the voice contact. 

● Makes it the active contact. 

● Highlights the contact in the list and adds an open angle bracket (>) to help you identify 

this as the active contact. 

● Changes the contact’s status in the Phone task list to InCall. 

To answer a new voice contact with Auto Answer turned on 

1. Begin speaking with the customer. 

2. When you finish the talk, click Hangup in Softphone. 
 

 

Handling contacts without Auto Answer 

If you do not have Auto Answer turned on, follow this procedure. 

To answer a new voice contact: 

1. Double-click the new voice contact in the Phone task list. 

2. Click Answer. 

3. Begin speaking with the customer. 

4. When you finish the talk, click Hangup in Softphone. 

Note: 
If you see CTI - Server Failure in the Phone task list, contact your administrator. 

 

 

Placing a voice contact on hold 

You can place a voice contact on hold while you look up information, answer another contact, or 
transfer the voice contact to another agent. The contact’s status in the Phone task list changes 

to On Hold. 

A button in Softphone changes its label between Hold and Reconnect. When you click the 

Hold button, the label changes to Reconnect. When you click the Reconnect button, the label 

changes to Hold. 
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Note: 
If you are using an Aspect switch, you cannot use the Hold and Reconnect 

buttons. Instead, to put a current voice contact on hold and connect to a new 

voice contact, double-click the new contact. To reconnect to the first voice contact 

and put the second contact on hold, double-click the first contact. 

To place a customer on hold while you speak to another customer: 

1. Ask the customer with whom you are speaking if you can put them on hold for a moment. 

2. Click the Hold button. 

3. Double-click the new voice contact in the Phone task list. 

4. Begin speaking with the second customer. 

5. Return to the first customer, as follows: 

a. Either finish the call with the second customer or tell that customer you will put them 
on hold. 

b. Click Hold if you did not finish the call with the second customer. 

c. Select the first voice contact in the Phone task list. 

d. Click Reconnect. 

e. Continue your conversation with the first customer. 

6. If the second customer is on hold, return to that customer. 

For more complete information on handling two simultaneous telephone calls, see Example: 

Handling two voice contacts on page 74. 
 
 
 
 

Involving other agents in a voice contact 

At certain times, you might want to have other agents help you with a customer to whom you are 

speaking. You can do so using the following Softphone buttons: 

● Transfer – Transfers the call and removes the voice contact from your Phone task list 

immediately. You will not be able to speak to the customer and another agent after you 

complete the transfer. The call waits in a queue until it is connected to an agent. 

● Conference – Transfers the call to another agent while you remain on the call, and lets 
you, or the other agent, add more agents to the call as well. 

● Consult – Places the customer on hold and connects you to the other agent so that the 

two of you can talk privately before the call is actually transferred. Once you are done 

consulting with the agent, the call is transferred and the contact is removed from your 

Phone task list. You will not be able to speak to the customer and another agent after you 

complete the consult. 
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You can also transfer the voice contact to a queue if you prefer. The system routes the transfer 

to anyone currently available in that queue. You may also be able to transfer a voice contact to 

an individual agent. 

  Tip: 

If you want to transfer a contact to someone with a particular skill, first use the 

Find option to get the skilled person’s contact information, as described in 

Looking for the agents with the Find option on page 57. Then return to this 

section to transfer the contact to that agent. 

To transfer a voice contact to a queue or an agent: 

1. Tell the customer that you are going to transfer them to someone who will help them. 

2. Click the Transfer, Conference, or Consult button on the Softphone, according to the 

type of transfer you want to do, as described above. 

The Select Destination for <Transfer, Conference, or Consult> dialog box is displayed, 

depending on which button you clicked. 

3. If you want to transfer the contact to the first available agent in a queue, click the Queues 

tab. If you want to transfer the call to an agent, select the Agents tab or other appropriate 

tab. 

4. If the queue or agent to whom you want to transfer the contact is located at a different site, 

select that site from the Site drop-down menu. Select All Sites if you do not know where 

the queue or agent is located. 

  Tip: 

If you are certain you know the telephone number of an agent to whom you want 

to transfer the contact, you can enter the number in the To field, and then skip to 

Step 6 in this procedure. 

5. Find and select the queue or agent who will receive this transfer. If you need help in finding 
an agent, see Looking for the agents on the Agents tab on page 54. 

The queue name or agent name is placed in the To field when you select it. 

6. If you want to send a message to the agent who will receive the contact, put your cursor in 

the Comment field and type the message. 

The agent will see your message in the EDU Viewer. 
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7. Click Ok, or press Enter when your cursor is in either the Comment or To field. 

If you select another agent, the <Transferring, Conferencing, or Consulting> Call with 

< telephone number> dialog box is displayed. 

Watch the status of the transfer that is displayed in the dialog box. For example, if the 

status is Ringing, the other agent’s telephone is ringing. 

If you are doing a Transfer, that is, if you clicked the Transfer button in Step 2, the dialog 

box disappears when the agent answers the telephone. A Wrap-up dialog box can appear 

for you to wrap up the contact. 

If you are doing a Consult or a Conference, the dialog box status changes from Ringing to 

In Call when the agent answers the telephone. The dialog box contains buttons that let 

you switch between talking to the other agent and talking to the caller (the customer). The 

dialog box will remain on your screen until you click the Complete button. 

8. If you are doing a Consult or a Conference, begin speaking to the other agent when the 

status in the dialog box changes to Connected to Destination and the button changes to 

Switch to Caller. Tell the agent about the customer’s question or problem. 

9. Click Switch to Caller when you are ready to speak to the customer. 

When you are connected to the customer, the status changes to Connected to Caller and 

the button changes to Switch to Destination. You can click that button to speak to the 

agent again. 

10. If you are doing a Conference, add other agents to the call. 

11. You can complete your part of the Consult or Conference. Say good-bye to the customer 
and agents, and click the Complete button in the dialog box. 

You can cancel your part of the Consult or Conference by clicking Cancel button 

You can also come out from the Conference by clicking the Hangup button on the 

Softphone or Hardphone. 

Note: 
If you see the Wrap-up dialog box or a Prompter script, wrap up the voice contact 

as usual. 
 
 
 
 

Initiating a voice contact 

If you are enabled for voice contacts, you can use your contact center telephones to make a 

voice contact. You can use the UAD’s Select Destination dialog box to find the telephone 

number of another agent, supervisor, or external agent who works for your company. 

To initiate a call 

1. Click the Initiate button on the Avaya Agent Softphone to open the Select Destination for 
New Call dialog box. 
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  Tip: 

If you know the telephone number of the person you want to call, you can enter 

that number in the To field at the bottom of the UAD. Then skip to Step 9 of this 
procedure. 

2. If you want to call the first available agent in a queue, click the queue in the Queues tab. 

The name of the queue moves to the To field. 

a. If you want, write a comment in the Comment field for the agent who will receive your 

call. The agent will see your comment in the EDU Viewer. 

b. Click Ok. 

A dialog box informs you that you are being connected. 

c. When you hear the other agent, begin speaking. 

d. When you are finished speaking, click the Softphone Hangup button. 

3. If you want to call a specific agent, and there is an Agents tab on the UAD, click on that. If 

you do not see an Agents tab, search for the person as described in Looking for the 

agents with the Find option on page 57 or Filtering the data displayed in UAD on page 55. 

4. If the person is not located in your site, select the name of the site from the Site drop-down 
menu. If you do not know where the person is located, select All Sites. 

5. Navigate through the tree structure in the scroll box on the left. Click any tenant or 

workgroup to display the agents in that tenant or workgroup. Use the scroll bar as 

necessary. 

6. When you see the name of the agent you want to call, you may want to check that this is 

the correct agent. To do so: 

a. Right-click the name and click Properties in the pop-up menu. 

b. Click the Phone and Email tabs of the dialog box as necessary so you can check that 

this is the person you want to call. 

c. Click OK to return to the previous dialog box. 

7. When you find the correct name, click the name once to move it to the scroll box at the 

bottom. 

  Tip: 

You can double-click the name instead, if you want to connect the call 

immediately. 

8. If you want, write a note to the agent in the Comment field. Comments are displayed in the 
agent’s EDU Viewer. 

9. Click OK. 

A dialog box informs you that you are being connected. 

10. When you hear the other agent, start speaking. 
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11. When you are finished speaking, click the Softphone Hangup button. 

 
 
 
 

Example: Handling two voice contacts 

With Softphone, you can handle more than one incoming voice contact at the same time, using 

either the telephony buttons or keyboard shortcuts. By following this example, you can take two 

incoming voice contacts using the Softphone telephony buttons. 

In the following example, a voice contact comes into the contact center. Your Softphone is in the 
Ready state. Avaya IC routes the voice contact to you. Your Phone task list displays the caller’s 

telephone number and the contact’s status as Ringing. 

To answer two simultaneous voice contacts 

1. If Auto Answer is not turned on, double-click the contact to answer it manually. 

2. Ask for information from the customer, who is following up on a previous contact. Use the 

Contact History Browser to look up the record on the previous contact. 

While you are looking up the customer’s history, another voice contact is assigned to you. 

3. Click the Hold button to place the first voice contact on hold so that you can answer the 

second voice contact. 

4. Double-click the new incoming voice contact to answer it. 

5. Click the Hold button to place the second voice contact on hold while you complete the 

first voice contact. 

6. To return to the first voice contact, select it in the Phone task list. Then click the 

Reconnect button. 

7. When you have completed the first voice contact, click the Hangup button. 

8. If your company requires you to enter wrap-up information for each contact, you enter the 

WrapUp state, and the Wrap-up dialog box is displayed. Select the reason and click OK. 

When you complete WrapUp, this information is entered into the customer’s record. (For 
more information about wrapping up contacts, see Wrapping up contacts on page 61.) 

9. Click the second voice contact in the Phone task list to make it the active contact. Click the 

Reconnect button to speak to the customer. 

10. If you do not have the information the customer needs, click the Transfer or Consult 

button to transfer the second voice contact to another agent (see Involving other agents in 

a voice contact on page 70). 
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Chapter 5: Managing email contacts 

 

If your account is enabled for email management, you use the Web Agent to interact with 

customers by email. 

Some customers send email from the website of the company while others send it from a 

corporate or personal mail account. The email is routed by the Avaya Interaction Center (Avaya 

IC) software to agents who are available to handle email. The email contacts that are routed to 

you are displayed in your email task list. 

In IC 7.3.2, when an agent downloads a new email that takes time to render, the system 

displays an hourglass. The hourglass indicates that the email is being downloaded. 

Note: 
While replying or sending a new outbound email, you should not explicitly add the 

tracking ID or text similar to tracking ID in the email subject. 

The format of tracking ID is as mentioned below: 

● [T<YYY><MM><DD><4 digit for base 32 string>S<2 digits for 

special status><1 digit for agent preference for 

routing>Z<Messageid of outgoing email>] 

● [T<YYYY><MM><DD><4 digit for base 32 string>S<2 digits for 

special status><1 digit for agent preference for routing>] 

This section contains the following topics: 

● Being alerted to a new email contact 

● Using the email task list 

● Viewing images in an email message 

● Viewing email history 

● Adding additional font for Plain Text mode 

● Composing a normal email reply 

● Formatting email text 

● Addressing emails with UAD 

● Using resources in an email 

● Using suggested responses 

● Sending an email to an external agent 

● Transferring an email contact 

● Deferring an email 
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● Saving an email draft 

● Forwarding an email 

● Forwarding an original email 

● Checking spellings in your emails 

● Requesting more information from a customer 

● Responding to an email alert 

● Resolving an email 

● Originating an outbound email 

● Approving or rejecting an email 

● Handling a rejected email 

● Using multiple languages with an email 

● Monitoring an email session (Supervisors Only) 

● Wrapping up an email contact 
 
 
 
 

Being alerted to a new email contact 

Email that customers send from the company website may be routed to you whenever you are 
available for email. 

Depending on how the Avaya IC software has been set up at your contact center, you may be 
alerted to an incoming email in two ways: 

● By a sound. For information on changing the way that you are alerted, see Setting 

Preferences on page 163. 

● By a screen pop. This is a dialog box that asks if you want to suspend your other contacts 

to begin handling the new email contact. You may be able to control whether you receive 

this dialog box, with the Wait for agent confirmation before accepting a contact 

preference. For information, see Setting Preferences on page 163. 

Note: 
If you are alerted to an email contact but do not acknowledge it within a preset 

amount of time, the contact is assigned to another agent and removed from your 

email task list. The amount of time is set by the administrator of the WebACD 

Server configuration. 
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Using the email task list 

The email task list displays the email contacts currently assigned to you. 

If you click a contact in the email task list, it becomes selected. The subject line of the selected 

contact is displayed when you click the contact. All tasks that you perform to the email in the 

Web Agent apply to the selected email contact. (When you double-click a contact, the Web 

Agent window opens and displays this contact in Compose mode or Reply mode.) 

The information about your email contacts is displayed in the space of the email task list by 
visual cues, including icons and text. 

 

 

Icons in the email task list 

If you pay attention to the icons in the task list, you can see at a glance a lot of useful 

information. There are three columns of icons in the email task list. To see all available 

information in a table column, hold your cursor at the right edge of any column title. When you 

see a double-headed arrow, click and drag to the right. 

Note: 
While an agent is handling an email contact, if a voice call arrives, the email task 

list changes the status of the email contact from Active to InActive or Pause. 

While the status of the email contact is InActive or Pause, if you click any button 

on the Web Agent toolbar, the Web Agent toolbar and the options in the Contact 

menu are disabled. 

The state of the email remains InActive or Pause and the state of Web Agent toolbar 

remains disabled till the agent clicks the email task while handling the voice call or 

after the voice call is complete. 

The icons in the first column indicate whether the email is active or has been transferred, as 
shown in the following table. 

: 

Icon Description 

 

 The email contact is active. 

 

 
You have transferred this email to your supervisor or to another agent. The contact 
remains in your task list until you wrap it up. 

Note: If you receive an error when you transfer an email to another agent, contact 
your administrator. 
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The icons in the second column give you information on the source of each email contact. You 

may see icons representing the following sources: 

 

Icon Description 

 

 
A reply to a normal email sent to the customer by the agent 

 

 
A reply from an external agent 

 

 
A reply from a customer to a request for additional information 

 

 
A reply to an email you forwarded. 

 

 

An email composed by another agent and forwarded to you for approval (Quality 
Assurance) 

 

 
An email rejected during Quality Assurance and sent to you for correction 

 

 
A reply to an email that you originated. 

 

 
An email alert, notifying you that an email requested from a customer or an 
external agent is overdue. 

 

 
A reply from an automatic response email that was sent to the customer from the 
Avaya IC system. 

Icons in the third column the current status of each email contact, as shown in the following 
table. 

 

Icon Description 

 

 
New, unopened email contact. 

 

 
Open, active email contact. This is the contact you are currently handling in the 
Web Agent. 

 

 
Deferred email contact. Click this contact when you are ready to complete your 
email reply. 

 

 
Email contact in WrapUp state. You are wrapping up this email in the Web Agent 
while you select information in the Wrap-up dialog box or you use a Prompter 
script. 

 

 Email contact is in Inactive state. That is, a set amount of time has passed since 
you selected it. When you click it, this contact will become active. 
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Text in the email task list 

The following areas give you text information about a selected email contact: 

● Origin – The email address from which the email was sent. 

● Age – The length of time the contact has been assigned to you. The time runs 

continuously until you complete the contact. 

● Question box – The text the selected customer typed in as the subject of their email. 
 

  Tip: 

You may not be able to see all of the information in the Origin and Age columns. 

To see all of the information, hold your cursor between two columns until the 
cursor changes its shape. Then click and drag the column to the left or right until 

you can see the information you want to see. Repeat in the other direction as 

desired. 
 
 
 
 

Viewing images in an email message 

An incoming HTML email can have two kinds of inserted images: 

● Image links that point to external images. If you do not have access to the internet or are 
behind a proxy server you may not be able to view the images in the Email Preview panel. 

● Embedded images that you can view regardless of whether you have access to the 

internet or not. Embedded images can increase the size of your email. 

You can view embedded images in the Email Preview panel and in the Attachments window. 

To save an embedded image, use the save option in the Attachments window. 
 
 
 
 

Viewing email history 

You can search for copies of previous emails sent by your customers in the History dialog box. 
This dialog box has the following tabs: 

● Tracking History – Detailed tracking information about the current email and past emails 

sent from a customer’s email address 

● Customer History – A list of previous emails the customer has sent to your company and 

copies of the emails themselves 
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Note: 
Another agent may have deferred an email contact from this customer. You 

cannot see deferred email contacts in the History dialog box but you can see 

them in the Active Contact Viewer. It is a good idea to check the Active Contact 

Viewer when you are looking for information about a customer’s recent contacts. 

See Viewing active contact information on page 49. 

To see the tracking history or previous emails of an email contact 

1. Display the email you want information about in the Email Preview mode. 

2. Click the View Email History button in the email toolbar. 

The History dialog box opens with the Tracking History tab displayed. 

3. To see the maximum amount of information in the Tracking History tab, do any of the 

following: 

● To see all available information in a table column, hold your cursor at the right edge of 

any column title. When you see a double-headed arrow, click and drag to the right. 

● To see tracking information about past emails sent by this customer, select the View 
Full Email History check box. 

4. To see complete technical information about the routing of any email selected in the table, 

select the Header check box. When there is a problem, this information may be full for 

supervisors or administrators. 

5. To see copies of emails this customer sent to your company in the recent past, click the 

Customer History tab. 

6. In the Months drop-down list, check the interval to see the time duration of the emails 

displayed. For example, Customer History dialog box may display emails that were 

received in the past one month. If you want to see emails that arrived before this time 

duration, you may be able to select the new duration from the Months drop-down list. 

7. Select any email in the box at the top to see a copy of the email itself in the scroll box at 
the bottom. 

Note: 
If you see an Attachment button (paper clip) to the right of a selected email, click 

the button to see a list of all attachments. Click the button to open the 

attachments or save them to your computer. 
 
 
 
 

Adding additional font for Plain Text mode 

By default, there are only three fonts for Plain Text mode in the agent application: 

● Serif 

● Sans Serif 
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● Monospaced 

Web Agent Plain Text mode supports all the fonts that are supported by operating system. In 

case the administrator sets a font on the Web Agent that is not present on the customer system 

or email application, the default font will be used. 

To add additional font for Plain Text mode: 

1. Go to the following path: 

<Install Drive>:\Avaya\WebAgent 

2. In the WebAgent folder, create a folder named Customization. 

3. In the Customization folder create a file named PlainTextExtraFonts.properties. 

4. Add the required font names in the PlainTextExtraFonts.properties file. For example: 

Comic Sans MS 

Tahoma 

Times New Roman 

5. Save the PlainTextExtraFonts.properties file. 

6. Logout of the Agent application and re-login. 

To view/select the newly added fonts: 

1. Login to the Avaya Agent application. 

2. In the Avaya Web Agent window, click Tools > Preferences. 

3. In the Web Agent Preferences window, click the User Interface tab. 

4. On the User Interface tab, in the Font Settings section, click Text tab. 

5. In the Font Name option, click to drop-down menu to view/select the available fonts for 

Text mode. 

6. Logout of the Agent application. 

7. Login to the Agent application. 
 
 
 
 

Composing a normal email reply 

The following procedure explains how to compose a normal reply to a customer email using 

features available in the email reply screen. 
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To compose a basic email reply to a customer: 

1. In Avaya Agent window, check the Email Channel button to ensure that you are available 
to handle email. 

If the Email Channel button shows a yellow X, click the Email Channel button to make 

yourself available for email. 

You are now available to receive the number of email contacts that is set for you in your 

channel load. See Setting your channel loads on page 46 for information about channel 

loads. After you become available, any email contacts that are routed to you show up in 

the email task list. 

2. In Avaya Agent, select a contact in the email task list. If there is more than one contact, 

select the oldest one. The contacts are usually listed in reverse chronological order, that is, 

with the oldest contact at the top. 

For information about the meaning of the icons, and the text displayed in the Origin and 
Time columns, see Being alerted to a new email contact on page 77. 

 

The Web Agent window opens in the Email Preview mode to show you this email and 

information about it. The Information Bar displays "New inbound message from customer." 

3. Read the message using the scroll bar, if necessary, to see the entire message. 

4. If you see the Attachment button (paper clip) in the Email Preview toolbar, this email has 

one or more attachments. Click the button to open the attachments or save them to your 

computer. 

5. Before you begin your reply, you can use any of the following buttons in the email toolbar, 
as needed. You can also return to this Preview tab later to use these buttons. 

● Print – Prints the currently displayed email to the default printer. 

● Resolve – Lets you apply a status to the email. See Resolving an email on page 109 
for information. 

● Email History – Displays a dialog box with tracking information about this email or 

copies of previous emails sent from the current customer’s email address, including 

email attachments, if any. See Viewing email history on page 80 for more information. 

● Transfer – Displays the Unified Agent Directory so you can transfer this email contact 

to a particular agent, or transfer it to a queue and let Avaya IC route the email to the 

first available agent in that queue. For information, see Transferring an email 

contact on page 98. 

● Defer – Defers your reply to this email contact until a later time. The contact remains in 

your email task list but you are available for another email to replace this one. For 

more information, see Deferring an email on page 99. 

● Wrap – Wraps up this email contact. See Wrapping up an email contact on page 116 
for information. 

6. To begin your reply, click one of the two reply buttons in the email toolbar: 

● Reply – Addresses your reply to the sender of the email and no one else. 
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● Reply to all – Addresses your reply to the sender of the email and to all the people 

listed in the Cc (Copy) field of the message you are replying to. 

The window changes to Compose mode where you will write your email reply. Note that 

the drop-down menu indicates that this is a Normal Reply. 

7. If desired, change the format of the email work item. For more information, see Changing 
the message format on page 86. 

8. If you want to add the email address of anyone in your company, so that they will receive a 

copy of this email, add their email address easily to any of the address fields by using the 

UAD. See Addressing emails with UAD on page 91 for information. 

9. Look in the Resource area of the window to determine if there are any Suggested 

Responses. If you see Suggested Responses, refer to Using suggested responses on 

page 95 for instructions about choosing a response or responses. 

10. If you do not see Suggested Responses, look for any resources that are relevant to the 

customer’s question in the Email Templates folder, Global Resources folder, or Agent 

Resources folder. For information on viewing resources, see Viewing Your Resources on 

page 162. 

11. If you found a resource that you want to use, add it to your message. For information on 

adding resources to an email, see Using resources in an email on page 92. 

12. If you added a resource, read the message in the Message Composition area and modify 

it appropriately, if necessary. 

13. Type your message to the customer in the Message Composition area. Be sure that you 
address the customer’s question or problem. 

 

  Tip: 

If you added a resource or an attachment, you can begin with a short introduction 

to explain the resource or the attachment. 

14. Look over the buttons in the email toolbar to decide whether you want to execute any of 

the commands before you send your message. The buttons are as follows: 

● Print – Prints the currently displayed email to the default printer. 

● Save – Saves a draft of your message. The contact remains in your email task list. The 

next time you double-click this contact and begin to reply to this customer’s email, the 

Compose window opens with the message you saved. 

● Cancel – Displays a dialog box that asks if you want to save a draft of the reply you 

are composing. If you say No, your reply is deleted, and you must compose a new 

reply for this email contact. 

● Add Attachments – Attaches a file from your computer’s hard drive or from the hard 
drive of any computer that you can access on the network. When you press the Add 

Attachments button, a window is displayed where you can browse to the file and 

select it. 
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● Spell Check – Helps you check and correct the spelling of your message. For 

information, see Checking spellings in your emails on page 104. 
 

  Tip: 

You can select an option in the Preferences dialog box to bring up the Spell 

Checker automatically before your messages are sent. If you select this option, 

messages are spell checked before sending. See Setting Preferences on 
page 163. 

15. When the message is complete, click Send. 

If the Spell check before sending an email option is selected in your Preferences, the 

Spell Checker is displayed so you can check the spelling in your message. Check the 

spelling, referring to Checking spellings in your emails on page 104. 

If the Confirm before sending an email option is selected, a dialog box asks if you are 
sure you want to send the message. Click Yes. 

To change the preferences that determine whether the Spell Checker or the confirmation 
dialog box are displayed whenever you start to send an email, see Setting Preferences on 

page 163. 

Your response is sent to the customer. 

16. Click the Wrap button to wrap up the email contact. If you need more information, see 

Wrapping up an email contact on page 116. 
 
 
 
 

Formatting email text 

Avaya IC supports two text formats for email messages and resources: 

Plain text format: Plain text format does not support text formatting, special formatting, or 

inserting images in the body of an email message. 

HTML format: HTML supports special formatting in the body of an email message. With HTML 

format, you can format the text in the message. For example, you can emphasize words with 

bold, italics, or colors. You can also view and insert images in an email message. 

Note: 
Web Agent does not support stationary or background images in emails. If a 

customer sends an email with stationary or a background image, Web Agent 

does not display the stationary background. Web Agent displays all other HTML 

formatting in the message, including any embedded images. 

This section includes the following topics: 

● Changing the message format on page 86 

● Formatting HTML text on page 86 
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Changing the message format 

The type of email message determines the message format: 

● Replies and forwarded emails automatically use the same message format that Web 

Agent uses to display the original incoming email. For example, if Web Agent displays an 

incoming email in HTML format, your reply is also in HTML format. 

Note: 
If an email is received in the HTML format and you have set the preference to the 

Plain Text format, the read and replies of that email will be in the format in which 
you received the email. 

● New outbound emails use the default format set in your preferences. To set the default 

format for all new outbound email messages, see email preferences on page 166. 

If a reply or other outbound email is sent to an approver for quality assurance, the approver can 

change the format of the email message. However, all email approvers should set their email 

preferences to read incoming emails in HTML format. This setting ensures that Web Agent 

displays all emails that require approval in the format selected by the agent. 

To change the message format, select one of the following options from the drop-down list: 

● HTML 

● Plain Text 

 
Important: 

If you change the format of an email message from HTML to Plain Text, you will 

lose all formatting, images, and other content that is not supported in plain text. 
 

 

Formatting HTML text 

You can format all HTML email messages that you create, including new outbound emails, 
replies to customers, and forwarded emails. 

This section includes the following topics: 

● Formatting message text on page 87 

● Aligning text on page 87 

● Changing the font colors on page 87 

● Creating a bulleted or numbered list on page 88 

● Inserting an image on page 88 

● Inserting a hyperlink on page 88 

● Removing a hyperlink on page 91 

! 
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Formatting message text 

To format message text 

1. Select the text you want to format. 

2. On the HTML formatting toolbar, select one of the following options. 

● Bold 

● Italic 

● Underline 

● Font 

● Font Size 
 

  Tip: 

To make more than one format change to the selected text, select Font 

Properties on the HTML formatting toolbar and apply the desired formats. 

 
Aligning text 

To align text 

1. Select the text you want to align. 

2. On the HTML formatting toolbar, select one of the following options. 

● Align Left 

● Center 

 
Changing the font colors 

You can change the background color of selected text and the color of the text. 

To change font color 

1. Select the text you want to format. 

2. On the HTML formatting toolbar, select one of the following: 

● Highlight Color to change the background color of the text. 

● Foreground Color to change the color of the text. 

3. In the Font Color dialog box: 

a. Select the color you want to apply. 

b. Click OK. 
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Creating a bulleted or numbered list 

To create a bulleted or numbered list 

1. Select the paragraphs that you want to include in a bulleted or numbered list. 

2. On the HTML formatting toolbar, select one of the following: 

● Bullets 

● Numbering 

 
Inserting an image 

In an email, you can insert an image. However, the size of an email contact increases with each 

image that you insert. Also, some customers may be unable to download an email that contains 

one large image or many smaller images. Therefore, do not insert many images in an email. If 

possible, link the image from a Web server that a customer can access. 

You can insert local images by drag-n-droping them in the email body editor. 

To insert an image from Web server you can copy image’s url to the email editor. Link will be 
recognized and inserted as a picture. 

Also you can use Insert Image button: 

 
1. In the email message, place the cursor where you want to insert the image. 

 

2. On the HTML formatting toolbar, click the Insert Image button. 

 
3. In the Insert/Edit Image dialog box, type or paste image location in the Source field. 

 
4. You can add alternative description and resize the image. 

 
5. Click Save. 

 
Inserting a hyperlink 

In an email, you can insert a hyperlink that a customer can click to open the linked resource. 
You can insert the hyperlink for the following resources: 
 

● Existing file or a webpage 
● Email address 
 
To insert a hyperlink in an email body: 
 
1. In an email message, select the text that you want to mark as hyperlink or place your 
cursor where you want to insert hyperlink. 
 
2. On the HTML formatting toolbar, click the Insert Hyperlink button. 
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3. In the Insert Hyperlink dialog box, enter or select the values for the following fields: 
a. Enter address to the URL field with desired protocol: http, https, ftp etc. To link an 
email adress use mailto: with adress. 
 
b. Enter text to display. If you have selected some text in the document you want to 
turn into link, it will be in that field.  
 
Warning! If selected text contains several lines, it couldn’t be shown properly in a 
dialog box, so the field would be absent, but text will turn into link after aplying. 
 
c. Enter link title if needed. 
 
d. Click Save 
Important: The email client application must support displaying the screen tip for a 
hyperlink. 
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Removing a hyperlink 

From an email body, you can remove the hyperlink. After you remove the hyperlink, the system 

deletes the link and changes the linked text to a normal text. The system also removes the 

actual email address or the URL from the Current Document list on the Insert Hyperlink 

dialog box. 

To remove a hyperlink: 

1. In the email message, set cursor on hyperlink. 

2. On the HTML formatting toolbar, click Remove Hyperlink. 
 
 
 
 

Addressing emails with UAD 

When you address emails to people at your contact center, the Unified Agent Directory (UAD) 

can help you find and add the addresses quickly and easily, and without errors. The UAD opens 

in a special Email Addressing mode for this purpose. This is useful for the following tasks: 

● Composing a normal email reply 

● Sending an email to an external agent 

● Transferring an email contact 

● Forwarding an email 

● Originating an outbound email 

Note: 
The following procedure explains how to add email addresses, not how to do 

other tasks such as transfer emails or send them to external agents. See the 

appropriate sections, as listed above, for those procedures. 

To address an email using the UAD: 

1. In the Compose window, display the email you are responding to the customer. 

2. Click the button beside the Cc or Bcc fields to display the UAD. 

The meaning of these fields is as follows: 

● Cc (Copy) – This field is for the address of any person that you want to receive a copy 

of this email. 

● Bcc (Blind Copy) – This field is for the address of any person that you want to receive 

a copy of this email, without anyone else knowing their address. 

Note: 
The To field is disabled for a Normal Reply and for a Request Additional 

Information email because the email is automatically addressed to the customer 

to whom you are replying. 
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3. If the person you are looking for is not located in your site, select the name of the site from 

the Site drop-down menu. If you do not know where the person is located, select All Sites. 

4. Navigate through the Agents tab, or any other tab available to you, opening groups as 

necessary, until you find the person to whom you want to address this email. 

5. Select the desired name and click the To, Cc, and Bcc button to add the email address of 
that person. 

6. Repeat the preceding steps as desired to add the addresses of all the intended recipients 

to your email. 

7. Click Ok. 

The email addresses are added to the email you are composing. 

8. If you are doing any of the following tasks, return to the appropriate section to finish your 
email and send it: 

● Composing a normal email reply on page 82 

● Sending an email to an external agent on page 96 

● Transferring an email contact on page 98 

● Forwarding an email on page 101 

● Originating an outbound email on page 111 
 
 
 
 

Using resources in an email 

Resources are prepared text messages, emails, and URLs (Internet addresses) that you can 
send repeatedly to different customers by chat or email. Resources save you the time and 

tedium of typing the same things again and again. Text and email resources may contain such 

things as greetings, closings, and answers to frequently asked questions. email resources may 

have information already entered in the To, Cc, and Bcc fields, and they may contain 

attachments. URL resources may be links to company webpages. For example, a URL may link 

to a page about exchange policies. 

When you are composing an email, you may see any or all of the following types of resource 

folders: 

● Global Resources: This folder is for email, text, and URL resources created for you and 

other agents by supervisors. If you are an agent, you cannot create or modify these 

resources. 

● Agent Resources: This folder is for email, text, and URL resources that you create for 

yourself. These resources are saved with your login ID. You are the only person who can 

see or use the resources you create. 
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● Email Templates: This folder is for a type of email resources called email templates. 

These are created for you and other agents by administrators. An email template is a 

standard email response that you can customize while using. For example, your current 

customer’s name and the current date may be automatically entered into the email 

resource whenever you use it. Your company may also send a copy of an email template 

when you apply a status to a customer’s email. For information, see Resolving an email on 

page 109. If your administrator has configured Selective download of templates, you will 

see a drop-down list with the following options: 

● My Templates: Only the templates that belong to your assigned workgroup will be 

visible. 

● All templates: All the templates available in your system will be visible. 

You can switch between My Templates and All Templates. 

● Suggested Responses: (If your company is not using the Content Analyzer, you never 

see this folder.) This folder is for email resources that are created by an Avaya software 

product, called the Content Analyzer, in response to a particular email. When these 

resources exist, you must consider using them before you consider using resources in any 

of the other folders. For more information, see Using suggested responses on page 95. 

The resources in the Global Resources folder and the Agent Resources folder can be any of 

three types: email, text, or URL. The Email Templates and Suggested Responses folders, when 

these exist, are always email resources. email, text, and URL resources are described in detail 

in Resource types and examples on page 157. 
 

 

Resource formats for email message 

To properly use the resources in an email message, ensure that the format of the resource 
matches with the format of the email message. If you try to insert a resource in a different 

format, the email message might not display the content of the resource correctly. 

The following table shows what happens when you insert a resource into an email work item. 

 

Resource format email format Result 

HTML HTML Uses the formatting of the resource. Ignores the 
format of the email work item at the cursor position. 

Plain text HTML Uses the formatting of the resource. Ignores the 
format of the email work item at the cursor position. 

HTML Plain text Converts the content of the resource to plain text. 
Ignores all HTML formatting in the resource. 

Plain text Plain text Inserts the resource at the cursor position. 
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Using Global, Agent, or Email Template resources in an email 

To use a global, agent, or email template resource in an email 

1. While composing an original email or an email reply, look through the resources available 

to you. See Viewing Your Resources on page 162 for information. 

2. To use a resource, right-click it and select the appropriate option, depending on the 
resource type. 

The options are as follows: 

● Email, Email Templates, and Suggested Responses - Use is the only option. When 

you select this option, the entire email resource is used, including all header 

information and text in the resource. You can edit this information as needed. 

● Text – Insert - Insert places the text of the resource into the email you are composing. 
Insert Quoted does the same as Insert but adds a special character at the start of 

every line to indicate that the text was pasted into the email. If you want to choose a 

different character to be inserted, see email preferences on page 166. 

● URL – Insert- Insert pastes a copy of the URL from the resource into the email you 

are composing. Insert Quoted does the same as Insert but adds a special character 

to indicate that the URL was pasted into the email. 

3. If this is an email resource, email addresses in the To, Cc, and Bcc fields of the resource 
are added to your email, along with any addresses already in your email reply, such as the 

customer’s reply address. Modify or delete these addresses, and add new ones if you 

want. 

Note: 
In a Normal Reply or a Request Additional Information email, you cannot edit 

the To field because the email is automatically addressed to the customer. 

4. If there is no information in the Subject field, enter an appropriate subject. 

5. Modify any text that was inserted from the resource into the body of your email, as 

necessary. 

6. Finish composing the email. 

7. Click Send when you are ready to send the message. 

8. Click Wrap to wrap up the email contact. 
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Using suggested responses 

Suggested Responses are generated automatically, either by Avaya IC or by software called 

the Avaya™ Content Analyzer. The software is guessing that these responses may 

appropriately answer the current customer’s question. 

When an incoming email in your email task list has been analyzed, you see a Suggested 

Responses folder in the Web Agent. The resources are “dynamic,” that is, the resources and 

the folder that contains them are only available when the email contact they were created for is 

active. When you complete that email contact, the resources that apply to it are removed. 

You must read the email from the customer and decide which of the Suggested Responses best 

answers the customer’s question or problem. If you see a score for the responses, this may 

help you decide. The higher the number, the more likely it is that this is a proper response to the 

customer’s question. 

To select and send Suggested Responses 

1. Double-click an email contact in the email task list. 

The Web Agent window displays the customer’s message in the Email Preview mode. 

2. Read the customer’s message, using the scroll bar if necessary to see the entire message. 

Be sure you understand what the customer is asking. 

3. Click the Reply button or select Contact > Reply to begin your reply to the customer. 

4. If you see a Suggested Responses folder, look at the responses with the highest scores 

first. The responses with the highest scores are displayed at the top of the list. 

Note: 
If you do not see a Suggested Responses folder, no Suggested Responses have 

been created for this message. 

The scores give an indication of the likelihood that each response is a good one. In other 

words, the higher the score, the more likely it is that this is a proper response to the 

customer’s question. However, only you can decide what is actually the best response. 

  Tip: 

You can hold your cursor over any Suggested Response to see information about 

it, without opening it. 

5. If the responses have attachments, verify that the attachments are appropriate for the 

customer’s question. 

6. Right-click each response and select View Resource. Read the responses one by one, 
until you see one or more that you think answers the customer’s question. You may need 

to read all the Suggested Responses to find the response or responses that you think 

answer the customer’s question best. 
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7. When you have found a response that you want to send to the customer, right-click it and 

select Use. 

The contents of the Suggested Response are inserted into your email reply. 

8. If you want, add some additional text to address your customer directly, or make any small 

changes that you think are necessary to better answer your customer’s question. 

9. If you found other Suggested Responses that you think are appropriate, repeat Steps 7 

and 8. Each time you select Use for a Suggested Response, that response is added to the 

message. You can add or delete text to help your customer understand the multiple 

responses. 

10. When the message is ready, click Send. 

11. Click Wrap to wrap up the email contact. 

 
 

 

Sending an email to an external agent 

If you do not know how to answer a customer’s question or solve a customer’s problem, you 
should ask for information from a person, usually outside of your company, who has been 

designated as an external agent because of special knowledge or skills. 

You use a special type of email when you send an email to an external agent. This type of email 

sends you or another agent an alert message if you do not get a response from the external 

agent within a certain period of time. 

You should defer the customer’s email to put it on hold while you write to the external agent and 

wait for a reply. If you receive a reply from the external agent that will help your customer, you 

can find the deferred email and send the customer the information. 

To send an email to an external agent about a customer’s question 

1. Read the customer’s email in the Email Preview mode. 

2. If you need information from an external agent to answer the customer’s question or 
problem, click the Defer button in the email toolbar to put the customer’s email on hold. 

The email contact remains in your email task list, marked with a red icon to indicate that it 

is deferred. 

3. Click the Reply button or select Contact > Reply. 

The drop-down menu displays the Normal Reply selection. 

4. Select Send to External Agent from the drop-down menu. 

The letters RE: are added to the beginning of the Subject field of the email to indicate to 

the external agent that this message is about an email you received. 
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5. Click the button beside the To field. 

The UAD is displayed in External Agent mode. Only external agents are visible. 

6. If the external agent is not located in your site, select the name of the site from the Site 

drop-down menu. If you do not know where the external agent is located, select All Sites. 

7. Navigate through the tenants and workgroups in the UAD for the name of the external 
agent. 

8. Select the name of the external agent to move it to the To field. 

You can only include one email address in the To field. If you need to write to additional 

external agents, send a separate email, or add their email addresses to the Cc field. 

9. Click Ok to add the external agent’s email address to your email. 

10. Compose your email to the external agent. 

11. Click Send when you are ready to send this email to the external agent. 

12. Click Wrap to wrap up this email contact. 
 

 

Handling a Reply from an External Agent 

If you or another agent previously sent an email to an external agent, you may receive a reply 

from the external agent as a contact in your email task list. 

To handle a reply from an external agent 

1. In Avaya Agent, select the reply from an external agent in the email task list. 

A special icon in the task list identifies this as a reply from an external agent. 

The Web Agent window opens in the Email Preview mode to show you this email and 

information about it. The Information Bar informs you that this is a reply from an external 

agent. 

2. Use the scroll bar, if necessary, to see first the message requesting information from the 

external agent. Then read the reply from the external agent. 

3. Take whatever action is needed. For example: 

a. If you deferred the original email from the customer while waiting for the external agent 

to respond, double-click the Defer icon in the email task list. This makes the email 

reply to the customer active again. 

b. Copy the information in the reply from the external agent by clicking Control+C. 

c. Paste the information into the reply to the customer. 

d. Write any other text to the customer as appropriate. 

e. Click Send. 

f. Click Wrap. 
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Transferring an email contact 

In most cases, you try to reply to your customers by yourself. But in some cases, you may not 

be able to handle a customer’s problem. In those cases, you may want to transfer the email 

contact to another agent or supervisor. When you transfer a contact, it is removed from your 

task list, and it is no longer your responsibility. 

  Tip: 

If you want to transfer this email to a person with a particular skill, for example to 

someone who speaks a particular language or supports a particular product, first 

use the Find option to find the email address of a person with that skill. See 

Looking for the agents with the Find option on page 57. 

To transfer an email contact: 

1. If you are not viewing the email you want to transfer in Email Preview mode, click the 

Preview tab. 

2. Click the Transfer button in the email toolbar. 

The Select Destination for Transfer dialog box is displayed. 

3. If you want to transfer the email to anyone in a particular queue, do the following: 

a. Select the queue from the Queues tab. 

The name of the queue is displayed in the To field. 

b. If you want to include a message to the agent who will receive the email, put your 
cursor in the Comment field and type the message. 

c. Click Ok. 

The email is transferred to the queue that you specified. The contact is removed from your 
email task list. 

4. If you want to transfer this email to a particular person, click the Agents tab or the 

appropriate workgroup tab. Then do the following: 

a. If the person you are looking for does not belong to the tenant or workgroups that are 

displayed, make an appropriate selection from the Site drop-down menu. If you are 

not certain which site the person belongs to, select All Sites. 

b. Navigate through the tree structure. Click the plus button (+) beside the name of any 
tenant or workgroup to display its contents. Use the scroll bars as necessary to see 

more information. 

c. When you find the name of a person you want to transfer this email to, click the name 

select it. 

The name of the agent is displayed in the To field. 
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d. If you want to include a message to the agent who will receive the email, put your 

cursor in the Comment field and type the message. 

e. Click Ok. 

The email is transferred to the agent that you specified and the transfer successful 

message is displayed. The contact is then removed from your email task list. 
 
 
 
 

Deferring an email 

When you need considerable time to find an answer to a customer’s question or a solution to 

the customer’s problem, you can defer the email contact so you can work on it at a later time. 

When an email contact is deferred, another email contact can be routed to you in the place of 

the deferred contact. For example, if your channel load allows you to handle only one email, 

when you defer an email, another email can be routed to you. 

To defer an email: 

1. Click the Preview tab for this email if you are not already viewing the email in the Preview 

mode. 

2. Click the Defer button in the email toolbar. 

The email is saved as a draft, including the customer’s address and any text that you 

began writing. The email contact remains in your email task list, marked with a red icon to 

indicate that it is deferred. 

3. Take any action necessary to find an answer of the customer’s question. For example, you 

may want to send an email to an external agent asking for information, or you may want to 

transfer the email contact to another agent. See Sending an email to an external agent on 

page 96 or Transferring an email contact on page 98. 

Note: 
After you defer the email, you are available for another email to replace it. The 

wait time for the contact continues to count while the email contact is deferred. 

When you are ready to work on this email, see Finishing a deferred email on 

page 100. 
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Finishing a deferred email 

If you deferred an email, you must return to it and complete it as soon as you can. 

To finish a deferred email: 

1. When you are ready to return to an email that you previously deferred, double-click it in 

your email task list. 

The Compose window displays the message that you deferred. This is now an active 

email contact. 

  Tip: 

While you are replying to an email that you previously deferred, you are still 

available for another email. If you do not want to receive another email contact 

while you are replying to this email, click the Agent button or the Email Channel 

button in the Avaya Agent to put yourself in Aux-work (Busy) state. After you 

finish replying to the email, click the button again to make yourself Available. 

2. Finish writing your email reply. If you received information from the external agent to help 

your customer, select and copy the information by clicking Control+C. Then paste the 

information into the email reply by clicking Control+V. 

3. When the email is ready, click Send to send the email. 

4. Click Wrap to wrap up the email. 
 
 
 
 

Saving an email draft 

When you begin to reply to an email but do not want to send the reply at the moment, you can 

click the Save button to save the current email as a draft. The email client application saves the 

contents of the reply and the added the email addresses in the Compose window. The email 

contact remains in your email task list. 

 
Important: 

If a draft email contains email addresses in the CC and Bcc fields, you need to 

delete the email addresses that are not required from the CC and Bcc fields after 

you open the same draft email using the Reply, Reply-All, or Forward a Copy 

options. 

The Avaya Agent Rich Client does not maintain separate copies of a draft email for 

Reply, Reply-All, or Forward a Copy options. 

! 
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When you are ready to send the reply, click the Compose tab. The email client application 

displays the new contents in the email body and the email addresses in the respective To, CC, 

and Bcc fields. 

Note: 
A new email that arrives in the system does not replace the saved email until you 

send that email reply. 
 

  Tip: 

If you want to hold an email for a long period of time because you are waiting for 

information, you can defer that email and return to that email later. Deferring an 

email allows you to receive another email in place of the email that you defer. For 

more information about deferring an email, see Deferring an email on page 99. 
 
 
 
 

Forwarding an email 

You may occasionally want to use Avaya Agent to forward a copy of an email that you received 

to another email address. For example, you may want to forward an email expressing a 

customer’s interest in a product that another agent supports. This lets the agent contact the 

customer. 

Do not use Forward: 

● To transfer ownership of an email to another agent. If you need to transfer ownership of an 

email to another agent, see Transferring an email contact on page 98. 

● To write to an external agent for help with the email. If you need to obtain information from 

an external agent, see Sending an email to an external agent on page 96. 

If the Unified Agent Directory (UAD) at your contact center uses workgroup tabs or an Agents 

tab, you can use the UAD to forward the email to a particular person, or to anyone in a particular 

workgroup or anyone with a particular skill. 

To forward an email: 

1. With the email displayed in the Email Preview window, click Forward. 

The Information Bar tells you that the email will be forwarded to the specified recipient. 

The Subject field uses the subject of the email you are forwarding, preceded by FW: to 

indicate that this is a forwarded message. 

2. Write a message to the recipient or recipients of this forwarded email at the top of the 
message itself. You may want to explain why you are forwarding the email and give any 

other relevant information. 
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  Tip: 

If you want to forward this email to a person with a particular skill, for example to 

someone who speaks a particular language or supports a particular product, use 

the Find option instead of the Agents tab described in the following steps. See 

Looking for the agents with the Find option on page 57. Then return to finish the 

remaining steps of this procedure. 

3. Click the button beside the To, Cc, or Bcc fields, according to which of the following 

address fields you want to use: 

● To – The main person to whom you want to forward this message. You can only 
include one email address in this field. 

● Cc (Copy) – Anyone else that you want to receive a copy of this email. 

● Bcc (Blind Carbon Copy) – Anyone that you want to receive a copy of this email 
without anyone else seeing their address. 

The UAD opens in Email Addressing mode. This mode makes it easier for you to add 

email addresses. In this mode, the UAD displays only the agents that are enabled for email 

and it contains only their email addresses. 

4. If you want to forward this email to a person, click the Agents tab or the appropriate 

workgroup tab. Then do the following: 

a. If the person you are looking for does not belong to the tenants or workgroups that are 

displayed in the box, make an appropriate selection from the Site drop-down menu. If 

you are not certain which site the person belongs to, select All Sites. 

b. In the left pane, navigate through the tree structure. Click the plus icon (+) beside the 
name of any tenant or workgroup to display its contents. Use the scroll bars as 

necessary to see more information. 

c. When you find the name of a person you want to forward this email to, select it from 
the list. 

d. Click the To, Cc, or Bcc button to move the name of the selected person to the 

appropriate box. 

e. Click OK. 

The email address of the person you selected is added to the appropriate fields of the 

email you are composing. 

5. Repeat the procedure if you want others to receive this forwarded email. 

6. If you want to forward this email to anyone who is not in the UAD, type their address in the 

appropriate field. 

7. Click Send when you are ready to forward this email to all the included addresses. 

8. Do any other required action to resolve the customer’s problem, such as the following: 

a. Reply to the customer’s email (see Composing a normal email reply on page 82) 
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b. Request additional information from the customer (see Requesting more information 

from a customer on page 106) 

c. Request information in an email to an external agent (see Sending an email to an 

external agent on page 96) 

9. Click Wrap to wrap up this email contact. 
 
 
 
 

Forwarding an original email 

You may occasionally want to use Avaya Agent to forward a copy of an email that you received 

to another email address without any modifications. For example, you may want to forward 

email to another email address that Interaction Center polls. 

Note: 
The email that you forward using the Forward original email option is not 

tracked in Interaction Center and also the contact history for this email does not 
show that email is forwarded. 

To forward an original email: 

1. With the email displayed in the Email Preview window, click Forward original email. 

The Forward Original dialog box opens. 

2. Enter the recipient email address in the To email address field. 

3. Write comments to the recipient of this forwarded email in the Please enter comment 

field. You may want to explain why you are forwarding the email and give any other 

relevant information. 

4. Click Send when you are ready to forward this email to the included recipient. 

5. Click Ok on the dialog box that opens for successful forwarding of an email. 

6. Click Wrap to wrap up this email contact. 
 
 
 
 

Forwarding an email with inline images 

When an agent receives an incoming email with inline images in the email body, the Web Agent 

interface displays those inline images as attachments. So, when an email contains attachments 

and inline images in the email body, the Web Agent displays the inline images as attachments in 

addition to the existing attachments. When the agent forwards such emails, the Web Agent also 

forwards the inline images in the email body as attachments. 
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With this, the agent is unable to differentiate between the actual attachments in an email and 

attachments of inline images in the email body. Also, the attachments list grows if the email 

body contains many images. 

You can overcome this problem by setting the email.preview.InlineAsAttachment 

parameter to false. 

After you set the email.preview.InlineAsAttachment parameter to false, the Web 

Agent: 

● Displays the inline images in the email body and not as attachments. 

● Sends only the actual attachments in an email and not the inline images when an agent 

forwards an email. 

● Does not displays the inline images in the attachments list when an agent searches the 
customer history and selects an email with inline images. 

● Displays the inline images as attachments when an agent changes the email preferences 

to view an email in plan format. Web Agent also displays the warning message about the 

formatting loss and displays the email in a plain text format. 

If an agent changes the email preference to view the email in the Plain text format, all the inline 

images in an email are added in the attachment list. If the agent changes the email view back to 

the html text format, Web Agent does not display the inline images in the email editor and the 

attachment list displays only the actual attachment in there are any. 

Note: 
If an agent forwards an email for which the preference is set to plain format, Web 

Agent sends the inline images as a part of email body and not as attachments 

To disable viewing inline images as attachment: 

1. On the system where you installed the Avaya Agent, go to the IC_INSTALL_DIR\IC73\ 

webagent directory. 

2. From the directory, open the Application.properties file. 

3. Add the following parameter with the value set to false. 

email.preview.InlineAsAttachment = false 

4. Save and close the file. 
 
 
 
 

Checking spellings in your emails 

The Spell Checker helps you find and correct spelling errors in your email. 

You can set the following preferences related to the spell checking in emails: 
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● A preference that displays the Spell Checker automatically whenever you press the Send 

button. Setting this preference ensures that each email is spell checked before sending it 

to a customer. If you do not set this preference, you have ensure that you must run the 

spell checker before sending an email. 

● A preference that let the spell checker check the contents of your reply and also the 

contents of the original email to which you are replying. If you do not set this preference, 

only the contents of your reply are checked for spelling. 

Note: 
If you set the preference to check only your reply and not the original message, 

you should be careful when you use the Change All feature. The Change All 

feature may not change all occurrences of the word, possibly leaving misspelled 

words, if you do either of the following things: 

● If you clicked the Ignore button when the Spell Checker found this misspelled 

word in previous text of this email, then it will continue to ignore the misspelled 

words. 

● If you cancel the spell check before it has finished checking the entire message, 

the misspelled word might occur in text that was not checked. 

For information on how to set preferences, see Setting Preferences on page 163. 

To check the spellings in an email: 

1. On the Compose tab, click the perform a spellcheck button on the Email toolbar. 

The Spell Checker is displayed. 

  Tip: 

The Spell Checker window displays various buttons at the right side. Each button 

represents an action related to spell checking. You can hold a mouse pointer over 

a button to view the tooltip. 

2. If you composed a message in a language other than your primary language, select that 

language from the Available languages drop-down menu. 

Reopening the spell checker changes the dictionary to that language. You can view the list 

of suggested words changed to the selected language. If any word in the email content is 

not available in the currently selected dictionary, that word is displayed in the Not in 

dictionary text field. 

3. If you see a word in the Not in dictionary field, verify the word for correctness. Look at the 

list of words in the Suggestions list to determine the possible replacement for that word. If 

the word in the suggestions list is correct, select the word and click the Change button. 

  Tip: 

If a word is displayed in the Not in dictionary field, it is not included in the 

currently selected dictionary. However, it may be spelled correctly. For example, 

names of people and products are not in the dictionary. If you think that you may 

use a name again, click the Add button to add it to your dictionary. 
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4. If a misspelled word appears several times in your message, you can use the Change All 

button to correct every occurrence of the word. 

 
CAUTION: 

Be careful using the Change All button. Some occurrences of the word you are 

searching for may be incorrect in one place but correct in another. Or the word 

you are searching for may be part of another word. When you click the Change 

All button, you must also be certain that the correct spelling is in the Change to 

field. 

5. You may decide that you do not want the Spell Checker to check certain types of words. 
Click the Options button to open the Spelling preferences dialog box in which you can 

select items for the Spell Checker to ignore. 

6. When you are finished checking the message, click Cancel. 
 
 
 
 

Requesting more information from a customer 

Occasionally a customer may send you an email with incomplete information. For example, the 

customer wanted to place an order but forgot to include a ZIP code in the shipping address. In 

this case, you send a special type of email asking for the missing information. 

To request additional information: 

1. Display the email from the customer in Email Preview mode. 

2. Click the Reply button or select Contact > Reply. 

The window changes to Compose mode. The drop-down menu under the toolbar indicates 

that this is a Normal Reply. You must change this, as indicated in the next step, if you 

decide that more information is needed from the customer. 

3. Select Request Additional Info from the drop-down menu. 

The Information Bar states, This email will be sent to customer to request more 

information. 

4. Put your cursor at the top left of the Email Composition Area and compose an email to the 

customer. Explain that you need more information to help them or fulfill their request. Tell 

them exactly what information is missing. 

5. When your email reply is finished, read it to verify that everything is correct. 

6. Click Send. 
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Note: 
If the customer does not reply within the time limit set by administrators, you or 

another agent will receive an email alert, an automatically generated email 

notifying you that the customer has not replied. If you receive an alert, see 

Responding to an email alert on page 107. 

7. Click the Wrap button to wrap up the email contact. 
 

 

Handling a customer reply to a request for the additional 

information 

If you or another agent sent a Request Additional Info email to a customer, you may receive 

the customer’s reply. 

To handle a reply to a request Additional Information email: 

1. In Avaya Agent, select the reply in the email task list. 

A special icon in the email task list identifies this as a reply to a request for additional 

information. 

The Web Agent window opens in the Email Preview mode to show you this email and 

information about it. The Information Bar informs you that this is a customer reply to a 

request for information. 

2. Use the scroll bar, if necessary, to see the original message requesting information. Then 
read the reply from the customer. 

3. If the information is still not complete, reply to this message as another request for 
information, as indicated in Requesting more information from a customer on page 106. 

4. If the information is complete, click Reply to compose a reply to the customer. Thank the 

customer for the information. Include any other message to the customer as appropriate. 

5. Click Send to send your request or your reply. 

6. Click the Wrap button to wrap up the email contact. 
 
 
 
 

Responding to an email alert 

Occasionally you may receive an email alert. The purpose of this type of email is to notify you 

that a response from a customer or external agent to a previous email is overdue. email alerts 

are generated automatically by the Avaya IC software. 

Note: 
Email alerts are system generated emails and are formatted in plain text. 
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A special icon in the email task list indicates that this is an email alert. The Information Bar in the 

Web Agent also informs you that this is an email alert. 

The original email related to an email alert may be either of these: 

● Request Additional Info - An email was sent to the customer requesting more 

information, and the customer did not respond within the time limit for this type of email. 

● Send to External Agent - An email was sent to an external agent requesting information, 

and the external agent did not respond within the time limit for this type of email. 

In some cases, you are the agent who sent the original email that requested a response. In 
other cases, another agent sent the email. 

When you receive an email alert, you must take action to try to get a response. 

To respond to an email alert: 

1. Double-click the email alert contact in your email task list. 

The Web Agent is displayed in the Email Preview mode. The Information Bar states, "This 

is an email alert. The recipient of a request for information has not responded to a 

request." 

2. Read the email to see what additional information was needed from the customer or the 
external agent. 

  Tip: 

If you did not send the email requesting information from the customer or external 

agent, you may want to click the Email History button to learn more about this 

email or previous emails from this customer. 

3. If the original email related to this alert was a Request Additional Info email, you should 
try again to get a response from the customer. You have the following choices: 

● Send the customer another request for information. If the customer fails to reply within 

the set amount of time, another email alert will be generated. While viewing the email 

alert in Email Preview mode, click the Reply button or select Contact > Reply. Select 

Request Additional Info from the drop-down menu. Write a message to remind the 

customer about the required information. Send the email and wrap the contact. 

OR 

● Send the customer a normal reply. This will not generate another alert. While viewing 

the email alert in Email Preview mode, click the Reply button or select Contact > 

Reply. Leave Normal Reply selected in the drop-down menu. Write a message to 

remind the customer about the required information. Send the email and wrap the 

contact. 

4. If the original email related to the email alert was sent using the Send to External Agent 

selection, you should try again to get a response from an external agent. You have the 

following choices: 

● Send the email to another external agent or the same external agent. 
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a. While viewing the email alert in Email Preview mode, find the text of the original 

email that was sent to an external agent, scrolling down as necessary. Select that 

text. Then click Control+C to copy the text. 

b. Begin a new email by selecting Tools > Compose new email. 

c. Click on the button in the To field and select an external agent. If you need 

information about finding an external agent, see Sending an email to an external 

agent on page 96. 

  Tip: 

Select a different external agent than the one to whom the original email was 

sent. 

a. Press Control+V to paste the copied text from the email alert into the new email. 

b. Write an additional message if necessary to explain further what information is 

needed. 

c. Click the Send button. 

Your reply is sent to the selected external agent. 

d. Click the Wrap button to wrap up the email alert contact. 
 
 
 
 

Resolving an email 

You can resolve a message without writing an email response. When you resolve an email, you 

apply a status to it. The status tells the email management software how to handle this type of 

email. For example, the software may reply to the customer’s message automatically, using an 

email template. An email template is a complete email response that can be used to reply 

automatically to customer emails that are alike in some way. 

For example, your company may set up a Dismiss status. You are to apply this status when all 
of a customer’s problems have been resolved and the customer writes an email to thank you for 

your help. When you apply the Dismiss status, a copy of an email template is sent to the 

customer. The text of the email thanks the customer for contacting your company and invites 

them to contact the company again. 

Your company has defined the list of statuses and the responses that are carried out for each 

status. The statuses and responses may include the following: 

● A customer sends an email praising the service or product they received. You apply an 

Acknowledge status. A copy of an email template is sent to the customer to thank them for 

their email. 
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● A person sends an email to your company’s email Support address, but the person is not 

listed as a customer. You apply a Rejection status. A copy of an email template is sent to 

tell the customer that they cannot receive support to help them solve their problem until 

they purchase a product. 

● A customer sends a frequently asked question (FAQ) about cameras, for example. You 

apply a Camera status. A copy of an email template is sent to describe the cameras that 

they may buy. 

You may need to ask your administrator or supervisor what types of messages you should 
resolve and what statuses you should apply to them. 

To resolve an email: 

1. Become familiar with the email statuses that are available to you before you need to use 

them. Ask your administrator for information, or click the Resolve button in the Email 

Preview mode and read the description of each status. 

2. When you receive an email contact that you need to resolve because it fits one of the 

statuses, display the email in the Email Preview mode. 

3. Click Resolve. 

A dialog box is displayed asking you to select a status to apply to this message. 

4. If the email is in a language that is not the primary language used at your company, select 
the language from the Filter by language drop-down menu. 

5. Read the description of each status. 

6. If an email template is displayed in the scroll box at the bottom of the dialog box, read the 

message for each status to determine if it is an appropriate response to this email. 
 

  Tip: 

You may see strings of characters within the messages that you do not 

understand. These character strings may be variables, that is, character strings 

that stand for information that changes automatically when the template is used. 

For example, the %date% character string may be a date variable that will 

change to the current date and %customername% may change to the current 

customer’s name whenever you use this resource. 

7. Select the status that is appropriate for this email, and click Resolve. 

The email management software carries out the action that is associated with this status. 

The dialog box closes and the email contact is removed from your email task list. 
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Originating an outbound email 

You may occasionally want to originate an email, that is, to send an email that is not a reply to 

an incoming customer email. Usually, you originate an outbound email when you want to send 

an email to an external agent to ask for information. The UAD helps you address an original 

outbound email to an external agent. 

To originate an outbound email: 

1. If the Web Agent is not currently displayed, click the Web Agent button in the task bar. 

2. In the Web Agent, select Tools > Compose Email. 

The window is displayed in the Compose mode. 

The Information Bar informs you that this is a new outbound email. 

3. If you want to address this email to an external agent, click the button beside the field you 

want to use, as follows: 

● To – The main person or persons to whom you want to address this message directly. 

● Cc (Copy) – Anyone that you want to receive a copy of this email. 

● Bcc (Blind Copy) – Anyone that you want to receive a copy of this email, without 
anyone else seeing their address. 

The UAD opens in Email Addressing mode. In this mode, the UAD displays only external 

agents. 

4. If you are looking for an external agent who does not belong to the tenant or workgroups 

that are displayed, make an appropriate selection from the Site drop-down menu. If you 

are not certain which tenant or workgroup the person belongs to, select All Sites. 

5. Navigate through the tree structure. Click the plus icon (+) beside the name of any tenant 
or workgroup to display its contents. Use the scroll bars as necessary to see more 

information. 

6. When you find the name of the external agent that you want to address this email to, select 

it from the list. 

a. Click the To, Cc, or Bcc button to move the name to the appropriate box. 
 

  Tip: 

If you know an email address of someone else to whom you want to address this 

email, type the address in the appropriate address field. 

b. Click Ok. 

The email address of the external agent is added to the appropriate field of the email 

you are composing. 

If you need to delete the name of a person that you selected, click the name and press 
the Delete key on your keyboard. 
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7. Repeat as desired to add other email addresses. 

8. Web Agent automatically uses the default message format in your email preferences. To 

change this default format, from the Format drop-down list, select one of the following 

options: 

● HTML 

● Plain Text 

If you select HTML, the resource can include the same text formats, images, and other 

content that is available for HTML email. For more information, see Formatting HTML 

text on page 86. 

9. Put your cursor in the Email Composition area and type your message. 

10. Use the Add Attachment or Spell Check buttons as desired. 

11. When you are ready to send your message, click Send. 

12. If a dialog box asks you for the information, specify the language encoding to be used and 

the queue to be used. The queue you select will be used in the From address of the email. 

Therefore, replies to this email will be routed to the same queue. 

  Tip: 

You can set preferences for the system to select the default queue or default 

language automatically. Then the dialog box will not be displayed whenever you 

send an original outbound email. 

13. If a dialog box asks for confirmation, click OK. 

Your email is sent to the recipients. 

 
 

 

Approving or rejecting an email 

The email replies that you and other agents send, or a certain percentage of them, may be sent 
to an approver for Quality Assurance before the emails are sent to customers. You may be a 

designated approver, even if you are not a supervisor. This section assumes that you are a 

designated Approver. 

When you receive an email that needs Quality Assurance, the email task list displays a Quality 
Assurance icon. You should give high priority to an email needing Quality Assurance because 

the customer is waiting for a reply and the approval process may take time. 

When you click an email contact that has been sent to you for Quality Assurance, the 

Information bar also alerts you to the fact that the email was sent to you for your approval or 

rejection. 
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Important: 

Before you wrap the email work item, you must either approve or reject an email 

that you received for Quality Assurance. 

The email work item that you warp without approving or rejecting does not reach to the 

customer email address. Also, you cannot recover that email work item. 

To handle an email sent to you for quality assurance: 

1. Double-click the email contact in your email task list. 

Notice that the Information Bar informs you that this message needs Quality Assurance. 

2. Look at the customer’s message at the bottom of the email. 

3. Click the Quality Assurance button. 

The email is displayed as a reply to the customer in Quality Assurance mode. Depending 

on the way the Quality Assurance feature was set up by your administrator, the reply you 

compose to the customer here may be sent for approval again or it may be sent directly to 

the customer. 

4. Carefully read the agent’s reply to the customer’s email. Read any attachments as well. 

Look for the following things: 

● Did the agent respond appropriately to all of the customer’s questions and problems? 

● Did the agent use polite language? 

● Did the agent use reasonably correct grammar and spelling? 

● Did the agent include company promotional information, if applicable? 

● Did the agent use the appropriate format for the message? For example, do you need 

to change the format from Plain Text to HTML? 

● If the email used any resources, are they entirely appropriate? 

● If the email has attachments, are they appropriate? 

5. If your answer to all of the previous questions is yes and you do not see any other 

problems with the email, do the following: 

a. Select Approve from the drop-down menu. 

b. Click Send. 

The email is sent directly to the customer. 

6. If you see problems with the email, do the following: 

a. Select Reject from the drop-down menu. 

The Information bar changes to indicate that you rejected the agent’s message. 

! 
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b. Write a message explaining to the agent exactly what they need to do to make the 

email reply acceptable. 

You may want to ask your administrator whether the agent who receives this rejected 

email is always the agent who wrote the reply. In some cases, the administrator has 

set up the software so that an Approver’s comments and a copy of the original email 

reply are sent to any available agent. 

c. Click Send. 

A confirmation dialog box is displayed. 

d. Click Yes. 

This message is sent to the agent for correction. When the agent corrects the message 

and sends it again, the reply may be sent directly to the customer or it may be routed to 

you or another Approver, depending on the setup at your contact center. 
 
 
 
 

Handling a rejected email 

Some or all of the emails you and other agents write to customers may be sent for approval 

(also known as Quality Assurance) to another agent or a supervisor who is designated as an 

email approver. The designated person reads each email that is sent for approval and takes one 

of the following actions: 

● Approves the email and sends it to the customer. 

● Makes corrections to the email, marks it as Approved, and sends the corrected email to 

the customer. 

● Marks the email as Rejected, along with a message explaining what needs to be done to 

make the message acceptable and sends the email for correction. It may be routed back to 

the original agent who wrote the rejected email or to any agent, depending on the setup at 

your contact center. 

● Changes the format of the email message. For example, an approver can change the 

message format from Plain Text to HTML. 

If you receive a rejected email in your email task list, the email icon contains an X to indicate 

that it is a rejected email. You should usually select this contact before other email contacts in 

the list because the customer is still waiting for a reply. 

To edit a rejected email: 

1. Double-click the rejected email contact in the email task list. 

The Web Agent window displays the rejected email in Email Preview mode. The 

Information Bar identifies this as a rejected message. 

2. Read the message carefully, noting the comments that the approver put in the email. Note 

what changes are required to make the email to the customer acceptable. 
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3. Click the Reply button or select Contact > Reply. 

At this time, this email becomes a normal reply. 

4. Edit the email according to the changes suggested by the approver. 

5. When you are finished, reread the message from the Approver and check that you made 

all the desired changes. 

6. Remove the message from the Approver and the original reply that was rejected. 

 
CAUTION: 

The previous step is crucial. You must remove everything from this reply except 

the new message to the customer. 

7. Read the entire message to check it again. Make any necessary changes. 

8. When you are ready to send the message, click Send. 

Depending on the setup at your contact center, the message is either sent back to an 
Approver or sent to the customer. 

 
 
 
 

Using multiple languages with an email 

You may receive emails in a language that is not your primary language. If you know the 

language well, you may reply in that language. Check with your administrator if the language is 

not displayed properly. 

You can also spell check your reply in that language. Click the Perform a spellcheck button to 

open the Spell Checker and select the appropriate language from the Available languages 

drop-down menu. 
 
 
 
 

Monitoring an email session (Supervisors Only) 

To monitor the email session of an agent, you must start the agent interface in the Supervisory 

mode. Supervisor can only view the emails of an agent but cannot perform any other operations 

on the emails. 

Note: 
To monitor an agent task, an agent with supervisor role must be designated as 

the supervisor of the first agent's workgroup. 
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From IC 7.3.5 onwards, an administrator can assign multiple supervisors to a single workgroup. 

Therefore, supervisors can monitor a number of agents within the assigned workgroups. 

Multiple supervisors can monitor a single agent at a time. A single supervisor can actively 

monitor only one email task at a time. 

To start monitoring an email session: 

1. On the Avaya Agent main toolbar, select Switch to Supervisor mode. 

The system displays a Supervisor pane besides the interaction list panel. In this pane, 

Supervisor can view the workgroup and agents that are currently logged in to the email 

session. 

2. Expand the workgroup node. 

3. Expand the agent node whose emails you want to monitor to see what emails that agent is 

currently engaged in. 

To end monitoring an email session do one of the following: 

1. If you want to switch to another mode and end the session, select one of the following 

modes on the Avaya Agent main toolbar: 

● Switch to Chat & Phone mode 

● Switch to Email mode 

● Switch to Chat mode 

The system ends the supervisory mode for monitoring. Supervisor can start the work in an 

agent mode. 

2. If you do not want to switch to another mode or end the session, click the Supervisor 
Mode button or click an icon at the root level in the Monitoring panel. 

 
 
 
 

Wrapping up an email contact 

When you have sent a normal email reply to a customer, you may need to wrap it up. In some 

contact centers, email is wrapped up automatically whenever an agent sends a reply to the 

customer. Ask your administrator if your emails are wrapped up automatically. If the answer is 

yes, you do not need to read this section. 

You can select Email Preferences to wrap up email responses automatically after you send 

them. For more information, see Setting Preferences on page 163. 

When you click the Wrap button, you are in WrapUp state. While in this state, you cannot 
receive another email contact to replace this one. You may need to perform the following tasks: 

● Enter information about the session in a Wrap-up dialog box. 

● Follow a WrapUp script in Prompter. 
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Note: 
In certain cases, you may not see a Wrap-up dialog box for any of the following 

reasons: 

● The email contact was removed because you did not respond in the allotted 

amount of time. 

● Your supervisor removed the email contact to put it back in a queue. 

● The email contact was cancelled in the server. 

● The email contact was wrapped automatically because a preference to wrap up 
this type of email automatically is selected in Email Preferences. For information 

about the wrap-up preferences, see Setting Preferences on page 163. 

To wrap up an email contact: 

1. After you send an email, click the Wrap button in the email toolbar. 

2. If a dialog box asks if you want to confirm, click Yes. 
 

  Tip: 

You can set a preference to control whether this dialog box is displayed whenever 

you wrap up an email contact. See Setting Preferences on page 163. 
 

3. If you see a Wrap-up dialog box or a Prompter script, fill in the questions about this email 

contact. For information about the dialog box or script, see Wrapping up contacts on 

page 61. 

The email contact is completed. It is removed from your email task list. 

mailto:infodev@avaya.com


July 2021 118 Agent User Guide 

Comments on this document? infodev@avaya.com 

 

 

Chapter 6: Managing chat contacts 

 

If your account is enabled for Web Management, you use the Web Agent to chat with 

customers, where you exchange real-time typed messages with customers. 

Customers visiting your company website who have a question or want help can click a button 

to request a chat session (or a chat session with a phone call or VoIP call). A request for a chat 

session becomes a chat contact. Avaya Interaction Center (Avaya IC) routes the chat contacts 

to agents who are available to handle chat. You can view the chat contacts in your chat task list. 

This chapter explains how to receive and manage your chat contacts and the related 

collaboration features. Collectively, these features are referred to as Web Management. 

The chapter contains the following topics: 

● Being Alerted to a New Chat Contact on page 119 

● Using the Chat task list on page 119 

● Understanding the tabbed pane on page 120 

● Popping out your chat task to a separate window on page 121 

● Identifying the customer chat client on page 122 

● Handling a Basic Chat Session on page 122 

● Using emoticons on page 124 

● Sharing browsers with a customer on page 125 

● Understanding notifications on page 131 

● Using resources in a chat session on page 132 

● Spell Checking Your Messages on page 134 

● Using the Phone in a Chat Session on page 135 

● Involving other agents in a chat contact on page 139 

● Involving Other Agents in a Voice Chat on page 145 

● Handling a JoinUs Conference on page 147 

● Handling Simultaneous Chat Sessions on page 149 

● Monitoring a Chat Session (Supervisors Only) on page 150 

● Viewing Customer DataWake Records on page 152 

● Using Multiple Languages in Chat Sessions on page 153 

● Managing Web Scheduled Callback Contacts on page 153 
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Being Alerted to a New Chat Contact 

When a customer sends a chat request by clicking the Chat button on the company website, a 

chat contact is created in your chat task list. Chat contacts may be routed to you whenever you 

are available for chat. 

With chat, it is particularly important to respond quickly. Depending on how the Avaya IC 

software has been set up at your contact center, you may be alerted to a new chat contact in 

two ways: 

● By a sound. A Contact preference lets you determine whether you are alerted with a 
sound. For information, see Setting Preferences on page 163. 

● By a screen pop. This is a dialog box that asks if you want to suspend your other contacts 

to begin handling the new chat contact. The "Wait for confirmation before accepting a 

contact" preference lets you determine whether screen pops are displayed when new 

contacts arrive. For information, see Setting Preferences on page 163. 

Note: 
When a screen pop informs you that a new chat contact has arrived, clicking OK 

or pressing the Enter key begins the chat session with the customer. Be careful 

not to click OK or Enter accidentally when a screen pop appears. Ensure that you 

do not do this, you can turn off the Wait for agent confirmation before 

accepting a contact preference. 

If you are alerted to a chat contact but do not acknowledge it within a preset amount of time, the 

contact is assigned to another agent and removed from your Chat task list. The amount of time 

is set by the administrator of the WebACD Server configuration. 

From Release 7.3.5 of Avaya Interaction Center, you are also alerted when a chat contact 

replies to your chat. You are alerted with audio and visual notifications. An alert also notifies you 

when you exceed the service level agreement (SLA) levels defined for responding to a 

customer’s messages. For more information about notifications, see Understanding 

notifications on page 131, Visual notification on page 131, and Audio notification on page 132. 
 
 
 
 

Using the Chat task list 

The Chat task list displays all the chats that are currently assigned to you. Your Chat task list is 
located near the bottom of your Media pane. 

To view the Chat tasks clearly, you can resize or change the location of the Chat task list 

columns. These changes persist in the Avaya Agent Rich client. So, if you log off and log in 

again to Avaya Agent Rich Client, you can view the Chat task list columns resized or relocated. 
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Each entry in your Chat task list relates to a different chat contact. If you have more than one 

chat contact in the Chat task list, you can click each contact in turn to display its customer’s 

question. 

From Release 7.3.5, Avaya Interaction Center displays chat tasks on a tabbed pane. You can 

also pop out a tab with a chat task to a separate window. For more information about the 

multi-tab chat pane, see Understanding the tabbed pane on page 120. For more information 

about popping a chat task out to a separate tab, see Popping out your chat task to a separate 

window on page 121. 

For each chat contact, the Chat task list displays the following information: 

● Customer’s question – The text the customer typed when requesting a chat. The question 

is displayed only when you select the chat contact. The question is also displayed in the 

Web Agent when you double-click to make this the active contact. 

● Name – The user name to log into the website. Users can also log in as guest. 

● Duration – The amount of time you were in chat session with the customer. This time runs 
continuously until you complete the contact. 

● Waiting – The time lapsed since customer responded to you or requested a chat and not 
received any response from you. 

Each chat contact has a customer icon. The color of the customer icon changes as the status of 
the chat contact changes. The colors and other symbols indicate status as follows: 

● Red – It is your turn to respond. The customer has waited longer than the maximum 

desirable time set up by your administrator. 

● Yellow – It is your turn to respond. The customer responded recently. The customer has 

not yet waited longer than the maximum desirable time. 

● Green – It is the customer’s turn to respond. You sent the most recent chat message. 

● Blue with an arrow symbol – This contact was transferred to you. 

● Exclamation mark or something else if the icon was customized – It is the customer’s turn 

to respond. The customer has not responded for a while. 

Icons are also used for chat contacts in which a customer requested a phone call (Chat & 

Phone) or a VoIP call (Chat & VoIP). These icons are the same as the icons for those features in 

the Web Agent. 
 
 
 
 

Understanding the tabbed pane 

From Release 7.3.5, Web Agent displays all the chat tasks you activated on a tabbed pane. If 
you have not activated any chat task, the system displays the tab with an inactive empty chat 

task. 
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The system creates a chat tab when you double-click a chat task on the QUI’s chat task list to 

activate the task. If you select a chat task that is already activated, the tab with the task is also 

selected. In the same way, if you select a particular chat tab from the tabbed pane, the chat task 

on the QUI’s chat task list is also selected. 

When you are on the chat tab, you can manage a chat contact either with the toolbar on the 

Web Agent window or using the Contact menu. 

You cannot close the chat tab, unless the chat task is complete. When the chat is active, the 

chat tab does not have a close button. 

When the chat task is complete, a white cross (X) button is displayed. When you hover your 

mouse pointer over this cross button, Web Agent displays the tooltip, Chat form: 

CustomerName. You can click this button to close the chat tab after the chat task is complete. 

You can use resources on the selected tab the same way you add them in a chat session or 

drag and drop the resources. 

If a customer sends message to the chat when the chat tab is not selected, the system alerts 

you with various techniques. The tab flashes to indicate that the customer has messaged you. 

If you do not select the tab during the flashing, the tab changes color and remain the color until 

you select the tab. If a number of tabs are opened, and a scroll button is available scroll through 

the tabs, the system highlights the scroll button to indicate that you have received a message. 

Your administrator can customize the number of times the tab flashes. The default value is 

three. The administrator can also set the rate at which the tab flashes. 
 
 
 
 

Popping out your chat task to a separate window 

You can pop out a tab with a chat task to another window. Press Control+Shift+W to pop out to 

a separate window. 

You can also customize the size of the popped out window by dragging its borders. Minimizing 
and maximizing the window is also possible. 

The popped out window has a toolbar with which you can manage your chat contacts. However, 

you cannot use the Contact menu. 

If you select a particular chat tab from the tabbed pane, the chat task on the QUI’s chat task list 
is also selected. 

If you receive a chat message in the popped out window when the window is inactive, the Web 
Agent icon on the Windows taskbar flashes thrice to indicate that you have received a message. 

You can also pop the chat task back in to the tabbed pane. Press Control+Shift+P or click the 

Pop In icon to pop back in to the tabbed pane. 

You cannot close the popped out window until the chat task is complete. However, your 

administrator can customize the close operation. The options are: 
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● 1: The default option. 

● 2: Pop in the window back to the tabbed pane. 

● 3: Close the popped out window, but keep the task in the chat list. This operation ensures 

that your chat session is intact, even though the popped out window is closed. 
 
 
 
 

Identifying the customer chat client 

Avaya IC includes HTML chat client that a website customer can use when they chat with an 
agent. A welcome message appears in the transcript of your HTML chat client. 

The HTML chat client supports the following features: 

● Text chat 

● Push URL 

● Join Us 

● Shared browsing or Collaborative form filling 

● Voice chat 
 
 
 
 

Handling a Basic Chat Session 

This section presents the basic procedures to be used with a customer in a chat session. Before 

you go through the procedure, it is important for you to understand a chat session from the 

customer’s point of view. 

When customers visit the supported Avaya Interaction Center (Avaya IC) website, they can click 
buttons to ask for different types of help. The customer can type chat messages to you in the 

chat client. 

As the request is routed, a message displayed in the chat client informs them that an agent will 

be with them shortly. If the request is routed to you, you see the chat contact in your Chat task 

list. As soon as you double-click the contact, the customer sees a message in the chat client 

that you have arrived to help them. 

You should begin the chat session as instructed by your contact center administrators. For 

example, you may type "Hello" and introduce yourself. 

The chat window displays the typing status at the bottom of the window. The customer can view 
the typing status of an agent and the agent can view the typing status of the customer. 
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To interact with a customer using chat: 

1. In the Avaya Agent status bar, see the Chat button. 

If the button displays a yellow X, click the Chat button to make yourself available for the 

chat. When the Chat button does not display a yellow X, you are available to receive the 

number of chat contacts that is set for you in your channel load. For more information, see 

Setting your channel loads on page 46. 

Your channel load for chat is also displayed in the Chat icon in the Status bar at the bottom 

of the Web Agent. 

2. In the Chat task list, double-click the contact you want to accept for a chat session. Usually 

this customer, whose name is appearing at the top in the list, is waiting in a queue for long 

time. 

3. Read the customer’s question in the scroll box above the Transcript area. If you cannot 

see the customer’s entire question, use the scroll bar. 

4. Consider whether any of the Global Resources or Agent Resources are appropriate to 
send to the customer. 

For information on viewing resources, see Organizing Your Resources on page 163. For 
information on adding resources to a chat, see Using resources in a chat session on 

page 132. 

5. Put your cursor in the Text Entry area and type a message in response to your customer’s 

question. 

6. When your message is ready, click the Say button or press the Enter key, depending on 

the configuration of Avaya IC. 

Note: 
If the Spell check text before a "Say" preference is selected, your message is 

spell-checked after you click the Say button. If this option is not selected, you can 

click the Spell Check button at any time to check a message. For information on 

this preference, see Setting Preferences on page 163. For more information on 

the Spell Checker, see Spell Checking Your Messages on page 134. 

Your customer sees the message you just sent in their chat client. In the Web Agent, your 

message moves to the Transcript area. The message begins with your preferred name 

followed by a colon. 

When your customer replies, you see their message under yours in the Transcript area, 

preceded by the customer’s user name. 

7. Continue your conversation with the customer. Read the customer’s messages. Then type 

and send your responses. 

8. Use any of the following buttons to access other features while you are in the chat session: 

● Print – Prints the currently displayed chat messages to the default printer. 
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● Auto Sync – Starts an Auto Sync session so your customer’s browser displays the 

same webpages as your browser while you navigate through webpages. See Using 

Auto Sync on page 127 for more information. 

● JoinUs – Starts a JoinUs session in which friends of your customer can join the chat 

session. See Handling a JoinUs Conference on page 147 for more information. 

● Transfer – Displays the Unified Agent Directory (UAD) so you can transfer this chat 

contact to another agent or supervisor. For information, see Involving other agents in a 

chat contact on page 139. 

● Chat & Phone – Lets you talk to the customer on a regular telephone connection while 

still in the chat session. See Handling a Chat & Phone Session on page 136. 

● Chat & VoIP – Lets you talk to the customer on a telephone-Internet connection while 
still in the chat session. See Handling a Chat & VoIP Session on page 137. 

9. When your customer is satisfied, wrap up the chat contact. Use the instructions in 

Wrapping Up a Chat Contact on page 155. 
 
 
 
 

Using emoticons 

Emoticons are the iconic representation of the facial expressions, such as smiley, sad, tired, 

and so on. You can use emoticons to alert a responder to the temper of a statement, and can 

improve interpretation of plain text. 

In Interaction Center, you can use the emoticons.properties file to configure emoticons. In 

the properties file, you have to map the image file of an emoticon to a sequence of characters. 
For example, in the properties you can map the smiley emoticon as: \:\)=smiley.gif. 

The emoticons.properties file is located at: IC_INSTALL_DIR\IC73\comp\icm. 

Note: 
You must precede each special character with escape character (\). For 

example, consider the character sequence x\-\). In this example the dash [-] 

and the closing angle bracket [)] are preceded with \. 

When you are in chat session with your customer, you can enter the configured sequence of 
characters in the message area of chat application and the mapped image is displayed in the 

transcript area of the chat client at customer. 
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The following table lists the default emoticons, character sequence, and the facial expression: 

 

Emoticons Character Sequence Facial Expression 

 

 
?-| Ponder 

 

 
:( or :-< Sad 

 

 
:) or :-) Smile 

 

 
:@ angry 

 

 
:o or :O surprised 

 

 
:| disappointed 

 

 
:U thankyou 

 

 
(^) thumbsup 

 

 
:8 holdon 

 

 
:-D grin 

 

 
x-) Knocked-out 

 

 
8-| Tired 

 

 
;) Wink 

For Avaya Agent, the image files of emoticons are stored in the following folder: 
IC_INSTALL_DIR\IC73\Webagent\images\emoticons. 

 
 
 
 

Sharing browsers with a customer 

Shared Browsing refers to the features that allow you and your chat customer to view the same 
webpages at the same time: 

● Auto Sync – When you click Auto Sync and then navigate through a website, your 
customer’s browser displays the same pages simultaneously. 
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● Push URL – You push a URL to your customer. Your customer sees the page displayed 

within their browser. The customer can push a URL to you as well. 

● Collaborative Form Filling – When you share a webpage with a customer through Push 

URL or Auto Sync, you can help your customer fill out forms, such as registration forms, 

shopping cart pages, and checkout pages. 

Note: 
You can use the Shared Browsing features when multiple agents are in the 

session. The first agent in the chat session is in charge of the Auto Sync session. 
All agents can push pages and collaborate on form filling. 

 

 

Technical Issues with Shared Browsing 

You need to be aware of the technical issues in this section so that you can explain them to your 
customers when necessary. 

Customers Using Netscape 6.0 and Netscape 6.2.1: Chat customers who are using 

Netscape 6.0 through Netscape 6.2.1 cannot share browsers with you. When you try to use 

Auto Sync or Push URL with a customer who is using those particular versions of Netscape, the 

customer receives a message prompting them to install a later version. 

 
Privacy Protection for the Customer 

A customer can follow your browser when you Auto Sync, but the customer cannot lead. 

Therefore, the customer can visit any other page or website, knowing that you are not watching 

them as they navigate. 

 
Shared Browsing on External Web Sites 

Usually when you share browsers with a customer, you and your customer are browsing your 

company’s website or a website that your company supports. But your customer may want to 

show you a product on an external website (also called an off-domain website). Or you may 

want to show your customer a product on an external website to indicate that your company’s 

similar product is better or less expensive. 

However, using Shared Browsing with an external website can sometimes cause problems. A 
page may not be displayed properly on your browser or your customer’s browser. Or the page 

you see may not exactly match the page that your customer sees. You may want to ask your 

supervisor or administrator if there is anything you should know about using Shared Browsing 

on external websites. 
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Using Auto Sync 

With Auto Sync, you and your chat customer can navigate the Web together, that is, you can 
see the same webpages at the same time. You are always in the lead. 

When you click Auto Sync, any action that you perform in your browser is reflected in the 

customer’s browser. For example, if you enter information in a form, your customer sees that 

information. If you follow a link, the customer’s browser follows the same link. 

If a customer wants to send you a page, such as information they entered on a form, they must 

click a Send Message button. 

You can click a button to stop or start the Auto Sync feature at any time. 

To use Auto Sync to share browsers with your customer: 

1. While in a chat session, tell your customer that you are going to lead them as you navigate 

through some webpages. Explain that they will see the same pages in their browser that 

you see in yours. 

2. In the Text entry area of the chat window, type the complete URL. 

The URL must begin with http://, https://, or ftp://. 

For example, the complete URL will be: http://www.avaya.com. However, the 

incomplete URL can be: www.avaya.com. 

3. Click the Push URL button. 

4. Go to a webpage that you want your customer to see. 

5. Click the Auto Sync button. 

The webpage in your browser is pushed to the customer. The Auto Sync button changes 

to show arrows indicating that Auto Sync is turned on. The Transcript area also states that 

Auto Sync was turned on. 

6. Ask your customer if they can see the webpage that you just sent. Chat with your customer 

about the page, as appropriate. 

7. If your customer wants to lead you to a different page, tell them to go to that page and click 
the Send Message button in their chat client. 

The customer can also paste the URL into the chat client and click the Send Message 

button. 

You see the page your customer sends you on your browser. You can also see the URL 

the customer typed in the Transcript area of the Web Agent. 

8. Continue to share webpages with your customer, until you satisfy their request and answer 

all their questions. 
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  Tip: 

In the Transcript area, you can see the URLs of all the pages you and your 

customer have shared. 

9. Click the Auto Sync button again when you want to end the Auto Sync session. 

The button changes to indicate that it is turned off. The Transcript states that Auto Sync 

was turned off. You can easily start another session with this customer whenever you want 

by clicking the Auto Sync button again. 

  Tip: 

If you begin a chat session with another customer before completing your current 

chat session, another browser opens for the second customer if you want to send 
the URL of the website to another customer. 

If you are handling two or more chat contacts simultaneously and you want to send the 

URL of a website to other customers, there is an Internet Explorer icon for each 

customer. 
 

 

Pushing a Web Page 

At any time during a chat session, you can push a webpage to your customer. Your customer’s 

browser opens to that page immediately. 

Use this feature when you want to show your customer some information or to help your 

customer find a page they are looking for. 

  Tip: 

Use Push URL when you want to show your customer a single page. If you want 

to lead your customer to a series of pages, use Auto Sync instead. 
 

  Tip: 

If you send the same URL repeatedly, it is easier to create a URL resource and 

then send the resource any time you want. See Managing Resources on 

page 156 for more information. 

To push a webpage to your customer 

1. Type a complete URL in the Text Entry area. It must begin with http://, https://, or ftp://. 

For example: 

Incomplete URL: www.avaya.com 

Complete URL: http://www.avaya.com 
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2. Click the Push URL button. 

The Transcript area shows that you have pushed a URL to your customer. Your customer 

sees a message in their chat client that a URL was sent to their browser. If you entered the 

URL correctly and the URL is currently working, the customer’s browser opens to the page 

you pushed. 

3. Verify with your customer that the page is displayed in their browser. 

Note: 
Modern browsers like IE8, IE9, and Google Chrome 21 have implemented 

security enhancements including Clickjacking Defense. Clickjacking is when 

hackers try to trick users into clicking buttons that appear to perform safe 

functions, but instead perform unrelated tasks. Clickjackers embed malicious 

code or "redress" the user interface by using transparent frames that overlay 

specific UI elements with misleading text and images. To help prevent 

Clickjacking, website owners can send an HTTP response header named 

X-Frame-Options with HTML pages to restrict how the page may be framed. 
XFrame-Options: Deny. The other option value is: SameOrigin. If the 
X-Frame-Options value contains the token Deny, modern browsers prevent the 

page from rendering if it is contained within a frame. If the value is SAMEORIGIN 

then it will only load the page in a frame if the request came from the same 

domain as the page to be loaded. Modern day browsers will not render the page if 

the top level-browsing-context differs from the origin of the page containing the 

directive. Blocked pages are replaced with a "This content cannot be displayed in 

a frame" error message. If there is any external page or URL being pushed from 

IC Web Agent or AAWC that has one of its HTTP response headers, 

X-frame-Options variable set as any of the above values for example, 

www.google.com, www.facebook.com, it would not be rendered on the end user’s 

system and give an error. 
 

 

Using Collaborative Form Filling 

Any time you are sharing browsers with your customer, you can help the customer fill in 

information on a webpage. This feature is called Collaborative Form Filling. A form can be a 

webpage or any part of a webpage where customers enter information. For example, your 

customer may need help entering information on the following types of forms: 

● Registration form 

● Shopping cart or order page 

● Checkout page 

When you or your customer enters information in a form that you are sharing, you both see that 

information immediately. Thus, you can take turns entering information. The customer must 

submit the information when the form is complete. 
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Note: 
If customer has installed the JDK/JRE on the system from where they escalate a 

chat to an agent and if the chat.htmlclient.collaboration.enabled 

property set to true in the website, a page that agent pushes to the customer 
opens in a new browser window. 

If customer did not install JDK/JRE on the system from where they escalate a chat and 
the chat.htmlclient.collaboration.enabled property is set to true in the 

website, the page that agent pushes to the customers opens in a docked mode at the 
right side of the browser window. 

To help your customer fill a form: 

1. Type the URL in the text field and click Push URL. 

2. Verify that your chat customer wants you to help fill out a form. 

3. Ask if the customer is currently viewing the form. 

4. If the customer is viewing the form, ask them to click the Send Message button. 

The page is displayed on your browser. If the customer has entered any information, you 

see that information. 

5. If the customer is not viewing the form and you know where the form is located, take the 

following steps: 

a. Go to the URL with your browser. Click Auto Sync. 

OR 

b. Type the URL in the Text Entry area. Click Push URL. 

The customer sees the page opens in the browser. 

6. If the customer is not viewing the form and you do not know the URL, ask the customer to 

push the page again. 

7. Take turns with your customer, as needed, to fill out the form. 

Everything you type in the form is displayed immediately in the customer’s browser. 

Everything your customer types is displayed in your browser. 

  Tip: 

Take turns with your customer. If you and your customer type simultaneously, the 

information you enter is garbled. If this happens, ask your customer to push the 

new page again. 

8. Ensure that your customer clicks the appropriate button to submit the form when the form 

is finished. 
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  Tip: 

When your customer clicks the button, the page you are viewing may be different 

from your customer’s page. In this case, ask your customer to click the Send 
Message button again. 

 
 
 
 

Understanding notifications 

While waiting for a customer’s response, you might want to do another task. To help you 

understand when a customer responds to your chat, from Release 7.3.5 of Avaya Interaction 

Center, Web Agent provides audio and visual notification alerts. An alert also notifies you when 

you exceed the service level agreement (SLA) levels defined for responding to a customer’s 

messages. 
 

 

Visual notification 

Visual notification can be of two types: 

● Flashing of the Web Agent icon 

● SLA notification 

 
Flashing Web Agent icon 

While chatting with a customer, if your Web Agent window is minimized, inactive, or you are 

working on another task, the Web Agent icon on the taskbar or the popped out window flashes 

when the customer responds to your chat. 

If the window is already in focus, the icon or the popped out window blinks thrice to indicate that 

the customer has sent you a message. If the window is not in focus or you are working on 

another task, the icon or the popped out window blinks thrice and then solidifies in bright 

orange. 

 
SLA notification 

While chatting with a customer, you must respond to a customer’s messages within a 

predefined SLA time. Your administrator might define up to three different SLA thresholds. 

If you do not respond within the defined SLA threshold, the background and text color of the 
chat item in the chat list changes to predefined colors. 
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For example, your administrator might set the SLA thresholds as 10, 20, and 40 seconds. The 

administrator might also assign blue, yellow, and red respectively for the background, and 

white, green, and yellow for the text of the chat list. In this case, the background color and text 

color changes as per the defined SLA as shown in the following table: 
 

 

Customer’s 

wait time in 

seconds 

Chat item 

background 

color 

Chat item text 

color 

10 Blue White 

20 Yellow Green 

30 Red Yellow 

The default SLA thresholds are 20, 40, and 60 seconds. As soon as you respond to the 

customer's chat, the background and text color of the chat item revert to the default settings. 
 

 

Audio notification 

If your Web Agent window is not in focus or you are doing another task, Web Agent produces a 

sound to indicate that the customer responded to your chat. Your administrator can customize 

the sound that Avaya Agent Rich Client (AARC) plays. 
 
 
 
 

Using resources in a chat session 

Resources are previously prepared text, emails, or URLs that you can send repeatedly to 

different customers by chat or email. Resources save you the time and tedium of typing the 

same things again and again. Text and email resources may contain such things as greetings, 

closings, and answers to frequently asked questions. Email resources may have information 

already entered in the To, Cc, Bcc, and Subject fields, and they may contain attachments. URL 

resources may be links to company websites, such as a page about exchange policies. 

When you are in a chat session with a customer, you can send text and URL resources. 

Although you cannot send an entire email resource from a chat session, you can send the text 

of the email resource. 

When a chat session is active, you see the following folders in the Resource Area of the Web 

Agent: 

● Global Resources: Resources that your administrator or supervisor has prepared for you 
and other agents. These agents see the resources when they login. 
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● Agent Resources: Resources that you create for you own use. These resources are saved 

with your account. Other agents cannot view the resources that you create. 

For information and examples of the resource types (text, email, and URL), and instructions on 

creating resources, see Creating New Agent Resources on page 158. 

To send a text resource while in a chat session 

1. If you want to see all the resources within all folders, click the Expand all folders button 

above the Resource Area. If you want to see only the main folders, click Collapse all 

folders. 

  Tip: 

To expand or collapse the contents of an individual folder, right-click the folder 

and select Expand folder or Collapse folder. 

2. If you want to limit the resources that you see, select the type of resource you want to see 
from the Filter by drop-down menu and select one of the following menu options: 

● Blank – Displays all types of resources for all tenants and all languages.] 

● Tenant – Displays only the resources for a specified tenant, which may be any group 

in an organization, such as a company, location, or workgroup. 

● Language – Displays only the resources for a specified language. 

● Text resources – Displays only text resources. 

● URL resources – Displays only URL resources. 

● Email resources – Displays only email resources. 

3. If you only want to view the contents of a resource, do one of the following things: 

● Select the resource and select the Preview content check box. A box opens, 
displaying the resource contents. 

● Right-click the resource and select View resource. 

4. If you want to send a text resource or the text of an email resource immediately, right-click 
the resource and select Say. 

 

  Tip: 

You can also double-click to send a resource immediately, if Avaya IC is 

configured this way at your contact center. If double-clicking sends a resource to 
the customer, be careful not to double-click before you are ready. 

The text is sent to the customer and is also displayed in the Transcript area, preceded by 

your preferred name within brackets and a colon. For example, if your preferred name is 

JackS and you send the message "Hello" to your customer, the Transcript area displays: 

JackS: Hello. 
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5. If you want a URL resource to open in the customer’s browser, right-click on the resource 

and select Push. 

The webpage at that URL automatically opens in the customer’s browser. The URL is 

displayed in the Transcript area of the Web Agent, preceded by your name. 

  Tip: 

You can also type a URL directly in the Text Entry area and click Push URL to 

have the customer’s browser open to a webpage. 

6. If you want to modify a resource in the Text Entry area or add a message before sending 

the resource to the customer, do the following things: 

a. Right-click the resource and select Insert or Insert quoted. 
 

  Tip: 

By default, Insert Quoted adds an angle bracket (>). This indicates to your 

customer that this text is different from your messages. If you want, you can 
change the character that is used. See Setting Preferences on page 163. 

b. Modify the text and add any new text you want to send your customer in the Text Entry 

area. 

c. When the text in the Text Entry area is as you want it, click Say to send it to your 

customer. 
 
 
 
 

Spell Checking Your Messages 

Spelling errors can make your messages difficult to read and can sometimes lead customers to 

misunderstand what you type. Because you want to type fast, it is difficult not to make many 

spelling errors in a chat session. Therefore, it is a good idea to use the Spell Checker. 

A preference displays the Spell Checker whenever you click the Say button. This allows you to 

check each message before it is sent to the customer. Although it takes time to check every 

message, you can turn on this chat preference and see how it works for you. See Setting 

Preferences on page 163. 

If you prefer, you can check only those messages that you want to check, as described here. 

To check the spelling of a chat message before you send it 

1. Put your cursor in the Text Entry area where you typed a message you want to check. 

2. On the toolbar, click the Perform a spellcheck button. 

The Spell Checker is displayed. 
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  Tip: 

The Spell Checker window displays various buttons at the right side. Each button 

represents an action related to spell checking. You can hold a mouse pointer over 
a button to view the tooltip. 

3. If you wrote a message in a language other than your primary language, select that 

language from the Available languages drop-down menu. 

Reopening the spell checker changes the dictionary to that language. You can view the list 

of suggested words changed to the selected language. If any word in the text is not 

available in the currently selected dictionary, that word is displayed in the Not in 

dictionary text field. 

4. If a word is displayed in the Not in dictionary box, look at the word to determine if you 

think it is spelled correctly. Look at the list of words in the Suggestions box to determine if 

any of those words is the correct spelling of the word. If so, select the word and click the 

Change button. 

  Tip: 

If a word is displayed in this box, it is not included in the currently selected 

dictionary. However, it may be spelled correctly. For example, names of people 

and products are not in the dictionary. If you think that you may use a name again, 

click Add to add the name to your user dictionary. 

5. You can decide at any time that you do not want the Spell Checker to check certain types 
of words. Click the Options button to bring up a dialog box where you can select items for 

the Spell Checker to ignore. 

6. When you are finished checking this message, click Cancel. 
 
 
 
 

Using the Phone in a Chat Session 

While connected to a customer in a chat session, you can also speak to the customer, using 

Voice Chat. You can use two types of Voice Chat: 

● Chat & Phone (also known as Callback) – You and your chat customer speak to each 
other over your telephones or headsets. The customer can request this type of call from 

the website or you can initiate it from the Web Agent. 

● Chat & VoIP – You speak to your chat customer over your telephone or headset. Your 

customer speaks to you over the Internet, using their computer’s microphone and 

speakers. If customer requests a Chat & VoIP from the website, you must initiate your own 

VoIP session using the Chat & VoIP button in Web Agent. 
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The two types of Voice Chat may appear almost the same to you. In both types, you speak to 

your chat customer over your telephone. However, the VoIP call is different for customers 

because they speak to you over their computer’s microphone and speakers, rather than a 

telephone. Customers using a dial-up connection to the Internet may prefer this type of call 

because it makes it possible for them to continue browsing the website as they speak to you. 

In both types of Voice Chat, you speak to your chat customer in real-time, just as with an 

ordinary telephone call. Voice Chat can make your interaction with the chat customer faster and 

more satisfying for both of you than chat alone, in the following ways: 

● Voice Chat is easier for customers who do not type well. 

● Voice Chat is usually faster for both you and your customer because people can speak 

faster than they can type. 

● Voice Chat makes it possible for you and your customer to hear each other’s tone of voice. 

● Voice Chat can combine other chat features with voice. For example, you can speak about 

the webpages as you browse them together with Auto Sync. 

See the following sections for information: 

● Handling a Chat & Phone Session on page 136 

● Handling a Chat & VoIP Session on page 137 

● Involving Other Agents in a Voice Chat on page 145 
 

 

Handling a Chat & Phone Session 

You and your chat customer can speak to each other over the telephone while you remain in the 

chat session together. You can receive a chat contact with a request for this type of session or 

you can suggest it to a chat customer. Read the appropriate procedure, depending on whether 

your customer requested a Chat & Phone session or you want to suggest one to your customer. 

● Responding to a Chat & Phone Request on page 136 

You use the Softphone interface in the Avaya Agent to control the telephone call portion of a 

Chat & Phone session. For information on handling a call with Softphone, see Handling a basic 

voice contact on page 68. 

 
Responding to a Chat & Phone Request 

When a customer requests a Chat & Phone call from the website, the request becomes a chat 

contact. If the contact is assigned to you, it is displayed in your Chat task list with a special icon 

to indicate that it is a Chat & Phone request. After you begin the chat session, you must connect 

the telephone call, as described in the following procedure. 
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To respond to a Chat & Phone request 

1. Double-click the Chat & Phone contact in the Chat task list. 

The Web Agent opens with this contact currently active. The Chat & Phone toolbar is 

displayed, as described in Voice Chat toolbars on page 33. 

If the customer is registered or if the customer entered their telephone number from the 
website, you see their telephone number in the Customer phone number field. 

  Tip: 

You may want to verify with your customer that this is the correct telephone 

number, and then make any necessary changes in the text box. 

2. Type a message to the customer in the Text Entry area and click Say to send the 

message. 

For example, you may say, "Hello, Maria. I see that you want me to call you on the phone. 
I will call you now at the number you entered." 

3. If necessary, put on your headphones. 

4. Click the Add phone request to chat button beside the Customer phone number field. 

You hear noises as the system dials the telephone number. Then you hear the customer’s 

telephone ring. If you need to cancel the call before it is completed, click the Hangup 

button in the Softphone. 

5. When your customer answers the telephone, say "Hello" and introduce yourself as the 

agent who is in a chat session with them. 

6. When you are certain that the customer is satisfied, say good-bye and hang up the 

telephone. 

7. Click the Wrap button in the Web Agent to wrap up the chat contact. 

The chat contact enters WrapUp state. For information on wrapping up contacts, see 

Wrapping up contacts on page 61. 

The voice contact continues until you click the Hangup button in the Softphone. 

8. After you finish speaking to the customer, click the Hangup button. 

9. Click Wrap to wrap up the voice contact. 
 

 

Handling a Chat & VoIP Session 

Many customers who are browsing your company’s website cannot use their telephone while 

they are connected to the Internet. If they have a question, they can click a Chat & VoIP button 

so they can continue browsing the website as they speak to an agent. If you are enabled to 

receive this type of contact, this request may be routed to you and appear in your Chat task list. 

You must initiate the Chat & VoIP feature from the Web Agent. 
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Note: 
Customers must meet certain requirements to be able to engage in a voice chat 

session with you. When a customer requests a VoIP call, the Avaya IC software 

sends a dialog box to the customer. The customer can click the Run Test button 

to determine if their computer meets all the requirements. If the customer’s 

computer is unable use VoIP, the customer receives an error message that 

explains the problem, and Avaya IC offers to submit a regular text chat request for 

that customer. 

After you connect to your chat customer through VoIP, you will speak to the customer over your 

telephone. 

To respond to a VoIP request 

1. Click the Chat & VoIP contact in your Chat task list. 

The Web Agent opens in the VoIP mode and displays the Chat & VoIP toolbar. 

2. Type a message to the customer in the Text Entry area and click Say to send the 

message. 

For example, you may say, "Hello, Maria. This is John at XYZ Tech Support. I see that you 

want me to call you with VoIP. Are you familiar with VoIP calls?" 

3. If the customer is not familiar with this type of call, ask them to ensure that the following 
statements are true: 

● They are using the Windows operating system. 

● They are using one of the following Internet browsers: 

- Internet Explorer 6.x or 7 

● Speakers, microphone, and sound card on their computer exist. The speakers are 

turned on and the microphone is plugged in to the computer. 

● Their audio device is not already in use, such as playing music. 

4. If necessary, put on your headphones. 

5. Look at the Voice channel button in the Avaya Agent. If the button has a yellow X, click the 
button to make yourself available. 

6. Click the Initiate VoIP request button. The customer’s chat client and your Web Agent 

show the status as the connection is made. 

7. When the status message informs you that the connection was made, say "Hello" and ask 

if your customer can hear you. 

  Tip: 

If the connection breaks during the session, you receive a message to help the 

customer troubleshoot the problem. 

8. Your customer with their original question or problem. 
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9. When the customer is satisfied, say good-bye and then click the Hangup button in 

Softphone. 

10. Click the Wrap button in the Web Agent to wrap up the Chat & VoIP contact. 

The chat contact and the VoIP contact are both wrapped up as a single contact. Your 

customer’s chat client informs them that the session is finished. 
 
 
 
 

Involving other agents in a chat contact 

At certain times during a chat session, you may need help answering your customer’s questions 

or you may need to transfer the chat contact to an agent in a different workgroup. At these 

times, you can conference another agent into the chat so that both of you can talk to the 

customer. If you conference in a second agent, you can also leave the chat contact and let the 

second agent finish working with the customer while you go on to other tasks. In effect, this 

transfers the chat contact to the other agent. 

Note: 
Consult transfer is not supported for chat contacts. 

Note: 
For information about adding agents to a Chat & Phone or Chat & VoIP session, 

see Involving Other Agents in a Voice Chat on page 145. 

You can also add multiple agents to the chat by conferencing in each agent individually. Each 

agent can stay in the chat session or leave it whenever they want by completing the contact. 

The chat session remains active until the last agent completes the contact. 

Just as you can request that another agent become involved in your chat contact, so can 
another agent or supervisor request that you become involved in their chat contact. When this 

happens, you must wrap up the joint contact just as you would a contact that you handled by 

yourself. 

If you want to involve another agent with a particular skill, you can do one of the following: 

● Use the Find option in the UAD to find a specific skilled agent. then conference that agent 

into the chat contact, as described in Conferencing Another Agent into a Chat Contact on 

page 140. 

● Transfer the chat contact to another agent, as described in Transferring a Chat Contact to 

Another Agent on page 141. 

● Transfer the chat contact to a queue that includes all agents with the needed skill, as 
described in Transferring a Chat Contact to a Queue on page 142. 

● Transfer the chat contact to a queue and get immediately dropped from the chat 

conference room without waiting for the other agent to receive the contact from the queue, 

as described in Performing a Blind Chat transfer on page 143. 
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● Conference the chat contact to a queue that includes all agents with the needed skill, as 

described in Conferencing a Chat Contact to a Queue on page 143. 

● Cancel the transfer or conference of a chat contact before it connects to another agent, as 

described in Cancelling the Transfer or Conference of a Chat Contact on page 144. 
 

 

Conferencing Another Agent into a Chat Contact 

To conference another agent into a chat contact 

1. Tell your chat customer that you are going to find another agent who can help them. 

2. Click the Conference current contact button in the Web Agent. 

The UAD’s Select Destination for Conference/Transfer dialog box is displayed. 

If the dialog box has an Agents tab, that tab is selected. If it has a workgroup tab, you can 
use that tab for your search. 

3. If the agent you are looking for may be in a different location or workgroup, click the Site 

drop-down menu to make another selection. Or select All Sites to include all locations and 

workgroups. 

  Tip: 

If you are not certain about the login ID of the agent to whom you want to transfer 

the chat session, right-click the agent’s name. Then click the Properties pop-up 
menu. A dialog box with information about this agent is displayed. 

4. Navigate through the folders as necessary until you find the agent you want for the 

conference. Click the name of the agent. 

The name you selected is displayed in the To field. 

5. If you want to send a comment to the agent, put your cursor in the Comment field and type 

your message. 

6. Click OK. 

A dialog box will inform you if the agent is unavailable. 

If available, the agent is connected to the session. The Transcript area announces that this 
agent has arrived. 

7. Chat with the customer and with the agent, reading their messages in the Transcript area 
and replying in the usual way. 

All messages you, the other agent, and the customer send are displayed in your Transcript 
area. The customer and the other agent see all messages as well. 

8. If you want to add another agent to the conference, repeat the above steps. You can stay 

in the Conference session with both agents and the customer as long as you want. 
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9. Whenever you decide to leave the session, inform the others that you will leave and say 

good-bye. Then you can drop out of the session by wrapping up the contact as usual. If 

you need instructions, see Wrapping Up a Chat Contact on page 155. 

You are dropped from the chat session. The agent to whom the contact was transferred 

continues to chat with the customer. 

Note: 
Each agent can drop out of the chat session whenever they want. The chat 

session continues until the last agent in the session wraps it up. 
 

 

Transferring a Chat Contact to Another Agent 

Your administrator configures whether you can perform a consultative transfer or a blind transfer 
or both. Consultative transfer is the default option. 

When you transfer a chat contact to another agent: 

1. The receiving agent joins the chat conference room. 

2. You are automatically dropped from the chat conference room. 

To transfer a chat contact to another agent 

1. Tell your chat customer that you are going to find another agent who can help them. 

2. Click the Transfer current contact button in the Web Agent. 

The Select Destination for Conference/Transfer dialog box of the Unified Agent 

Directory is displayed. 

If you can perform both consultative transfer and blind transfer, then Web Agent displays 
both the Transfer current contact and Blind Transfer current contact buttons. 

Procedure for blind transfer is described in Performing a Blind Chat transfer on page 143. 

3. In the Select Destination for Conference/Transfer dialog box, click the Agent tab. 

4. If the agent you need is in a different location: 

● Select the desired site from the Site drop-down menu. 

● Select All Sites from the Site drop-down menu to view agents in all locations. 

5. Navigate through the list of queues until you find the agent you want for the transfer, and 

then select the name of the agent. 

Avaya Agent displays the agent you selected in the To field. 
 

  Tip: 

If you are not certain about the login ID of the agent to whom you want to transfer 

the chat session, right-click the agent’s name. Then click the Properties pop-up 

menu. A dialog box with information about this agent is displayed. 
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6. To send a comment to the agent who receives the chat contact, type your message in the 

Comment field. 

7. Click OK. 

8. Continue to chat with the customer until the agent is available and the chat is transferred to 

that agent. 

9. As soon as the second agent joins the chat conference room, Avaya IC drops you from the 

conference room. 

10. When you leave the chat conference room, you enter the WrapUp state. Wrap up the chat 
session as described in Wrapping Up a Chat Contact on page 155. 

 

 

Transferring a Chat Contact to a Queue 

When you transfer a chat contact to a queue: 

1. The receiving agent joins the chat conference room. 

2. You are automatically dropped from the chat conference room. 

To transfer a chat contact to a queue 

1. Tell your chat customer that you are going to find another agent who can help them. 

2. Click the Transfer current contact button in the Web Agent. 

The Select Destination for Conference/Transfer dialog box of the Unified Agent 

Directory is displayed. 

3. In the Select Destination for Conference/Transfer dialog box, click the Queues tab. 

4. If the queue you need is in a different location: 

● Select the desired site from the Site drop-down menu. 

● Select All Sites from the Site drop-down menu to view queues in all locations. 

5. Navigate through the list of queues until you find the queue that includes agents with the 

needed skills, and then select the name of the queue. 

Avaya Agent displays the queue you selected in the To field. 

6. To send a comment to the agent who receives the chat contact from the queue, type your 
message in the Comment field. 

7. Click OK. 

8. Continue to chat with the customer until an agent is available and the chat is transferred 
from the queue to that agent. 

9. As soon as the second agent joins the chat conference room, Avaya IC drops you from the 

conference room. 
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10. When you leave the chat conference room, you enter the WrapUp state. Wrap up the chat 

session as described in Wrapping Up a Chat Contact on page 155. 
 

 

Performing a Blind Chat transfer 

Your administrator configures whether you can perform a consultative transfer or a blind transfer 
or both. Consultative transfer is the default option. 

When you perform a blind transfer of a chat contact: 

1. You transfer the chat to the queue. 

2. You are automatically dropped from the chat conference room without waiting for the other 

agent to receive the chat contact from the queue. 

To transfer a chat contact to a queue 

1. Click the Blind Transfer current contact button in the Web Agent. 

If you can perform both consultative transfer and blind transfer, then Web Agent displays 
both the Transfer current contact and Blind Transfer current contact buttons. 

Procedure for consulatative transfer is described in Transferring a Chat Contact to Another 

Agent on page 141. 

The Select Destination for Conference/Transfer dialog box of the Unified Agent 
Directory (UAD) is displayed with the Queues tab selected. 

For blind transfer, Agent is not allowed to select any agent. An agent is able to select 

queues. So Agent tab is disabled from the UAD. 

2. Click OK. 

You are automatically dropped from the chat conference room without having to wait for 

the other agent to receive the chat contact. 

A message, Transfer in progress, wait for next agent., is displayed on 

the csportal/old website. 

3. When you leave the chat conference room, you enter the WrapUp state. Wrap up the chat 
session as described in Wrapping Up a Chat Contact on page 155. 

 

 

Conferencing a Chat Contact to a Queue 

When you conference a chat contact to a queue: 

1. The receiving agent joins the chat conference room. 

2. You can talk to the receiving agent before you leave the chat conference room. 
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To conference a chat contact to a queue 

1. Tell your chat customer that you are going to find another agent who can help them. 

2. Click the Conference current contact button in the Web Agent. 

The Select Destination for Conference/Transfer dialog box of the Unified Agent 

Directory is displayed. 

3. In the Select Destination for Conference/Transfer dialog box, click the Queues tab. 

4. If the queue you need is in a different location: 

● Select the desired site from the Site drop-down menu. 

● Select All Sites from the Site drop-down menu to view queues in all locations. 

5. Navigate through the list of queues until you find the queue that includes agents with the 

needed skills, then select the name of the queue. 

Avaya Agent displays the queue you selected in the To field. 

6. To send a comment to the agent who receives the chat contact from the queue, type your 

message in the Comment field. 

7. Click OK. 

8. Continue to chat with the customer until an agent is available and the chat is moved from 

the queue to that agent. 

9. When the second agent joins the chat conference room, you can either: 

● Stay in the chat conference room and continue to participate in the chat session 

● Leave the conference room 

Note: 
You cannot send private messages to the second agent in the conference room. 

10. When you leave the chat conference room, or when the customer leaves the chat 

conference room, you enter the WrapUp state. Wrap up the chat session as described in 

Wrapping Up a Chat Contact on page 155. 
 

 

Cancelling the Transfer or Conference of a Chat Contact 

You can cancel a transfer or a conference of a chat contact at any point until the other agent 
accepts the chat contact. 

To cancel the transfer or conference of a chat contact 

1. Click the Cancel Transfer/Conference request button in the Web Agent. 

2. Click OK. 

3. Advise customer that you have cancelled the transfer or conference request. 
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Involving Other Agents in a Voice Chat 

When you are in a Voice Chat session with a customer (either Chat & Phone or Chat & VoIP), 

you may want to add one or more agents into the Voice Chat, or you might want to transfer the 

Voice Chat to another agent. 

Note: 
A Voice Chat has two media channels, Chat and Voice. If you want to involve 

another agent in the contact, that agent must be available to take both the chat 

session and the voice call. 

When you involve other agents in a Voice Chat, there are some differences from working with a 

text chat session. For example, the dialog box that is displayed when you click the Conference 

button is called In the Select Destination for Conference dialog box, be sure to enter the 

agent’s name in the To field before you click the OK button. Otherwise, a message says 

Destination Busy and you cannot transfer the contact. 

You can use the Softphone buttons to: 

● Conference – Includes another agent in the contact with yourself and the customer. 

● Consult – Lets you talk to the other agent while the customer is on hold before you 

transfer the contact to that agent. 

Note: 
You cannot use the Transfer Softphone button for a Voice Chat. If you want to 

send a Voice Chat to another agent, you must use the Consult feature so that you 

can be sure the other agent is available for both the chat and voice portions of the 

contact. 

For more information about the Softphone buttons, see Using the phone task list and 

softphone on page 64. 

To add another agent to a Voice Chat 

1. While in a Chat & Phone or Chat & VoIP session with a customer, click the Softphone 

Conference button. 

The UAD’s Select Destination for Conference dialog box is displayed. 

2. Select the agent you want to conference in to the voice chat. For more information, see 

Involving other agents in a chat contact on page 139. 

Once you have selected an agent, the system tries to connect the voice portion of the 

voice chat with the agent you selected, and displays the status of the connection in the 

Conferencing Call/Chat dialog box. 

When the other agent has been contacted and the voice call has been connected, the 

Conferencing Call/Chat dialog box shows the status In Call and enables the Send Chat 

button. At this point, you and the agent you just added can talk with each other over the 

phone, but the other agent has not yet been added to the chat and cannot speak to the 

customer over the phone. 
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  Tip: 

If you want to tell the customer that the conference is almost complete, you can 

click the Switch to Caller button. The status changes to Connected with Caller, 

and you can now speak to the customer over the phone. If you want to go back to 

the other agent, click the Switch to Destination button. 

3. Click the Send Chat button to send the chat to the other agent. 

When the other agent enters in the chat conference, the status changes to Chat 

Conferenced. 

At this point, you, the customer, and the agent you just added can all view and participate 

in the chat, and you can speak to the other agent, or the customer, over the phone. The 

other agent, however, cannot yet speak to the customer over the phone. 

4. To conference everyone in to the voice call as well as the chat, click the Complete button. 

At this point, anything you say on the phone will be heard by both the other agent and the 

customer. 

To consult with another agent before transferring the Voice Chat 

1. While in a Chat & Phone or Chat & VoIP session with a customer, click the Softphone 

Consult button. 

The UAD’s Select Destination for Consult dialog box is displayed. 

2. Select the agent to whom you want to transfer the voice chat. For more information, see 
Involving other agents in a chat contact on page 139. 

Once you have selected an agent, the system tries to connect the voice portion of the 

voice chat with the agent you selected, and displays the status of the connection in the 

Consulting Call dialog box. 

When the other agent has been contacted and the voice call has been connected, the 

Consulting Call dialog box shows the status In Call and enables the Send Chat button. 

At this point, you and the agent you just added can talk with each other over the phone, but 

the other agent cannot enter the chat with the customer or speak to them over the phone. 

  Tip: 

If you want to tell the customer that the consultation is almost complete, you can 

click the Switch to Caller button. The status changes to Connected with Caller, 

and you can now speak to the customer over the phone. If you want to go back to 

the other agent, click the Switch to Destination button. 

3. Click the Send Chat button to send the chat to the other agent. When the other agent can 
see the chat log, the status changes to Chat Conferenced. 

At this point, you, the customer, and the agent you just added can all view and participate 
in the chat, and you can talk to either the agent or the customer on the phone. 
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4. To transfer the contact to the other agent, click the Complete button. Avaya Agent takes 

you out of the chat and transfers the customer’s voice call to the other agent’s phone line. 

At this point, you can wrap up the contact as you normally would while the new agent 

handles the customer’s issues. 
 
 
 
 

Handling a JoinUs Conference 

You may occasionally have a customer who would like to invite one or more others to join the 
chat session. This type of session is called a JoinUs Conference. 

To create the JoinUs Conference, you first create a JoinUs handle (user name). You send this 

handle with a special URL, given in step 5 of the following procedure, to anyone who is going to 

enter the JoinUs session. These people go to the URL and enter the handle. You can then all 

share browsers and type messages to each other about what you see. 

For example, say that you have a customer who is thinking about buying an item on the 

company website but wants the advice of his wife before making a decision. You suggest that 

his wife join the session and he agrees. You follow the instructions below to create the handle 

and to convey the URL and instructions to your customer’s wife. She then goes to that location 

and enters her handle. The chat client opens on her desktop. Now the three of you can 

exchange chat messages in a three-way session. 

The following instructions explain how to have a person of your customer’s choice join a 

conference. In the instructions, the person is called a "friend," but of course it may be a spouse 

or an acquaintance. If your customer wants more than one person to join, repeat the 

instructions as needed. 

Before you begin, ask your administrator for the URL of JoinUs conferences. 

To handle a JoinUs conference 

1. Chat with your customer about having someone they know join the chat session. Note that 
these instructions refer to this person as your customer’s friend. 

2. Explain to your customer that their friend must go to a specific Web address (URL) and 

enter a specific user name, which is called a handle. Explain that you must give their friend 

the URL and handle they need to join the chat. Ask which of the following methods the 

customer prefers: 

● You send the information to your customer and the customer passes it on to their 

friend. 

● You send the information to your customer’s friend through the friend’s email account. 

● You call your customer’s friend on the telephone and give them the information. 

3. Ask your customer to send the friend’s email address or telephone number. 
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4. Click the JoinUs button in the Web Agent window. 

The JoinUs dialog box opens displaying a unique handle generated by the system. You 
can change the handle. However, you should not change the system generated handle. 

The JoinUs handle is displayed in the format: <customername><hhmmss>. 

Note: 
The JoinUs handle is displayed in the format: <customername><hhmmss>. 

  Tip: 

Note the handle and the friend’s name for your reference. 

5. Whether by email or telephone, tell the friend the URL and the handle for the JoinUs 

Conference, as follows: 

a. Unless your administrator has changed it, the URL is website\public\ 

joinus.jsp. 

b. Tell that person to enter the following: 

● JoinUs Name: Any display name 

● JoinUs password: The handle provided by the agent. 

Note: 
If the Join-Us website asks for a password, the friend should enter the JoinUs 

handle as a password. 

c. After they enter their handle, they should click the Submit button. 

When the friend does this, the JoinUs program is downloaded to their browser. You, 

your primary customer, and your customer’s friend are in the same chat room. You can 

see what the other two people type. 

Note: When the friend joins the chat room the last sent URL is shared with him/her. All 
other previously sent messages are not shared. 

6. Manage the JoinUs conference as appropriate. Use Auto Sync or push URLs to your 
customer and their friend. Watch your browser as they send pages to you and each other. 

 

  Tip: 

You may want to tell your customer and friend how to lead the others to a 

webpage. They can go to the page or paste the URL in the URL box of their chat 
client, and then click the Send Message button. 

Note: 
If your customer or their friend closes their browser or clicks the End Chat button, 

the session continues between you and the other person. 

7. When your customer and their friend indicate that they are finished, tell them that you will 

close the session. Say good-bye. 

8. Wrap up the JoinUs session as described in Wrapping Up a Chat Contact on page 155. 
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Handling Simultaneous Chat Sessions 

You can handle more than one chat session at the same time. For example, you may chat with 

a new chat customer while your other chat customers are reading material you sent them or 

trying your suggestions. 

  Tip: 

If you plan to handle multiple sessions, it is a good idea to set the "Away from 

Desk" message. The "Away from Desk" message is sent to the customer 

whenever you do not respond within a period of time you specify. This is a 

preference and is described in Setting Preferences on page 163. 

To handle simultaneous sessions with multiple customers 

1. Ensure that you are available for the number of simultaneous sessions you want to handle. 

For information, see Changing your agent state on page 43 and Setting your channel 

loads on page 46. 

2. While handling a chat session, double-click the name of another customer from the Chat 

task list. Usually you should select the next contact from the top. 

The Web Agent changes to display your chat session with the new customer. An icon for a 

new Internet Explorer browser is added to the Windows Task Bar, beside the icon for your 

previous chat customer. 

3. Type and send a message to the new customer. 

4. Whenever you have a chance to return to the original customer, click that customer’s 

contact in the Chat task list. 

The Web Agent changes to display information about this contact, including the transcript 
of your previous conversation. 

5. If your current chat contact load allows you to handle more chat customers and you want 

to add another, repeat Steps 2-4. Your contact load for chat is the maximum number of 

chat contacts you can handle simultaneously. This number, which can change during your 

login session, is displayed in the chat icon at the bottom right of the Web Agent. 

  Tip: 

If one of your chat customers needs more attention, you can click the Transfer 

button and transfer that contact to another agent. 

6. Return to interact with your other customer by clicking the name in the Chat task list. 
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  Tip: 

You can double-click any currently active contact in the Chat task list to have the 

Web Agent window display that chat session. If you are handling multiple 

contacts simultaneously, the logo in the Web Agent window may change when 

you select a different contact from the Chat task list. This can help you distinguish 

between different customers quickly. 
 

Tip: 

You can use the Shared Browsing features with each chat contact. Use the 
Internet Explorer icons in the Windows Task Bar to switch between the browsers. 

7. When you are finished with any of the chat customers, select the name from the Chat task 
list. Wrap up and close this session as usual. See Wrapping Up a Chat Contact on 

page 155. 

The other chat sessions remain active until you wrap up and close them. 
 
 
 
 

Monitoring a Chat Session (Supervisors Only) 

If you are a supervisor, one of the most important ways that you can ensure quality is to monitor 

your agents’ chat sessions. You can enter a chat session and view the interaction between the 

agent and the customer in real time. You can also have other supervisors join you in observing 

an agent. 

Note: 
To monitor an agent task, an agent with supervisor role must be designated as 

the supervisor of the first agent's workgroup. For details about setting up 

workgroups, see Interaction Center Administration Guide. 

From IC 7.3.5 onwards, an administrator can assign multiple supervisors to a single workgroup. 
Therefore, supervisors can monitor a number of agents within the assigned workgroups. 

Multiple supervisors can monitor a single agent at a time. A single supervisor can actively 

monitor only one chat task at a time. Avaya Agent displays a monitored symbol to other 

supervisors after a supervisor starts monitoring an agent. 

When you first enter the chat session, neither the agent nor the customer can see you. You can 
become visible by selecting the Make Visible option and speaking. When you are visible and 

you leave the chat session, then both the agent and the customer can see you leave. 

If you want to monitor a session without anyone knowing you are there, you can remain 

Invisible. This makes it possible for you to observe natural interactions for training purposes. It 

also helps ensure that your agents perform well because they know that you may monitor them 

at any time. 
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  Tip: 

If you prefer to monitor while you handle a chat session of your own or reply to an 

email, you can do this. Use the Chat Management and Email Management 

buttons in the main toolbar to switch between contacts, as desired. 

To monitor a chat session: 

1. On the Avaya Agent main toolbar, select Switch to Supervisor mode. 
 

  Tip: 

To expand the window, hold your cursor over the bottom edge of the Monitoring 

panel. When you see a small, double-headed arrow, drag the edge of the panel 
down, as far as you want. You can drag the edge back in similar manner. 

2. Expand the workgroup node. 

3. Expand the agent node whose chats you want to monitor to see what chats that agent is 

currently engaged in. Avaya Agent displays a monitored symbol to other supervisors after 

a supervisor is monitoring the agent. 

Click on any customer name under that agent to monitor that chat. 

A transcript of the current session is displayed in the Transcript area of the chat window. 

Note: 
By default, when you begin monitoring, you are invisible to all parties involved in 

the chat. You cannot type in the Text Area unless you make yourself visible. 

4. If you want to become visible, right-click the name of the customer and select Make 

Visible. 

In the Transcript area, the system announces your presence. A line says Supervisor is 

available on the call. 

  Tip: 

If you make yourself visible, you might want to make yourself invisible before 

monitoring another session. 

5. If you want to become invisible again, right-click the name of the customer and select 

Make Invisible. 

You can also use the toolbar to make yourself visible or invisible. 

The system announces that you are not available. However, you can continue monitoring 
the session without typing messages. 

Note: 
If you click another chat session, the system announces that you left the first 

session. You can only monitor one session at a time. 
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To end monitoring a chat session do one of the following: 

1. If you want to switch to another mode and end the session, select one of the following 
modes on the Avaya Agent main toolbar: 

● Switch to Chat & Phone mode 

● Switch to Email mode 

● Switch to Chat mode 

The system ends the supervisory mode for monitoring. Supervisor can start the work in an 

agent mode. 

2. If you do not want to switch to another mode or end the session, click the Supervisor 

Mode button or click an icon at the root level in the Monitoring panel. 
 
 
 
 

Viewing Customer DataWake Records 

A DataWake record is a list of URLs (webpages) that customers have recently navigated. Your 

administrators set up the webpages that can be listed in DataWake records. 

Some URLs that the customer has visited may not appear in the customer’s DataWake. Your 

administrators determine which URLs can be included in DataWake records. 

To view a customer’s DataWake record 

1. Display a contact in the Web Agent. 

Note: 
When you are not handling a chat contact, the DataWake option is disabled. 

2. Select Tools > DataWake. 

Your Internet browser opens to the customer’s DataWake Summary page. The DataWake 
record has the following columns: 

● Time – The time of day when the customer accessed the page. 

● Priority – The significance of a particular URL accessed by the customer, as defined 
by your administrator in IC Manager. 

● Type – Pages are classified as either escalation pages or browse pages. Escalation 

pages are pages from which a customer can send an email or request a chat session. 

Browse pages are all other pages in the DataWake database. 

● Description – The URL of the page. You may be able to click the URL to access the 

page in your browser. 
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Using Multiple Languages in Chat Sessions 

Your customer may want to chat with you in a language that is not your primary language. If you 

are assigned a chat contact in another language and the language is not displayed properly, 

check with your administrator. 

You can spell check your chat messages in a secondary language before you send them. When 

you open the Spell Checker, select the appropriate language from the Available languages 

drop-down menu. 

If you use another language, you may want to create some Agent Resources in that language. 
See Managing Resources on page 156. 

 
 
 
 

Managing Web Scheduled Callback Contacts 

This section includes the following topics: 

● About Web Scheduled Callback on page 153 

● Responding to a Web Scheduled Callback Request on page 154 
 

 

About Web Scheduled Callback 

Web Scheduled Callback allows customers to schedule a date and time for an agent to call 

them. This process works as follows: 

1. Using the Scheduled Callback webpage, the customer fills in the required call 

information, including: 

● Customer phone number 

● Scheduled date and time for callback 

● Customer time zone 

● A detailed description of the problem or question 

2. The customer receives confirmation that the request has been submitted. 

3. The request is routed to an agent at the scheduled time as a scheduled callback work 

item. 
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Responding to a Web Scheduled Callback Request 

When a customer requests a Web Scheduled Callback from the website, the scheduled call 

request is routed as a chat contact. After you begin the chat session, you must connect the call, 

as described in the following procedure. 

To respond to a Web Scheduled Callback request 

Note: 
You must be available for voice contacts and chat contacts to be able to handle 

Web Scheduled Callback requests. 

1. Double-click the Web Scheduled Callback contact in the Chat task list. 

The Web Agent opens with this contact currently active. The Chat & Phone toolbar is 

displayed, as described in Voice Chat toolbars on page 33. 

You will see the customer telephone number displayed in the Customer phone number 

field. The question from the customer is displayed in the Question field. 

2. Call the customer telephone number by pressing the icon located to the right of the 

displayed telephone number. 

 

3. When your customer answers the telephone, introduce yourself as the agent who is 
responding to their callback request. 

  Tip: 

You can initiate a consultation or a conference call if necessary using the buttons 

under the Avaya Agent Media tab on the right side of your screen for both Web 

and voice contacts. If you want to transfer a contact, you can transfer only a Web 

contact, not a voice contact. 

If the customer is not available, disconnect the call and continue to Step 4. You cannot 
reschedule the contact. 

4. When you finish the customer interaction over the phone, use the HangUp button on the 

softphone to disconnect the phone call. 

5. Wrap up the Web Scheduled Callback contact using the Wrap button on the toolbar. A 

wrap up dialog box may display allowing you to fill in information about this contact. 

  Tip: 

For information on wrapping up contacts, see Wrapping Up a Chat Contact on 

page 155. 
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Wrapping Up a Chat Contact 

When you finish interacting with a customer in a chat session, you wrap up the session. When 

you click the Wrap button, you enter the WrapUp state. While in WrapUp state, you cannot 

receive another chat contact to replace this one. You may be required to enter information about 

the chat session while in this state. 

Note: 
In certain cases, you may not see a Wrap-up dialog for any of the following 

reasons: 

● The chat contact was removed because you did not respond in the allotted amount 
of time. 

● Your supervisor removed the chat contact to put it back in a queue. 

● The chat contact was cancelled in the server. 

To wrap up a chat contact 

1. Ensure that you have addressed all your customer’s questions or problems and that the 

customer understands that the session is about to end. Say thank you and good-bye. 

2. Click the Wrap button in the chat toolbar. 

3. If you see a dialog box asking you to confirm your action, click Yes. 

A Wrap-up dialog box may be displayed for you to fill in information about this contact. Or 

you may see a Prompter script displayed in the Avaya Agent. 

  Tip: 

You can set a preference to control whether this dialog box is displayed when you 

wrap up a chat contact. See Setting Preferences on page 163. 

4. If you see a dialog box or a Prompter script, answer all the questions appropriately. For 

information about the dialog box or the script, see Wrapping up contacts on page 61. 

When you have completed all the wrap-up tasks, the chat contact is removed from your 
Chat task list. 
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Chapter 7: Performing chat and email 

tasks 

 

This chapter explains how to perform tasks related to email or chat that you generally perform 
when you are not actively handling an email or chat contact. 

The chapter includes the following topics: 

● Managing Resources 

● Setting Preferences 
 
 
 
 

Managing Resources 

Resources are previously prepared text, emails, and URLs (Internet addresses) that you can 

send to customers whenever the information is needed. This saves you the time and the tedium 

that it would take to type the same information repeatedly. For example, text resources may 

consist of boilerplate text and small pieces of text that you can use in your chat sessions, such 

as common phrases, greetings, closings, and answers to questions you receive frequently. 

email resources may contain answers to commonly asked questions and may contain 

attachments. URL resources may lead your customer to corporate websites, such as a page on 

exchange policies. 

Your administrator may have prepared "global" resources for you and other agents to use. You 

cannot change or delete global resources, unless you are an administrator. However, you can 

create agent resources for your own use. No one else can see your agent resources. 

When you respond to email, you may also have a list of "Suggested Responses" in your 

Resource Area. These are temporary resources related to an email contact. For more 

information, see Using suggested responses on page 95. 

This section contains the following topics: 

● Resource types and examples 

● Creating New Agent Resources 

● Creating New Global Resources (Supervisors Only) 

● Editing Your Resources 

● Viewing Your Resources 

● Organizing Your Resources 
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For information on sending resources to a customer, see Using resources in a chat session on 

page 132 or Using resources in an email on page 92. 
 

 

Resource types and examples 

Global and agent resources come in three types: email, text, and URL. This section explains 
each type and gives an example. 

 
email 

An email resource contains the subject and text of an email message that you can use to 

respond to customers quickly. You can add an attachment to this message as well. When you 

send the resource to a customer, you can add to or modify the message as needed. 

For example, you could create an email resource to respond to a question customers frequently 

ask about the safety of a product. 

 
Text Files 

You can use text resources to store "canned" or "boilerplate" greetings and responses. This 

saves you time and tedium when you are responding to email or when you are engaged in a 

chat session. You can add to or modify the message before you send it to a customer. 

For example, You could create a "Welcome" text file containing text like the following: 

Hello. Welcome to XYZ support. My name is Joe, and I am here to 

assist you. 

 

URLs 

A URL resource is a resource that contains a linked address to a website. When you send this 

resource to a customer in a chat session with you, the customer’s browser opens to display that 

website. In most email programs, if you send the resource to an email customer, the customer’s 

browser opens to the website when they click the URL. 

Example: 

A URL resource named "Shopping Mecca Catalog" might be 

http://www.shoppingmecca.com/catalog/ 
 

Tip: 

You can use a File Transfer Protocol (FTP) site as a URL resource, so that 

customers can go to the site to download files. When you create such a URL, 

begin it with ftp://. 

Example: 
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A URL resource named "XYZ ftp site" could take the customer to an ftp site at your company. 

The contents of the URL resource might look like the following: 

ftp://ftp.XYZsupport.com/special 

 

 

Creating New Agent Resources 

You can create your own resources and store them in the Agent Resources folder. These are 

saved with your user account and are available to you whenever you log in. Other agents 

cannot see or use the resources you create. 

You can create resources for specific tenants. A tenant may be a company, such as XYZ Corp; 

a location, such as New York or Boston; or a workgroup, such as Sales or Support. You can 

create resources in different languages, which is useful if you interact with customers in more 

than one language. 

If required, you can edit a resource just before you send it to a customer. This makes it possible 

for you to adapt the existing resources to meet your customer’s individual needs. 

  Tip: 

You can drag and drop a copy of any resource to a new location. For example, 

you can copy a resource in your Global Resources folder into your Agent 
Resources folder. Then you can modify the copied resource if you want. In some 

cases, this is faster than creating a new resource from the beginning. 

To create a resource 

1. Right-click the Agent Resources folder or any of its subfolders in the Resource Area of the 
Web Agent. 

2. From the pop-up menu, select Create resource and the type of resource you want to 

create. For information on each type of resource, see Resource types and examples on 

page 157. 

The New resource dialog box is displayed, with your Login ID and today’s date and time 

already entered. This read-only information will be displayed as a tooltip when you hold 

your cursor over this resource. 

3. If you want to create the resource for a specific tenant, select that tenant from the Tenancy 

drop-down menu. 

4. If you want to create the resource in a language other than your primary language, select 
the language from the Available languages drop-down menu. 

5. Enter a unique name to identify this resource in the Name field. 

6. From the drop-down list, select one of the following options: 

● HTML 
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● Plain Text 

If you select HTML, the resource can include the same text formats, images, and other 

content that is available for HTML email. For more information, see Formatting HTML 

text on page 86. 

7. Follow the step below that applies to the type of resource you are creating: 

 

Resource Notes 

URL resource Type the entire URL, beginning with http://, https://, or ftp://. 
Do not type any text other than the URL. 

If you do not begin the address correctly, you will not see an error 
message at this time. However, you will see an error message when 
you try to send it to a customer. If you send a URL with an incorrect 
address, the customer who receives it will see an error message 
when their browser attempts to locate the website. 

Tip: When creating a URL resource, you can copy a URL from your 
browser and paste it into a resource. Select the entire address from 
the browser’s Location or Address box and click Control+C. Put your 
cursor in the scroll box of the New resource dialog box and click 
Control+V. The URL is pasted into the dialog box. 
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Resource Notes 

Text resource Type the message that you want customers to see. 

Email resource Fill in the fields as follows: 

● To – You should probably leave this field blank. Your current 
customer’s address will be filled in here automatically each time 
you send this resource. 

● Cc – Enter addresses here that you want be entered in the Cc 
field of emails using this resource. In this way, you can inform 
someone in your company that a customer is seeking help on 
this topic. 

● Bcc – If you want another person or persons to receive a copy of 
this email whenever you send it to a customer, but you do not 
want your customers to see the address or addresses, enter the 
email address or addresses here. 

● Subject – Type the subject of this email so customers who 
receive an email from this resource can see what the email is 
about before they open it. 

Tip: Click the buttons beside the To, Cc, and Bcc fields to look up 
the email addresses of other employees of your company or External 
Agents in the Unified Agent Directory (UAD). See the description of 
the fields below. When you find the name of a person you want to 
add to the field, double-click the name. 

If you want to attach a file or files 

1. Click the Attachments tab and then the Add Attachments (paper 
clip) button. 

2. Use the drop-down menu and the buttons at the top of the Open 
dialog box to locate a file you want to attach. The file can be on 
your local hard drive or on any drive on the network to which you 
have access. 

3. Click on the file you want to add and then click Open. 

4. If you want to attach more files, click the Add Attachments button 
again. 

5. Click OK. 
 

8. Read carefully everything that you have entered in the New resource dialog box. 
 

  Tip: 

To spell check your resource, select the text that you have entered and click 

Control+C to copy it. Then select Tools > Compose new email. Put your cursor 

in the Text Composition Area of the email and click Control+V to paste the text. 

Click the Spell Check button from the email toolbar and run the Spell Checker. 

After you correct any errors, you can copy the message and paste it back into the 

New resource dialog box. 
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9. Click OK. 

If you need to change anything in this resource after you click OK, right-click it and select 

Edit resource. 

10. Click the Save Resources button in the Resources toolbar. 

The resource is saved with your login ID so it will continue to be available to you until you 
delete it. 

 

 

Creating New Global Resources (Supervisors Only) 

If you are a supervisor, you can create Global Resources for agents or groups of agents. You 

may want to create separate resources for different tenants or agents in different language 

groups. Follow the instructions in Creating New Agent Resources on page 158, adapting them 

as necessary. Begin by selecting the Global Resources folder or any of its subfolders. 

When you click Save in the Resources toolbar, the resources you created or modified in the 

Global Resources folder are saved on a shared drive that has been set up for this purpose. 

Usually, this is the Global_resources.xml file. Other agents should be able to see the resources 

you create the next time they log in. 
 

 

Editing Your Resources 

You can change any part of a resource that you have created, such as the tenancy, language, 

name, or contents. (You can only change Global Resources if you are a supervisor.) 

To edit a resource 

1. Right-click the resource you want to edit. 

2. Select Edit resource. 

The Edit resource dialog box is displayed with all the information contained in this 

resource. Use the drop-down menus if you want to change the tenancy or language. 

3. Change the resource name or contents as you want, selecting any text you want to delete 

or replace. If this is an email resource, you can also change the header fields (To, Cc, 

Bcc, and Subject), or add or delete an attachment. 

4. Click OK. 

The resource is updated. 
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Deleting a Resource 

You can delete any resource you created yourself. Only supervisors and administrators can 
delete a Global Resource. 

To delete a resource 

1. From the Web Agent, select the resource. 

2. Right-click the resource and select Delete resource from the menu that appears. 

The resource is removed from the Resource Area. 

 
 

Viewing Your Resources 

Resources are organized in a hierarchy of folders and subfolders in the Resource area of the 

Web Agent. In this area, you can view the folders, subfolders, and the resources they contain by 

selecting commands from three places. Most of the same commands are available in all three 

places. 

● A toolbar and drop-down Filter by menu at the top of the Resource area 

● The Resources menu 

● Pop-up menus displayed when you right-click a folder 

To show the contents of all folders and subfolders in the Resource area, select Expand All from 

the toolbar or from the Resources menu. To show only the folder or folders that contain all the 

other folders, select Collapse All. 

Note: 
You may have only one main folder, called Resources, which contains all the 

other folders. In this case, Collapse All displays only that folder. 

To hide the subfolders and contents of any folder that is currently open, right-click the folder and 

select Collapse folder from the pop-up menu. To show the subfolders and contents of any 

folder that is currently closed, right-click it and select Expand folder from the pop-up menu. 

  Tip: 

Keyboard characters to the side of the folder icons indicate whether folders are 

open, closed, or empty. 

To display only a particular type of resource within the open folders, click one of the following 

items from the Filter by drop-down menu: 

● Blank – Displays all types of resources for all tenants and all languages. 

● Tenant – Displays only the resources that belong to a tenant of the current active task or 

belong to all the tenants. A tenant may be any group in an organization, such as a 

company, location, or workgroup. 
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● Language – Displays only the resources for a specified language. 

● Text resources – Displays only text resources. 

● URL resources – Displays only URL resources. 

● Email resources – Displays only email resources. 

Note: 
You cannot filter suggested responses or email templates. 

To view the contents of a resource without opening it, select the Preview content check box at 

the lower part of the Resources area. Use the vertical and horizontal scroll bars to see more of 

the resource. 
 

 

Organizing Your Resources 

You can create folders and subfolders to keep your Agent Resources organized. If you are a 

supervisor, you can do this for Global Resources also. After you create a folder or subfolder, 

you can drag and drop resources into it. 

To organize your resources 

1. If you want to display the contents of all the resource folders, including subfolders and 

resources, select Expand All from the toolbar. 

2. Check the Filter by drop-down menu to be sure you are displaying all the resources that 

you plan to organize into folders. If no text is displayed until you open this drop-down 

menu, you are displaying all the resources, regardless of type. 

3. To create a new folder, right-click the existing folder in which you want to create your 
folder. Then click Create folder in the pop-up menu. 

The new folder, with the name "New resources," is added under the current folder with the 

name already selected so that you can easily rename it. 

4. Type a new folder name and press Enter. 

The name you typed is displayed next to the folder icon. 

5. If you have already created the resources for this folder, drag and drop one at a time into 

the new folder. You can also drag a folder or resource from an open folder and drop it into 

another folder. 
 
 
 
 

Setting Preferences 

You can use the Web Agent Preferences dialog box to set certain options about the display of 

the Web Agent and the way you handle your email and chat contacts. 
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Note: 
Except for User Interface settings, all preference changes you make take place 

immediately. User Interface changes, such as changes to the size of the font or 
icons, take place only when you exit the Web Agent and start it again. 

To set your preferences 

1. If the Web Agent is not currently displayed, click the Web Agent button in the task bar. 

2. In the Web Agent, select Tools > Preferences. 

The Web Agent Preferences dialog box opens. Note that it contains five tabs and opens 

to the User Interface tab. 

3. Click the tab with the category of preferences that you are interested in seeing or 

changing. The tabs and their options are described in the following sections: 

● User Interface Preferences on page 164 

● Contact preferences on page 165 

● email preferences on page 166 

● Chat Preferences on page 167 

● Other Preferences on page 168 
 

 

User Interface Preferences 

When you open the Preferences dialog box, the User Interface tab is displayed. 

User Interface preferences are related to the display of the Web Agent. The changes you make 

in the User Interface tab do not take effect in the Web Agent until you log out and log back in 

again. 

You may see two parts of this dialog box, Client Settings and Font Settings. The Client Settings 

include: 

● Use large icons for menus and buttons – With large icons, it is easier to see what the 
icons represent. 

● Word-wrap text – This selection makes the text you write in email or chat move to the 
next line automatically whenever the text reaches the edge of the window. 

The Font Settings section contains tabs and drop-down menus for you to choose the way the 

text looks in different parts of the interface. 

  Tip: 

To see a sample of the different font options, make selections from the drop-down 

menus. The sample text in the changes according to your selections. The 

selections are saved only when you click OK. You will see the changes in the 

Web Agent the next time you log in. 
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The Font Settings include: 

● Font Name: The name of the type face. You may see the following choices: 

● Serif: A font with decorated letters, that is, letters with little strokes on their edges. 

● SansSerif: A font with plain letters, that is, letters without little strokes on their edges. 

The font in this sentence is a SansSerif font. 

● Monospaced: A font in which all letters have the same width. Many newspapers use a 

monospaced font. 

● Style: Whether the font is bold or plain. 

 
CAUTION: 

If you are using Japanese characters and want to use a bold text style, you must 

select a monospace font. If you want to use a serif or sans serif font with 

Japanese characters, you must select the Plain text style or Avaya Agent may not 

display chat and email preview text correctly. 

● Size: The size of the font. Usually the smallest size you can choose is 8 and the largest is 

20. 

Note: 
Font settings are not applicable for HTML email composition. Contact your 

administrator. 
 

 

Contact preferences 

The options in the Contact tab apply to both email and chat contacts. The options are as 

follows: 

● Wait for agent confirmation before accepting a contact: If you select this option, a 
dialog box, called a "screen pop," is displayed whenever a new email or chat contact 

arrives, allowing you to accept or reject the contact. If you reject the contact when the 

dialog box is displayed, the contact is assigned to another agent. 

Note: 
If you select this option and you do not click Yes or No in the allotted time when 

the dialog box is displayed, the chat or email contact will be removed from your 

task list. In addition, your agent state will change to Aux-work. 

● Alert with sound when a new contact arrives – If you select this option, a sound is 
played whenever a new email or chat contact is assigned to you. The sound is the 

Microsoft® Windows default beep, defined in the properties for system sounds in the 
Windows Control Panel. Your administrator can customize the sound that Avaya Agent 
Rich Client (AARC) plays. 

 

mailto:infodev@avaya.com


Setting Preferences 

July 2021 166 Agent User Guide 

Comments on this document? infodev@avaya.com 

 

 

 

 
● Display a confirmation before wrapping a contact – If you select this option, whenever 

you click the Wrap button, a dialog box asks you to confirm that you want to wrap up the 

email contact or chat contact. This prevents you from accidentally ending the session with 

your customer. 
 

 

email preferences 

The options on the Email tab applies only to email you send from the Web Agent. 

The options are as follows: 

● Spell check before sending an email – If you select this option, the Spell Checker is 

displayed whenever you press the Send button. This reminds you to check the spelling of 

each email message and allows you to correct any errors before the message is sent to 

the customer. 

● Spell check original message text on reply – Check this box if you want to include the 
customer’s original message when you spell check your email replies. If you do not select 

this option, the Spell Checker will check only the new text in your reply. 

Note: 
If you do not select this preference, you should be careful when you use the 

Change All feature. The Change All feature may not change all occurrences of 

the word, possibly leaving misspelled words, if you clicked the Ignore All button 

when the Spell Checker found this misspelled word in previous text of this email, 

then it will continue to ignore the misspelled words. 

● Confirm before sending an email – If you select this option, after you click the Send 

button to send an email, a dialog box asks if you are certain that you want to send this 

message. This gives you a last chance to check your emails before you send them. 

● Quote original message in email response – This option inserts the customer’s original 

message into your email replies. With this option, you can see what you are responding to 

and your customer can see what they wrote you in their original message. If you select this 

option, you can also select the following: 

● Quote prefix to be used – You can change the keyboard character that is entered in the 
text box at the start of each line in the original message. The default character is a closed 

angle bracket (>). 

Note: 
When you forward an email, the original message is indented by spaces. This 

preference works only for emails in plain text format. 

● Use default pool for new outbound email – This option lets you set the queue (pool) that 

will be used when you originate a new outbound email. The queue that is used for your 

outbound emails is also used to route replies to those emails. For example, if a support 

queue is used for your new outbound emails, replies to your new outbound emails will be 

routed to the support queue. If you select this option, select the queue that will be used for 

all of your new outbound emails from the drop-down menu. 
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Note: 
If you do not select this option, whenever you start to send a new outbound email, 

a dialog box will ask you to select the queue. 

● Use default character set for email – You can change the character set used by default 

in your new outbound email to the character set of another language. If you select this 

option, select the character set from the drop-down menu. 

The following options on the Email tab applies only to emails that you send from the Web 
Agent. The options are as follows: 

● Set default mode of composition to HTML: If you select this option, Web Agent 
automatically sets the message format to HTML for all new outbound email messages. 

● Wrap contact after a "Normal Reply" response: If you select this option, your normal 

email replies are automatically wrapped up after you send them. Normal replies are email 

responses in which you leave Normal Email Reply selected in the drop-down menu. 

● Wrap contact after a "Send to External Agent" response: If you select this option, your 

email replies when you select Send to External Agent from the drop-down menu are 

automatically wrapped up after you send them. 

● Wrap contact after a "Request Additional Information" response: If you select this 

option and select Request Additional Info from the drop-down menu, your email replies 

are automatically wrapped up after you send them. 

The following option on the Email tab applies to Web Agent for previewing of incoming emails: 

● Read emails in HTML – If you select this option, Web Agent displays all the incoming 

emails in the HTML format. However, if you do not select this option, Web Agent displays 

all the incoming emails in the plain text format. 

An email composed in the HTML format consists of two Multipurpose Internet Mail 
Extensions (MIME) parts, the HTML MIME part and the PLAIN MIME part. MIME refers to 

an Internet standard for the format of email. So, when you set the preference in the Read 

emails in HTML field to read the email in the HTML or the PLAIN format, Web Agent 

renders only the part, which corresponds to the preference set by the agent. 

Note: 
Based on the contents of an email message, Web Agent can override the 

preference that you set in the Read emails in HTML option. So, if the content of 

an incoming email is only in the HTML format and does not include any plain text 

elements, Web Agent ignores the preference setting and displays that email in 

the HTML format. Similarly, if the content of an incoming email is in the plain text 

format and does not include any HTML text elements, Web Agent ignores the 

preference setting and displays the content of that email in the plain text format. 
 

 

Chat Preferences 

The options in the Chat tab, which apply only to chat sessions, are as follows: 
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● Spell check text before a "Say": If you select this option, the Spell Checker is displayed 

whenever you press the Say button, so you can check the spelling of each chat message 

and correct any spelling errors before the Web Management software sends the chat 

message to the customer. 

● Enable "Away From Desk" message: If you select this option, whenever you have not 

responded to the customer within the specified period of time, a message is sent to the 

customer. This is useful if you plan to be available to handle multiple chat sessions or 

multiple channels simultaneously, such as email and chat. After you select this check box, 

you can change the time interval, and you can specify what the message says in the text 

box. 

● Time interval between "Away From Desk" messages: The message referred to in the 

description of the previous preference is sent each time the specified amount of time 

passes, until you type a chat message to the customer. 

● "Away From Desk" message text: This option lets you can change the text that is sent to 

the customer whenever you do not respond within the time interval that is specified. 
 

 

Other Preferences 

The options in the Other tab are as follows: 

● Internet Explorer Browser Path: If you want to use a different installation of Internet 

Explorer, click the button and navigate to the program. 

● Default mode "Visible" when monitoring a chat session: (Supervisors only) If you are 

a supervisor and you select this option, whenever you begin to monitor a chat session, the 

system announces your presence to the agent in the Transcript area. 

● Start collaboration automatically when monitoring a chat session: (Supervisors only) 
If you are a supervisor and you monitor multiple sessions and you do not use Shared 

Browsing in the sessions, you may want to select this option. Otherwise, whenever you 

start to monitor a session, a browser opens to enable Shared Browsing in that session, 

and whenever you leave a session, the browser closes. 

● Automatically save resources during logout: If you select this option, any new 

resources are always saved when you log out, and you do not get a message asking if you 

want to save them. 

● Confirm before deleting a resource or folder: If you select this option, whenever you 

start to delete a resource or a folder, a dialog box asks if you are certain you want to do 

this. 

● Leave copy of original when copying resource to new location: If you select this 

option, whenever you drag and drop a resource from one folder to another, the original 

resource remains in the original location while a copy of that resource is created in the new 

location. 
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● Use resource when double-clicked: If you select this option, whenever you double-click 

a resource, its contents are inserted into the email or sent to the chat customer 

immediately. If you do not select this option, when you double-click a resource in a chat 

session, the resource moves to the Text Entry area, where you have a chance to view or 

change it before sending it to the customer. 
 
 
 
 

Using Web Self-Service 

The Web Self-Service database contains commonly requested information about products and 

services that your contact center supports. This makes it possible for your customers to find 

answers to their questions by themselves. The database is also referred to as the FAQ 

(frequently asked questions) database. 

You can also help your customers find answers in this database, in the following ways: 

● For your chat customers: 

- Use the Auto Sync feature to lead them to the appropriate documents 

- Push URLs of the documents to them 

● For your email customers: 

- Send an email with URLs of the appropriate documents 

- Paste the contents of the documents in your email responses 

● For your telephone customers: 

- Read to them the URLs or the contents of the appropriate documents 

- Send an email with URLs of the appropriate documents 

● For all your customers: 

- Create resources using the contents of the document 
 

 

Finding Documents in Web Self-Service 

It is a good idea to learn your way around the Web Self-Service database so you can help 

customers quickly. You can find topics and documents in the following two ways: 

● Navigating the Topic Hierarchy on page 170 

● Searching the Web Self-Service Database on page 170 
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  Tip: 

By default, your browser is displayed inside the Avaya Agent. To see more of your 

browser, open the Avaya Agent menu and select Always on Top to remove the 
check mark. 

 

Navigating the Topic Hierarchy 

One way to find specific topics and documents in the Web Self-Service database is to navigate 

the topic hierarchy, as described in the following procedure. 

To navigate the topic hierarchy 

1. In the Web Agent, select Tools > Submit FAQ. 

2. If you want to find a document for a tenant other than the DefaultTenant, click Manage 
FAQ on the left side of the page. 

Your browser opens to the Manage FAQ page, asking you to select a tenant . A tenant 

may be a company, such as XYZ Corp; a location, such as New York or Boston; or a 

workgroup, such as Sales or Support. 

3. Select the tenant and then click Manage FAQ. 

The FAQ Database page displays the root folders in the database of FAQ documents. 

4. If you want to find documents in a different language from the one displayed, select that 
language from the Select language drop-down menu at the top of the page. 

5. Navigate through the folder hierarchy in the FAQ Database section to find the desired 

topic. 

Topics are indicated by folder icons. Folders may contain other folders, which may contain 

still more folders, and so on. When you open a topic folder containing documents, the 

documents are displayed under a line separating them from the folder. Documents are 

marked by a document icon. 

6. Click the document that you want to see. 

The contents of any text document you select are displayed beneath a line separating it 
from the list of documents. 

If the document is a URL, click the link beneath the topic title to display the webpage 

containing the information. 

 
Searching the Web Self-Service Database 

You can search the Web Self-Service database for any available topics or documents that 

match your search criteria. 
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To search the Web Self-Service database 

1. In the Web Agent, select Tools > Search Web Self-Service. 

The Search FAQ page opens. 

2. If you want to search for a document associated with a tenant other than the 

DefaultTenant, click Search FAQ on the left side of the page, select the tenant, and then 

click Search FAQ. 

3. If the document you want to view is related to a specific language, make the appropriate 

selection from the drop-down menu. 

4. Enter a term in the What are you searching for field. 

Note: 
The term you enter can be a phrase or a single keyword. You cannot use any 

wildcard characters. 

5. Click Go. 

All documents containing the term you entered are displayed in the Search page. 
 

 

Submitting documents to Web Self-Service 

You can submit a document for addition to the Web Self-Service database, which is then subject 

to your administrator’s approval or rejection. You can create the document on the Submit a 

Document page, paste an existing document into that page, or enter a URL that displays an 

HTML document. 

Note: 
If you are a supervisor, there are several additional fields available when you 

submit a document. For a description of those fields, see Viewing, Editing, or 
Deleting Proposed Documents on page 172. 

To submit a document for the Web Self-Service database 

1. In the Web Agent, select Tools > Submit FAQ. 

2. If you want to submit a document for a tenant other than the DefaultTenant, click Manage 
FAQ on the left side of the page. 

The Manage FAQ page opens asking you to select a tenant . A tenant may be a company, 

such as XYZ Corp; a location, such as New York or Boston; or a workgroup, such as Sales 

or Support. 

3. Select the tenant and click Manage FAQ. 

4. If you want to find documents in a different language from the one displayed, select that 

language from the Select language drop-down menu at the top of the page. 

5. Select the topic to which you want to add a document. 
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6. At the bottom of the Manage FAQ page, click Submit. 

The Submit a Document page is displayed 

7. Write unique title for this document in the Document Title field. 

8. If the document is an HTML page set up for the website, click Internet Link. Then enter 

the URL with the complete address, such as http://www.avaya.com 

9. If the document is text, leave the Text button selected. Enter your text for the Web 

Self-Service database in the Text box. 

  Tip: 

If you want, you can copy from an existing document, such as a Microsoft® Word 

document or an email, and then paste the copy into the text box. 

10. Read what you have written to check for errors. 
 

  Tip: 

You can use the following trick to spell check your document. Select the entire 

document in the Text box and click Control+C to copy the text. Then go to the 

Web Agent and select Tools > Compose new email. Click Control+V to paste 

the text you copied into the Text Entry area. Click the Spell Check button and 

check the spelling. After you correct any errors, select and copy the message. 

Return to your browser and the Submit a Document page. Paste the text back 

into the Text box. (Later you can delete the email composition text from the Web 

Agent.) 

11. Scroll to the bottom of the Submit a Document page and click Submit. 

Your document is added to the Proposed Documents list, which is the list of documents 

waiting for approval from your supervisor. If you want to view, edit, or delete a document 

you have submitted, see Viewing, Editing, or Deleting Proposed Documents on page 172. 
 

 

Viewing, Editing, or Deleting Proposed Documents 

You can make changes to a document that you have proposed for the FAQ database, or 

remove it before your supervisor has approved or rejected it. 

If you are a supervisor, you can view, edit, and delete the proposed documents that agents in 

your workgroup submit. In addition, as supervisor, it is your responsibility to read the documents 

that agents in your submit to the database and either approve or reject them. For information, 

see Approving or Rejecting Documents (Supervisors Only) on page 173. 

To view, edit, or delete proposed FAQ documents 

1. In the Web Agent, select Tools > Submit FAQ. 

2. Select Manage Proposed FAQ from the left side of the page. 
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3. If the proposed FAQ that you want to see was entered for a different tenant or in a different 

language, make an appropriate selection. Then click the Manage Proposed FAQ button. 

A list of pending FAQ documents for this tenant and language is displayed. 

4. To view a proposed document, click its title. 

5. If you are an agent, make any necessary changes and click the Update button. 

6. If you are a supervisor: 

a. Read the document and decide whether you want to approve it. If you do not want to 

add the document, scroll to the bottom of the page and click the Reject button. 

Otherwise, continue with this procedure. 

b. Enter the ASCII title for the document. This title will always appear exactly as you enter 

it regardless of what language is selected. 

c. Make any necessary changes to the language-specific portions of the document that 

were entered by the agent. 

d. Enter the task type, mail account, and routing hint information for this document. (For 
details about these fields, see Interaction Center Administration Guide.) 

e. Click the Approve button. 
 

 

Approving or Rejecting Documents (Supervisors Only) 

As a supervisor, you must approve or reject documents submitted by members of your 

workgroup. 

To approve or reject proposed FAQ documents 

1. In the Web Agent, select Tools > Submit FAQ. 

2. Select Manage Proposed FAQ from the left side of the page. 

3. Select the tenant or language of the proposed documents you want to see and click 

Manage Proposed FAQ. 

A list of pending FAQ documents for this tenant is displayed. 

4. To view a proposed document, click its title in the Pending column. 

5. Read the document and decide whether you want to accept it. If you do not want to add 

the document, scroll to the bottom of the page and click the Reject button. Otherwise, 

continue with this procedure. 

6. Enter the ASCII title for the document. This title will always appear exactly as you enter it 
regardless of what language is selected. 

7. Make any necessary changes to the language-specific portions of the document that were 
entered by the agent. 
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8. Enter the task type, mail account, and routing hint information for this document. (For 

details about these fields, see Interaction Center Administration Guide.) 

9. Click the Accept button. 

mailto:infodev@avaya.com


Chapter 7: Performing chat and email tasks 

175 Agent User Guide July 2021 

Comments on this document? infodev@avaya.com 

 

 

 

mailto:infodev@avaya.com


July 2021 176 Agent User Guide 

Comments on this document? infodev@avaya.com 

 

 

Chapter 8: Shortcut keys 

 

This chapter provides information about the shortcut keys that you can use to perform any 

action in Avaya Agent Rich Client application. 
 

 

Shortcut Key Description 

Control+P Prints the content displayed in the current window to the default 
printer. 

Control+Z Undo or cancel the previous action. 

Control+Y Redo the previous action. 

Control+K Performs the spelling check. 

Alt+O Imports the resource file. 

Control+X Cuts the selected text or an object. 

Control+C Copies the selected text or an object. 

Control+V Pastes the copied text or an object. 

Control+A Selects all the content. 

Alt+Shift+9 Makes the chat unavailable. 

Control+R Displays the reply to email message window for the selected email. 

Control+Shift+A Displays the reply to all email message window for the selected email. 

Control+F Displays the Forward email message window for the selected email. 

Control+L Resolves the email addresses specified in the email message. 

Control+H Displays the email history. 

Control+Q Approves or rejects an email request. 

Control+N Displays the new email message window. 

Control+O Forwards the original email. 

Control+J Starts the JoinUs conference. 

Alt+Shift+K Creates a new text resource. 

Control+Alt+C Switch to chat management. 
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Shortcut Key Description 

Alt+Tab Continue through the open applications while looking at the contact 
information displayed in the Avaya Agent. 

Alt+L Clear 

Alt+L Logs in to Avaya Agent Rich Client application. 

Alt+X Exit from the Avaya Agent Rich Client application. 

Alt+N New 

Alt+S Save 

Alt+F Open 

Alt+E Displays the Edit menu. 

Alt+A Displays the Agent menu. 

Alt+T Displays the Contact menu. 

Alt+M Displays the Message menu. 

Alt+O Displays the Tools menu. 

Alt+H Displays the Help menu. 

Alt+R Displays the Resources menu. 

Alt+A Set the availability of an agent. 

Alt+E, Alt+8 Makes the email available. 

Alt+U, Alt+Shift+8 Makes the email unavailable. 

Alt+A, Alt+9 Makes the chat available. 

Alt+2 Displays the Agent Home page. 

Alt+V, Alt+7 View the FAQ section. 

Alt+4, Alt+W Searches for a web self-service. 

Alt+S, Alt+3 Submits the FAQ. 

Alt+5, Alt+D DataWake 

Alt+6, Alt+P Displays the Preferences window. 

Alt+C, Alt+1 Displays the content of the Rich Client application help. 

Alt+A, Alt+Shift+1 Displays the About window for the Rich Client application. 

Alt+B Go to the previous page. 
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Shortcut Key Description 

Alt+F Go to the next page. 

Alt+S Stop accessing the webpage. 

Alt+R Refresh the current webpage. 

Alt+H Displays the home page of the current website. 

Ctrl+Alt+L Displays the login status of an agent. 

Ctrl+Alt+E Email Management 

Ctrl+Alt+P Chat and Phone Management 

Ctrl+Alt+I Chat and VoIP Management 

Ctrl+Alt+W SMS view 

Ctrl+Alt+M Messages View 

Ctrl+Alt+U Unified Agent Directory 

Ctrl+Alt+S Supervise Team 

Ctrl+Alt+H Displays the Agent home page. 

Ctrl+Alt+D Delete 

Ctrl+Alt+1 Help 

Ctrl+N Compose new email. 

Ctrl+O Forward original email. 

Ctrl+L Resolve 

Ctrl+H History 

Ctrl+R Reply 

Ctrl+Shift+A Reply to all 

Ctrl+F Forward 

Ctrl+Q Reject/approve 

Alt+Q, Ctrl+Q Quality Assurance 

Ctrl+S Save 

Ctrl+Shift+C Cancel 

Ctrl+Shift+S Send 
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Shortcut Key Description 

Ctrl+T Attach 

Ctrl+B Lookup addresses 

Alt+E, Ctrl+Shift+H Searches an email. 

Alt+D Displays the task details. 

Alt+D, Alt+Shift+D Defers the task. 

Alt+W, Alt+Shift+W Wraps the current task. 

Alt+C, Alt+Shift+C Completes the current task. 

Alt+I Displays the customer information for the current task. 

Alt+N, Alt+Shift+N Starts the conference for the current task. 

Alt+L, Alt+Shift+L Cancels the current task. 

Alt+A Sends the chat transcript to the customer. 

Alt+P Push the URL to the customer. 

Ctrl+Shift+A Starts the Auto Sync with the customer. 

Alt+R Creates a new resource. 

Alt+Shift+K Creates a new text resource. 

Alt+V Displays the resources. 

Alt+D Deletes the resource. 

Alt+X Expands all resources. 

Alt+C Collapses all resources. 

Alt+S Saves the resource. 

Alt+F Filters the resources. 

Alt+Shift+U Creates a new Url resource. 

Alt+E, Alt+Shift+E Creates a new Email resource. 

Alt+A Applies the changes. 

Alt+V, Ctrl+Shift+V Makes the supervisor visible to the agent and a customer in the Chat 
session. 

Control + Shift + W Pop out a chat task tab to a separate window. 

Control + Shift + P Pop in a chat task back to the tabbed pane. 
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